INSTRUCTION REPORT ITL-90-5

USER'S GUIDE: COMPUTER AIDED STRUCTURAL MODELING (CASM)

Version 1.01
Release Date - February 1990

by

David Wickersheimer, Gene McDermott
Ken Taylor, Carl Roth,
Wickersheimer Engineers, Inc.
821 South Neil Street
Champaign, Illinois  61820

September 1990
Final Report
Approved For Public Release: Distribution Unlimited

Prepared for: DEPARTMENT OF THE ARMY
US Army Corps of Engineers
Washington, DC  20314-1000

Under Contract No. DACA39-86-C-0024
(RDT&E Program, Work Unit No. AT40-CA-001)

Monitored by Information Technology Laboratory
US Army Engineer Waterways Experiment Station
3909 Halls Ferry Road, Vicksburg, Mississippi  39180-6199
This user's guide describes the computer program CASM, which is designed to aid the structural engineer in the preliminary design and evaluation of structural building systems by the use of three-dimensional interactive graphics. Funds for the development of this program and publication of this user's guide were provided to the Information Technology Laboratory (ITL), US Army Engineer Waterways Experiment Station (WES), Vicksburg, MS, by the Directorate of Military Programs, Headquarters, US Army Corps of Engineers (HQUSACE), under the Research, Development, Test, and Evaluation (RDT&E) program. The work was accomplished under Work Unit No. AT40-CA-001 entitled "CASE Building Systems." The work was performed by members of Wickersheimer Engineers, Inc., of Champaign, IL, under Contract No. DACA39-86-C-0024.

Specifications for the program were provided by members of the Building Systems Task Group of the Computer Aided Structural Engineering (CASE) Project. The following were members of the task group during program development (though some did not serve for the entire period):

- Mr. Dan Reynolds, Sacramento District (Chairman)
- Ms. Anjana Chudgar, Ohio River Division
- Mr. Joseph Hartman, Southwestern Division
- Mr. George Henson, Tulsa District
- Mr. Dave Illias, Portland District
- Mr. Sefton Lucas, Memphis District
- Mr. David Raisanen, North Pacific Division
- Mr. Pete Rossbach, Baltimore District
- Mr. Daniel Sommer, Omaha District
- Mr. Larry Seals, Savannah District
- Mr. Dave Smith, Omaha District
- Mr. Mark Burkholder, Tulsa District
- Mr. Jerry Maurseth, Portland District
- Mr. Young Shu, Memphis District
- Mr. Chris Merrill, WES
- Mr. Paul K. Senter, WES
- Mr. Michael Pace, WES

The computer program and user's guide were written by Messrs. David Wickersheimer, Gene McDermott, Ken Taylor, and Carl Roth of Wickersheimer Engineers, Inc.

The work was monitored at WES by Mr. Michael E. Pace, Computer Aided Engineering Division (CAED), under the general supervision of Mr. H. Wayne Jones, Chief, Scientific and Engineering Applications Center; Dr. Edward Middleton, Chief, CAED; Mr. Paul K. Senter, Assistant Chief, ITL; and Dr. N. Radhakrishnan, Chief, ITL. Mr. Donald Dressier was the original HQUSACE point of contact, and Mr. Charlie Gutberlet is the present technical monitor.

COL Larry B. Fulton, EN, is Commander and Director of WES. Dr. Robert W. Whalin is Technical Director.
# CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>PREFACE</td>
<td>i</td>
</tr>
<tr>
<td>BACKGROUND</td>
<td>v</td>
</tr>
<tr>
<td>INTRODUCTION</td>
<td>1-1</td>
</tr>
<tr>
<td>What Is CASM?</td>
<td>1-1</td>
</tr>
<tr>
<td>Version 1.01</td>
<td>1-1</td>
</tr>
<tr>
<td>INSTALLATION</td>
<td>2-1</td>
</tr>
<tr>
<td>Packing List</td>
<td>2-1</td>
</tr>
<tr>
<td>What You Need to Use This Program</td>
<td>2-1</td>
</tr>
<tr>
<td>Installing the Program</td>
<td>2-4</td>
</tr>
<tr>
<td>PROGRAM OVERVIEW</td>
<td>3-1</td>
</tr>
<tr>
<td>Getting Started</td>
<td>3-1</td>
</tr>
<tr>
<td>The CASM Program Window</td>
<td>3-5</td>
</tr>
<tr>
<td>Running the Program</td>
<td>3-9</td>
</tr>
<tr>
<td>Saving Your Work on Disk</td>
<td>3-16</td>
</tr>
<tr>
<td>Using Previously Saved Files</td>
<td>3-22</td>
</tr>
<tr>
<td>Stopping the Program</td>
<td>3-23</td>
</tr>
<tr>
<td>REFERENCE</td>
<td>4-1</td>
</tr>
<tr>
<td>System Menu</td>
<td>4-2</td>
</tr>
<tr>
<td>File Menu</td>
<td>4-9</td>
</tr>
<tr>
<td>Criteria Menu</td>
<td>4-23</td>
</tr>
<tr>
<td>Draw Model Tool Palette</td>
<td>4-33</td>
</tr>
<tr>
<td>Draw Structure Tool Palette</td>
<td>4-57</td>
</tr>
<tr>
<td>Loads and Design Tool Palette</td>
<td>4-81</td>
</tr>
<tr>
<td>Viewpoint Tool</td>
<td>4-117</td>
</tr>
<tr>
<td>TROUBLESHOOTING</td>
<td>5-1</td>
</tr>
<tr>
<td>Precautions</td>
<td>5-1</td>
</tr>
<tr>
<td>What To Do If Something is Wrong</td>
<td>5-2</td>
</tr>
<tr>
<td>Appendix A: Project History</td>
<td>A-1</td>
</tr>
<tr>
<td>Appendix B: Trademarks</td>
<td>B-1</td>
</tr>
<tr>
<td>Appendix C: Disk File Contents</td>
<td>C - 1</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Appendix D: Matrox Installation</td>
<td>D - 1</td>
</tr>
<tr>
<td>Appendix E: Sample Graphics</td>
<td>E - 1</td>
</tr>
<tr>
<td>Index</td>
<td>I - 1</td>
</tr>
</tbody>
</table>
BACKGROUND

PURPOSE

The purpose of this manual is to help you understand the CASM program. The CASM program is designed by structural engineers for structural engineers. Its purpose is to help solve those basic early problems that all engineers face when trying to fit a structural system into a building.

This is the first release of the program (Version 1.01). Not all options are implemented at this time (a message that you may see when using this program). But do not fear; what you are getting is a usable, functional, practical program that will help you solve many basic problems much faster and easier than your present methods.

The areas that are addressed in this program include:

- **Basic Design Criteria.** This section has a wide range of features that are useful in preparing regional data, site-specific data, and also building-specific data for a new project. Once entered, these data can be saved and reused for future projects.

- **Dead and Live Loads.** How many times do you find yourself flipping through the same old manuals trying to locate the weight for materials or occupancy? Here you will be able to pick and choose from precompiled lists and then total them to create reports. You may also edit the lists and enter your own weights for materials.

- **Snow and Wind Loads.** The program quickly calculates these values for the building geometry that you create on the screen. Make some changes to your design model, and recalculate the snow and wind loads for comparison. The program calculates load data quickly so that you can use them to make better decisions about your building.

- **Building Geometry and Structural Layout.** You can use computer 3-D building blocks to quickly model the building geometry. After you have created the building geometry, you can experiment with different structural framing plans to select the optimum framing plan for your building.

- **Member Analysis and Preliminary Sizing.** The CASM program allows you to apply loads to your building geometry from the list of load cases that you created. You may then use an analysis program in combination with spreadsheets to quickly determine a preliminary size for the structural members. Based on this preliminary information, you can quickly evaluate several structural schemes.
BACKGROUND

When you begin using the CASM program, you will see that it is quite comprehensive. But we are still at work with more features. For now, follow the directions given here to get started.

For the Beginning User

For the beginning user, we assume no experience with Microsoft® Windows. At this point we suggest that you may want to become familiar with Windows by installing it on your computer and reviewing chapters 1 through 6 of the Microsoft Windows User’s Guide. You may want to know more about Windows because CASM is a Windows application program which uses many of the Windows conventions. Please refer to the Getting Started section of this guide to help with installing Windows.

The Installation section of this guide will also provide you with guidance for installing Windows and CASM. Once you have installed Windows and CASM, the Program Overview section will provide you with a preview of all the primary CASM command sequences. You may then proceed to the "Tutorial Guide" to learn how to use CASM.

For the Advanced User

For the advanced user, we assume that you have a working knowledge of Microsoft Windows and that it is already installed on your computer. The Installation section of this guide will show how to install CASM, after which you should review the Overview section before beginning with the "Tutorial Guide."

HOW THE CASM GUIDES ARE ORGANIZED

CASM User’s Guide:

Chapter 1, Introduction, gives general information about the program.

Chapter 2, Installation, shows you how to install the program on your computer.

Chapter 3, Program Overview, presents the basic program operation of CASM.
HOW THE CASM GUIDES ARE ORGANIZED

Chapter 4, Reference, gives a short description for every command in the CASM program.

Chapter 5, Troubleshooting, gives advice for problems with the computer and CASM.

The appendixes present other miscellaneous information including Project History (Appendix A), Trademarks (Appendix B), Disk File Contents (Appendix C), Matrox Installation (Appendix D), and Sample Graphics (Appendix E).

This manual ends with an Index, which we have made every effort to make as complete as possible.

CASM Tutorial:

The Tutorial describes the CASM methodology, takes you through all the structural design features of the program including a series of example design problems that have been taken from the appendixes of Load Assumptions for Buildings, Technical Manual (TM) 5-809-1/Army Field Manual (AFM) 88-3.

Chapter 1, CASM Philosophy, describes the intent of the program in aiding in the structural decision-making process.

Chapter 2, Design Criteria, shows you how to select and enter project criteria data.

Chapter 3, Modeling, provides the user with hints, options, and ramifications with regard to use of the 3-D modeling process.

Chapter 4, Loads, shows you how to use the CASM load generation and application features for dead, live, wind, and snow loads. Examples from TM 5-809-1 are used.

Chapter 5, Structural Analysis and Design, shows you how to use CASM to generate preliminary structural framing schemes; shows you how to use the preliminary analysis feature of CASM for generating shear, moment, and deflection diagrams; and shows you how to use the Microsoft Excel spreadsheet to select preliminary member sizes based on the preliminary analysis data.
CONVENTIONS USED IN THIS MANUAL

Many additional notes and reminders are used in this manual. These include:

[ENTER] - word in brackets indicates single key entry.

>>> or NOTE: - indicates additional information about a specific function or feature in the program.

WARNING! - indicates where caution should be used to ensure that you do not lose data!

Double Click - Press the mouse key twice in quick succession, less than a second pause between presses. If the pause is too long the double click may not produce the desired result.

Cursor Arrow Keys - Four keyboard keys with up, down, right, and left arrows printed on top of the keys.

Tab Key symbol. Look for this symbol on top of the key when you are directed to use the TAB key to select dialog window commands.
Because the CASM program will respond to keyboard entries or mouse inputs and the CASM program can be displayed on one screen or two screens, the following symbols are included in the guide to help you find the command sequence or display comments appropriate to your hardware configuration.

**Mouse symbol** - indicates commands and/or procedures activated by the mouse input device.

**Keyboard symbol** - indicates commands and/or procedures activated by keyboard keys.

**Single Screen symbol** - indicates displays and/or sequences that are unique to the Single Screen Display.

**Dual Screen symbol** - indicates displays and/or sequences that are unique to the Dual Screen Display.
INTRODUCTION

WHAT IS CASM?

First of all, CASM stands for Computer Aided Structural Modeling. It is a program designed to aid the structural engineer in the preliminary design and evaluation of structural building systems by the use of 3-D interactive graphics. Think of this program as a scratch pad for the structural decision process that would have been done on paper before you went to the computer to do the final numerical analysis of structural members. CASM will let you change your mind quickly and give you results that previously might have taken hours to obtain. By allowing quick changes, CASM allows you to make more informed decisions in the initial structural evaluation process.

VERSION 1.01

This first release of CASM is designed to help you with design criteria, building loads, and structural framing. For instance, CASM will let you calculate building loads, both dead and live loads, for different areas of the building by looking up loads from a predefined table of values. CASM will also let you develop and display snow and wind loads for your 3-D structural model. You may use these values, or create your own, to add to the load total. You may assign these loads to preliminary structural framing plans in order to evaluate different framing schemes for selection of the best preliminary solution for final design and in-depth analysis. This version of CASM provides you with a beam analysis program for developing shear, moment, and deflection diagrams for beams with a variety of loading (including pattern loads) and a variety of connectivity (including continuous beams). Data for all your preliminary schemes can be edited, printed, and used as justification for your preliminary solution.

You have two options for displaying the CASM 3-D interactive graphics. If you currently have an EGA or a VGA graphics system, you may display the CASM model as a 8-color wireframe on your graphics screen. If you purchase a Matrox SM graphics card and a high-resolution monitor, you can display the CASM model as a 256-color, shaded, solid model on the high-resolution monitor. Please refer to the Installation section in this guide for a list of hardware components that you will need for the program.

We have included more information about the program and the history behind the project in Appendix A. The CASM Tutorial Guide will provide you with detailed procedures for using CASM for Structural Design.
INSTALLATION

PACKING LIST

You should have two 1.2Mb, 5-1/4-inch floppy disks that contain the CASM program and three guides, a User's Guide (this guide), a Tutorial Guide, and a Quick Reference Guide. If you do not have all these materials, you can call or write the Engineering Computer Programs Library at:

Commander and Director
US Army Engineer Waterways Experiment Station
3909 Halls Ferry Road
Vicksburg, MS 39180-6199
(601) 634-2581

Appendix C contains a detailed listing of the diskette contents.

WHAT YOU NEED TO USE THIS PROGRAM

To use CASM you will need the following minimum requirements:

An IBM AT computer or compatible. We strongly recommend a computer that runs at 12MHz. The size and complexity of this program combined with Microsoft Windows makes for a lot of calculations for the computer, especially if you are using the single-monitor configuration.

640 KB of memory. Windows/386 or Windows 3.0 will require more memory. The single-monitor configuration may require more memory for large projects.

1.2MB Floppy Disk Drive.

20MB Hard Disk Drive.

Microsoft Windows, Version 2.1 (Windows/286 or 'ndows/386) or Windows 3.0.

Microsoft EXCEL, Version 2.1 or later.

A mouse that is compatible with Microsoft Windows. A partial list of pointing devices that work with Microsoft Windows includes:

Microsoft Mouse (either bus or serial port version)
Mouse systems Mouse (connected to serial port Com1 or Com2)
INSTALLATION

WHAT YOU NEED TO USE THIS PROGRAM

Logitech Logimouse (bus or serial)

Digitizing Tablets (Most either have a mouse emulation mode or Windows drivers. These are not necessary for CASM, but you can use one if you already have it.)

Other devices are always being developed and made available. If you have a particular mouse or pointing device that is not listed here, refer to the Microsoft Windows documents for a more detailed list. If your device does not appear on that list, contact the device manufacturer to see if they provide a Microsoft Windows software driver for the device. Most manufacturers will supply the necessary software driver free of charge and often include it with the item.

MS-DOS 3.1 or greater.

A monitor (color or monochrome) with an adaptor card. A VGA board and monitor will give you the best color and resolution for the single-monitor display option. An EGA-compatible monitor will also work as a color monitor for the single-monitor system. A Hercules® compatible monochrome monitor would be acceptable as an inexpensive primary monitor for the dual-monitor display option (please refer to the high-resolution option discussed later in this section). We do not recommend a CGA-compatible monitor, either for the single-monitor system or as the primary monitor for a dual-monitor system, because of the poor resolution.

A printer (and a plotter as an option). Windows supports a number of dot-matrix printers, laser printers, and plotters on the market. A list of printers can be seen in the "Installation" section of the "Control Panel" program that comes with Windows. Please refer to the Microsoft Windows documentation for more printer information. A partial list of printers includes:

<table>
<thead>
<tr>
<th>Epson FX-80</th>
<th>Epson MX-80</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson LQ-1500</td>
<td>Any printer that can emulate Epson graphic commands</td>
</tr>
<tr>
<td>IBM Graphics</td>
<td>IBM Proprinter</td>
</tr>
<tr>
<td>Okidata 92/93 (IBM or Std)</td>
<td>Okidata 192/193 (IBM or Std)</td>
</tr>
<tr>
<td>NEC 3550</td>
<td>NEC P2/P3</td>
</tr>
<tr>
<td>C-Itoh 8510</td>
<td>Toshiba P1351</td>
</tr>
<tr>
<td>Star SG-10</td>
<td>TI 850/855</td>
</tr>
<tr>
<td>Hewlett-Packard LaserJet</td>
<td>HP LaserJet +</td>
</tr>
<tr>
<td>HP 7470A</td>
<td>HP 7475A</td>
</tr>
<tr>
<td>HP 7550A</td>
<td>HP ThinkJet (2225 C - D size)</td>
</tr>
<tr>
<td>Xerox 4020</td>
<td>Any PostScript Laser Printer</td>
</tr>
<tr>
<td>Apple LaserWriter</td>
<td>Any Generic, Text-Only printer</td>
</tr>
</tbody>
</table>
Dual Monitor Display Option. The dual monitor option will require the use of two monitors and two graphic cards. The primary monitor which displays Windows can be any of the required monitors and boards. The monitor displaying the high-resolution, solid, 3-D structural model will require the following equipment:

1. **A Matrox SM-1024 or SM-1281 graphics board.** This special graphics card produces 3-D solid, shaded images. It will allow you to move and change the building shape and structure in either solids or wireframe interactively. This graphics board gives you the power to alter the building with a minimum delay because the graphics board calculates all the coordinate information instead of burdening the computer memory with the calculations.

2. **A high-resolution monitor.** The Matrox graphics board requires a high-resolution, large-screen monitor to display the graphics. The monitor should also accept RGB analog signals. Here your selection for a monitor is more restricted because of the high resolution. A few monitors that may work with the Matrox graphics boards include:

<table>
<thead>
<tr>
<th>Monitor</th>
<th>MATROX Board</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>NEC Multisync XL</td>
<td>SM-1024</td>
<td>1024x768</td>
</tr>
<tr>
<td>Mitsubishi 9918</td>
<td>SM-1281</td>
<td>1281x1024</td>
</tr>
<tr>
<td>Mitsubishi 6600</td>
<td>SM-1281</td>
<td>1281x1024</td>
</tr>
<tr>
<td>Mitsubishi 6905</td>
<td>SM-1281</td>
<td>1281x1024</td>
</tr>
<tr>
<td>Hitachi 4115</td>
<td>SM-1281</td>
<td>1281x1024</td>
</tr>
<tr>
<td>Hitachi 4119</td>
<td>SM-1281</td>
<td>1281x1024</td>
</tr>
<tr>
<td>Hitachi 4619</td>
<td>SM-1281</td>
<td>1281x1024</td>
</tr>
<tr>
<td>Hitachi 4625</td>
<td>SM-1281</td>
<td>1281x1024</td>
</tr>
<tr>
<td>CDU 1964</td>
<td>SM-1281</td>
<td>1281x1024</td>
</tr>
</tbody>
</table>

We do not guarantee the compatibility of all the monitors listed. We have used only the NEC Multisync XL and the MATROX SM-1024. Please contact your Matrox Dealer or Matrox directly for more information on monitors.

**WARNING!** These monitors can be expensive! The above monitors range in price from about $2000 to almost $4500! Always double check the specifications of these and any other monitors that you may be considering. Its worth the extra time to prevent a costly mistake.

3. **A cable to connect the monitor and the graphics board.** The Matrox SM-1024 has a DB-9 pin female connector that carries the RGB signals. Most monitors today also have DB-9 connectors, but some have BNC connectors. Please check your monitor to see which type of connector it is so you can order the correct one or have one made at your local computer store. The cable that comes with the NEC Multisync works!

Consult the MATROX manual and "Read.me" files for procedures on installing the MATROX card and downloading the LIB shell from the hard drive to the memory on the graphics card. We provide you with...
an abbreviated MATROX installation checklist in Appendix D of this guide. We also provide you with a sample download program (xgdownl.bat) to help you download the shell. You may need to edit the program for your own use.

In* A* Vision by Micrografx. This is a simple 2-D graphics program that lets you edit screen dumps generated by the CASM program. It is an object-oriented CAD program similar to Autocad, but not as complex. (Old program. May not be available.)

Designer by Micrografx. This is a graphics program similar to In* A* Vision but offers more advanced procedures including graphics for Desktop Publishing and Technical Illustration. The program will read and display the graphic output files from CASM.

CASM also provides graphic output files in a DXF format which can be read by AutoCAD and other programs capable of reading the DXF format.

Extended/Expanded Memory. New versions of Windows, the EXCEL spreadsheet, and this program require a lot of memory. You may experience problems running all these programs with only 640Kb of memory. Two megabytes of memory would be ideal for your CASM system—one megabyte of conventional memory and one megabyte of expanded/extended memory.

WARNING! The Matrox software supplied with the graphics card utilizes memory address locations 0C6000 to 0C63FF in the 384Kb memory segment from 640Kb to 1.0Mb. Some extended/expanded memory software may also try to access the same memory segment, which will lock up the computer. If you have a Matrox graphics card and extended/expanded memory, you will need to verify that the memory address locations 0C6000 to 0C63FF are protected for Matrox use. Use the EMMTEST.EXE program provided on Disk 1 to test for a memory conflict (see Appendix C).

INSTALLING THE PROGRAM ON YOUR COMPUTER

The following steps provide information for setting up the Windows program and CASM program on your computer by loading program files onto your hard disk. In addition, steps are provided to speed up access to the project files.

Make a backup copy of your disks ! ! ! ! ! ! ! ! ! ! ! ! ! ! !

At this time we urge you to make backup copies of your CASM disks. We have all experienced the horrible feeling of our hard disks dying. Don't let it happen to you! Also, remember to make backups of your project files daily on a floppy diskette.

Set up Windows on your computer

Microsoft provides a setup routine right on the Windows disk. All you have to do is:
1. Turn on your computer.
2. Insert the Windows Setup disk in Drive A.
3. Change to directory A: by typing A: followed by the [ENTER] key.
4. Type `setup` followed by the [ENTER] key.

   The Setup routine will prompt you with instructions to complete the installation.
   For a more complete description, see Chapter 1 of the "Microsoft Windows User's Guide."

---

**Set up directories for CASM and load the program onto your hard disk**

We have provided a program to automatically create a CASM subdirectory on your hard disk and transfer all the files from the floppy disk onto your hard disk. This should be done after you have loaded Windows onto your hard disk. All you have to do is:

1. Turn on your computer.
2. Insert the CASM disk in Drive A.
3. Type `a:\loadcasm` followed by the [ENTER] key.
4. When the prompt for the type of graphics card appears, select the type of 3D graphics card which you have installed (default = 1). Enter:
   - 1 - If you have the Matrox SM-1024 or SM-1281
   - 2 - If you have the Matrox SM-640
   - 3 - If you have MCGA, CGA, EGA, or VGA (Single-Monitor System)
5. Indicate the source drive of your CASM floppy disk A: or B: (default = A:). Press the [Enter] key if the default is OK.
6. Enter the directory name where you want the CASM program files to go (default = \CASM). Press the [Enter] key if the default is OK.

   **The program will create the directory and copy all the files into the specified directory. Please see Appendix C for a listing of all the CASM program files.**

7. If you have a Matrox graphics card, you will need to edit and add a batch file that will set up the Matrox graphics card.

   **Refer to the Matrox documentation which accompanies the graphics card. Appendix D in this guide contains an abbreviated procedure for checking the graphics board, loading the graphics software, and setting up your autoexec.bat file to load the Matrox software program which controls the graphics board.**

---

**Set up EXCEL on your computer**

Microsoft provides a setup routine right on the EXCEL disk. All you have to do is:

1. Turn on your computer.
2. Insert the EXCEL Setup disk in Drive A.
3. Change to directory A: by typing `A:` followed by the [ENTER] key.
4. Type `setup` followed by the [ENTER] key.

   The Setup routine will prompt you with instructions to complete the installation. For a more complete description, see Chapter 1 of the "Microsoft EXCEL User's Guide."
Add the CASM auto-start feature to Windows

Windows allows the user to start a program and have that program load an existing file just by double-clicking the left mouse key while pointing to that file name. For example, CASM stores all of its files with the file extension .BLD. So if you called your building PROJECT1, it would be stored as file PROJECT1.BLD. While you are in Windows, you could start the CASM program just by double-clicking on the file called PROJECT1.BLD, and Windows would automatically load PROJECT1.BLD and run the CASM program. However, you must tell Windows how to do this.

This procedure is not necessary if you do not intend to use Windows as an operating system for your computer. You may start CASM by typing WINCAS and then access project files by the Open command from the File menu in CASM. Please refer to the Program Overview chapter in this guide for instructions on starting CASM.

To tell Windows how to start CASM by double-clicking on a .BLD file, you must edit the WIN.INI file. WIN.INI is the Window's Initialization file that tells Windows all about the computer it runs on and other configuration notes. It is these configuration notes that you are going to change. You can follow our instructions that use the Notepad program, or you can use your own word processor to edit the WIN.INI file.

**WARNING!** If you use your own word processor, remember to save the file as an ASCII file (text only) with no formatting commands in the file. Windows will not understand the formatting commands of your word processor and will not work.

To add the auto-start feature to Windows using Notepad, follow these directions:

1. Turn your computer on.
2. Go to the directory where Windows is located by typing cd \ and the directory name.
3. Start Windows by typing win and a return.
4. Locate the file WIN.INI using the MS-DOS executive in Windows.
5. Double-Click the left mouse key on the WIN.INI file name.
6. The Notepad program will automatically start and load the WIN.INI file.
7. Find the section in the WIN.INI file called [extensions]. You may have to use the scroll bar on the right of the screen. The section we are interested in looks like this:

```plaintext
[extensions]
cal= calendar.exe ^ .cal
crd= cardfile.exe ^ .crd
trm= terminal.exe ^ .trm
txt= notepad.exe ^ .txt
ini= notepad.exe ^ .ini
msp= paint.exe ^ .msp
wri= write.exe ^ .wri
```
8. The mouse pointer is now an I-bar. Place the I-bar after the last line (at the end of .wri) and press the left mouse button.

9. You should now see a vertical cursor line flashing behind the .wri.

10. Press return and the cursor should now be located under the line
    \write \wri.

11. Now type:
    \bid= casm.exe \bid
    \dat= notepad.exe \dat

    There is only one space used. It is between the portion \bid= casm.exe and the portion ^ .bid.

12. Move the mouse pointer to the word File in the pull-down menu bar at the top of the screen.

13. Press the left mouse key. Move the mouse pointer downward and select the Save command. This saves the WIN.INI file with the change that you added.

14. Quit Notepad by going to the System menu and selecting Close from the menu in the same manner using the mouse.

15. You should now be back at the MS-DOS executive section of Windows.

16. Now exit from windows and then restart windows to initialize these changes. Now you will be able to double-click on a .bid file and CASM will start and load your file automatically. Also, you can double-click on a data file (.dat), and Notepad will begin using that file so you can edit it.

Now you may proceed to the Program Overview chapter for instructions on how to start CASM and a brief description of how to use the program.
PROGRAM OVERVIEW

Described in this chapter are instructions on how to start the CASM program, a description of the CASM program window, a brief overview of how to use the CASM commands, information on how to save your project files, and instructions for stopping the program. This chapter also briefly describes other Microsoft Windows application programs which can be used with CASM.

Microsoft Windows provides an easy method for operating the Computer Aided Structural Modeling (CASM) program. Windows is a menuing program that provides the user with a variety of program windows, pull-down menus, pop-up dialog windows, program icons (graphic representation of program names, i.e., a house for the CASM program), and the choice of using the keyboard and a mouse for data input and program control.

Windows makes it easy to combine information from several programs. You may copy text or graphics from one data file to another.

GETTING STARTED

In order to run the CASM program, both Windows and CASM must be loaded into subdirectories on the computer. Refer to the Installation section of this guide for instructions on installing the programs. Windows provides access to the DOS commands via the MS-DOS EXECUTIVE program. A detailed description of the use of the program is covered in the Microsoft Windows User's Guide.

There are a couple of methods for starting CASM. The Long Method of loading CASM is always available, especially if you are used to using the DOS commands to access programs. The Short Method is more convenient to use because it saves steps and can be easily entered when in DOS. However, it requires that you modify or add the DOS Path command to the computer's autoexec.bat file.

STARTING CASM - LONG METHOD

You may start the CASM program through the Windows program. After turning on the computer, the sequence for starting Windows is:

1. Select the Windows directory by typing after the DOS prompt:
   \win
   [ENTER]

   If the Windows subdirectory has been given another name, then enter that name in place of 'win' in the line shown.

2. Start the Windows program by typing after the DOS prompt:
   win
   [ENTER]
WIN is the name of the primary Windows executable file, WIN.COM. By typing WIN, the Windows program will be loaded in the computer memory and displayed on the monitor.

3. The Windows program will be loaded into the computer memory. An hourglass symbol will be displayed on the screen until the program has been loaded. Once loaded, the screen will look like the figure below.

### The sequence for starting CASM from Windows is:

1. Select the root directory (\) by using the mouse pointer to move the cursor to the backslash character (\) in front of WIN on the Active Drive\Directory line. Refer to the figure above.

2. **Double click** (in quick succession) the left mouse key while the mouse pointer is on the backslash character (\). The directory listing will change to the root (\) directory. Look for the CASM subdirectory in the list of files/subdirectories. Subdirectory names are printed in bold print.

3. Move the mouse pointer to the CASM subdirectory name.

4. **Double click** (in quick succession) the left mouse key while the mouse pointer is on the CASM subdirectory name. The directory listing will change to the CASM (\CASM) directory. Look for the CASM.EXE program file in the list of files/subdirectories.

5. Move the mouse pointer to the file name CASM.EXE.
6. Double click the left mouse key while the mouse pointer is on the CASM.EXE program file name.

   If you only press the left mouse key once or do not press the key twice quickly, CASM.EXE will be highlighted but will not run. You may start the program by using RUN on the FILE pulldown menu or double click the left mouse key again.

   An hourglass will appear while the CASM program is loading into the computer memory. The hourglass symbol will remain on the screen until the CASM program is fully loaded. After the CASM program has loaded:

   **Dual-Monitor System:** The primary monitor (EGA, VGA, or Monochrome) will display the program window and the secondary monitor (Hi-resolution MATROX) will display the ground plane. Please refer to Figures 3.2 and 3.3 in the CASM Program Window section.

   **Single-Monitor System:** The monitor will display both the program window and the ground plane. Please refer to Figure 3.1 in the CASM Program Window section.

   You may also enter the CASM program by double clicking the left mouse key on a project file (filename.bld) which is a CASM project file with the .bld extension. Please refer to the Autostart procedure in the Installation section of this guide.

---

**STARTING CASM - SHORT METHOD**

After the Windows and CASM programs have been installed in subdirectories, modify the AUTOEXEC.BAT file in the root directory using either EDLIN or another ASCII text file program (the Windows Notepad desktop application program may be used).

*Initial setup steps:*

1. Add the following line to the DOS PATH command (if it is already in the AUTOEXEC.BAT file) or insert the following line in the AUTOEXEC.BAT file:

   ```
   path c:\win;c:\casm
   ```

   assuming that both Windows and CASM are on the C: hard drive. WIN is the subdirectory name where the Windows program is stored, and CASM is the subdirectory name where the CASM program is stored. If the Windows or CASM subdirectories have been given other names, enter those names in place of WIN or CASM in the line above.

   You can also automatically start the Windows program in your project directory after starting (booting) the computer by adding the following lines to the end of the AUTOEXEC.BAT file.

   ```
   cd \projfiles
   win
   ```

   This step will start windows in your CASM project file directory (you may substitute the name of your project file directory in place of "projfiles"). You
may start project files by double clicking the left mouse key on the name of a project file.

2. Save the modified AUTOEXEC.BAT file. Reboot the computer, [CTRL]+ [ALT]+ [DEL], in order to activate the PATH command.

The sequence for starting the CASM program is:

After the DOS prompt.

1. Go to the directory where the CASM project files are located by typing:
   \cd \projfile [ENTER]

2. Type: \win casm [ENTER]

An hourglass will appear while the CASM program is loading into the computer memory. The hourglass symbol will remain on the screen until the CASM program is fully loaded. After the CASM program has loaded:

Dual-Monitor System: The primary monitor (EGA, VGA, or Monochrome) will display the program window and the secondary monitor (high-resolution MATROX) will display the ground grid. Please refer to Figures 3.2 and 3.3.

Single-Monitor System: The monitor (EGA or VGA) will display both the program window and the ground grid. Please refer to Figure 3.1.

3. Load your project file by using the Open command on the CASM File pull-down menu bar.
THE CASM PROGRAM WINDOW

The CASM program window provides you with a variety of command menuing options. You may use the keyboard to activate the commands in the menus; however, the program is much easier to use if you have a mouse. There are two CASM Window display options depending on your hardware configuration. The single-monitor option is displayed in Figure 3.1. The single-monitor configuration is used for a single EGA or VGA graphics card and monitor. The dual-monitor option is displayed in Figures 3.2 and 3.3. The dual-monitor configuration is used for a primary monitor consisting of a monochrome, EGA, or VGA graphics card and monitor and a secondary monitor consisting of a high-resolution Matrox SM graphics card and high-resolution, multi-sync, large-screen monitor. All of the CASM program window elements are displayed in the following figures. Following the figures is a brief definition of the program window elements.

Figure 3.1. Single-Monitor System Screen Display.
The following definitions of screen elements may be helpful as you begin to use CASM:

- The **System Menu Box** is common to the Windows format. It contains commands for manipulating the program windows. Activate by the mouse pointer or by the [Alt]+ [Space Bar] keys on the keyboard.

- The **Window Size Arrows** permit you to expand/reduce the size of the CASM program window or change it to an icon. Activate by the mouse pointer or by the System Menu commands, Size, Maximize, and Minimize.

- The **Title Bar** contains the program name (CASM) and current project filename. You may use the Title Bar to move the program window by placing the mouse pointer on the Title Bar; then press and hold the left mouse key while moving the mouse or use the Move command on the System Menu.

![Figure 3.2. Dual-Monitor System Primary Screen Display.](image)
THE CASM PROGRAM WINDOW

PROGRAM OVERVIEW

Figure 3.3. Dual-Monitor System Matrox Display.

- The **Pull-Down Menu Bar** contains the menu titles of the CASM command menus. Some of the Menu Bar selections produce pull-down menus while other selections produce pop-up Tool Palette windows with their own menu bars. Make selections with the mouse pointer or [ALT] + the underlined letter key.

- The **Tool & Dialog Area** is the location on the screen where the Viewpoint Tool, the pop-up Tool Palettes, the Pull-Down Menus, and Pop-up Dialog Windows are displayed. The Modeling Area is displayed in the Tool & Dialog Area on the single monitor system.

- **Pop-up Dialog Windows** permit you to make data selections and enter data. Make selections with the mouse pointer to select the data/input selection box or use the Tab key to make selections and the [Spacebar] to activate the selection. Pressing the [Enter] key will save the selections and close the window. Pressing [Esc] will cancel the dialog window.

- The **Viewpoint Tool** permits you to change the viewer's position in relation to the structural model on the modeling screen or permits you to select model displays such as solid (Matrox SM board), wireframe, 3-D, elevations, plans, or sections.

- The **Tool Palette** pop-up window is a graphic icon selection menu of CASM commands. All the icon command selections on the Tool Palette are repeated on the Tool Palette pull-down menus from the Tool Palette menu bar.

- The **Mouse Pointer** is the indicator you use to select menus, commands, tools, and icons. Movement of the Pointer is controlled by the mouse.
The **Icon Area** is the location on the screen where Icons representing active programs are stored for reference and ease of access. To activate a program Icon, move the mouse pointer to the Icon and double click the left mouse key. The Icon Area will not be visible on the Single Monitor Display until you Minimize the CASM window.

- The **MS-DOS Executive Icon** represents the Windows MS-DOS Executive program.

- The **Modeling Screen** contains the display of the Ground Plane, the 3-D structural model, plans, elevations, and sections. For the dual-monitor system the Modeling Screen is located on the high-resolution monitor. For the single-monitor system the Modeling Screen is located in the Tool & Dialog Area on the Windows display.

- The **Ground Plane** is the base plane for the structural model. A north arrow is located next to the Ground Plane for your reference. Grid spacing and size can be varied as desired.
RUNNING THE PROGRAM

CASM commands are organized into three distinct elements in the CASM window—the Pull-Down Menu Bar, the Viewpoint Tool, and the pop-up Tool Palette Windows. In addition to the command menus, data entry and data selections are entered via Pop-up Dialog Windows.

If you want to review how to choose commands in the CASM program or enter data, read the steps given here for the keyboard or the mouse. For complete information on choosing CASM commands and entering data, please refer to the Reference section following this section or to the CASM Tutorial.

PULL-DOWN MENU BAR

<table>
<thead>
<tr>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
</tr>
<tr>
<td>Open...</td>
</tr>
<tr>
<td>Save</td>
</tr>
<tr>
<td>Save As...</td>
</tr>
<tr>
<td>Print Data...</td>
</tr>
<tr>
<td>Print Screen...</td>
</tr>
<tr>
<td>Import...</td>
</tr>
<tr>
<td>Export...</td>
</tr>
<tr>
<td>Exit</td>
</tr>
<tr>
<td>About CASM...</td>
</tr>
</tbody>
</table>

To choose a command with the mouse:
1. Move the mouse pointer to a menu title on the pull-down menu bar.
2. Press the left mouse key.
   The menu or pop-up Tool Palette window will appear in the Tool & Dialog area on the screen.
3. Move the mouse pointer on the menu command list to the selection you want.
4. Press the left mouse key to carry out the command.

To choose a command with the keyboard:
1. When the CASM window is the active window (the Title Bar is highlighted), press the [Alt] key and the letter key. For example [ALT] and C opens the Criteria Menu.
2. Type the underlined letter of a command on the menu to carry out the command—OR—use the up or down arrows on the keyboard to move the selection bar up or down on the command menu and press the [Enter] key to carry out the command.

If the command needs more information, a Pop-up Dialog Window will appear prompting you for additional information. See the section entitled Use of Pop-up Dialog Windows later in this discussion.
Active command selections on the Pull-down Menus are designated by black print. Selections listed in gray print are either not active due to other command or configuration selections or not implemented in this version of CASM.

**VIEWPOINT TOOL**

The Viewpoint Tool is a small independent window in the upper left-hand corner of the Tool & Dialog area for the Dual-Monitor system (refer to Figure 3.2). For the single-monitor display the Viewpoint Tool is located in the upper right-hand corner of the Tool & Dialog Area (refer to Figure 3.1). You can move the Viewpoint Tool to different locations on the screen. The Viewpoint Tool can be used to change the orientation or view of the model on the modeling screen, such as viewing rotation, viewing height, and viewing distance from the center of the ground-level plane grid. In addition, the Viewpoint Tool can be used to change the views from 3-D wireframe, 3-D solid (dual-monitor system only), plan, or elevation by using the Viewpoint icons or the Options pull-down menu. Refer to the Reference section on how to change the views.

![Viewpoint Tool Diagram]

To move the Viewpoint Tool:
1. Move the mouse pointer to the Viewpoint title bar.
2. Press the left mouse key and hold it down.
3. While holding down the left mouse key move the Viewpoint Tool to any location on the screen.
   
   The boundary line of the Viewpoint Tool becomes dashed as it follows the movement of the mouse pointer.
4. Release the mouse key.
   
   The Viewpoint Tool moves to the new location.

To rotate the model on the modeling screen:
1. Move the mouse pointer to the black arrow that points to the circle.
2. Press the left mouse key and hold it down.
3. While holding down the left mouse key, move the mouse to drag the arrow around the circle.
When the arrow is moved, the 3-D model will rotate on the modeling screen.

4. **Release** the mouse key when the desired model orientation is established.

You may also locate the mouse pointer to a new location on the circle and press the left mouse key, the black arrow will move to the new location and the model will rotate to the new orientation.

**To change your 3-D viewing center (initial location is at the center of the ground plane):**

1. Move the mouse pointer to the black plus symbol in the center of the circle.
2. Press the left mouse key and hold it down.
3. While holding down the left mouse key, move the mouse in the direction which you desire to move the viewing center:
   - Right/Left = E-W
   - Toward/Away = N-S
   - Hold down right key & Toward/Away = Vertical
     When the mouse is moved, the viewing center mark on the screen will move.
4. Release the mouse key when the desired viewing center location is established.

**To pan the 2-D display (change the display vertically or horizontally on the screen):**

1. Move the mouse pointer to the plus symbol in the center of the circle.
2. Press the left mouse key and hold it down.
3. While holding down the left mouse key, move the mouse in the direction which you desire to Pan the display (right, left, away-down, toward-up)
   When the mouse is moved, the display will pan on the modeling screen.
4. Release the mouse key when the desired display orientation is established.

**To change your viewing height:**

1. Move the mouse pointer to a black arrow above or below the current height value.
2. Press and release the left mouse key to increment the viewer height up or down.

- **OR-**
  a. Press and hold the mouse key.
  b. Move the mouse pointer in the direction the height arrow is pointing in order to make large height changes. You may also reverse the direction of the mouse to reverse the height change.

The 3-D model on the modeling screen will be oriented to reflect the change in viewer height.

**You are allowed to select a negative height value (less than zero). This will allow you to look at any structure that is below the ground plane grid.**

3. Release the mouse key when the desired viewer height is established.
To change your viewing distance:

1. Move the mouse pointer to a black arrow to the right or left of the current distance value.
2. Press and release the left mouse key to increment the viewer distance farther or closer to the model.
   -OR-
   a. Press and hold the mouse key.
   b. Move the mouse pointer in the direction the distance arrow is pointing in order to make large distance changes. You may also reverse the direction of the mouse to reverse the viewing distance change.

The 3-D model on the modeling screen will be oriented to reflect the change in viewer distance.

3. Release the mouse key when the desired viewer distance is established.

For the Single-Monitor System, you may use the rotate tool, height tool, or distance tool to redraw the screen.

The distance tool will permit you to ZOOM IN and OUT for 2-D displays.
TOOL PALETTE WINDOWS

There are four Tool Palette Windows: VIEWPOINT, DRAW MODEL, DRAW STRUCTURE, and LOADS AND DESIGN. Located on the Tool Palette windows are Tool Icons which are graphic representations of commands that are also located on the Tool Palette pull-down menus. The Tool Icons in the Tool Palette windows allow you to quickly select a command without having to pull down a menu.

Shapes Edit Layout Reference

You can move the Tool Palette windows to another location in the Tool & Dialog Area on the screen. You may select one or all of the Tool Palette windows to be displayed on the screen if you desire. For the Single-Monitor System the Tool Palette windows are placed in the lower left corner of the Tool & Dialog area in order to provide more area for your structural model. You must use the System Menu box at the top left corner of the Tool Palette window to close the window.

Further detailed explanations of each Tool Palette window and its pull-down menu are contained in the Reference section in this guide.

To move the Tool Palette:
1. Move the mouse pointer to the Tool Palette title bar.
2. Press the left mouse key and hold it down.
3. While holding down the left mouse key move the Tool Palette to any location on the screen.
   The boundary line of the Tool Palette becomes dashed and it follows the movement of the mouse pointer.
4. Release the mouse key.
   The Tool Palette moves to the new location.

To display Tool Palettes:
1. Move the mouse pointer to the menu selection on the Pull-Down Menu Bar:
   Draw Model, Draw Structure, or Loads and Design.
2. Press the left mouse key.
   This will bring the Tool Palette window on the screen.
To select a command from the Tool Palette window (Dual Monitor):

1. Move the mouse pointer to the desired Tool icon.
2. Press the left mouse key.
   The selected Tool icon will be highlighted.
   A variety of responses will occur depending on which Tool icon is selected. Refer to the Reference section for a complete description of each Tool Icon.

An alternate method to the Tool Icon is to select a pull-down menu from the Tool Palette Menu Bar and select the command from the pull down menu.

To select a command from the Tool Palette window (Single Monitor):

1. Move the mouse pointer to the menu selection of the Pull-Down Menu Bar.
2. Press the left mouse key.
   This will display the Pull-Down Menu on the screen.
3. Move the mouse pointer to the desired menu selection and press the left mouse key.
   A variety of responses will occur depending on which menu item is selected. Refer to the Reference section for a complete description of each menu selection.

To remove a Tool Palette window:

1. Move the mouse pointer to the System Box in the top left corner of the Tool Palette window.
2. Double click the left mouse key.

OR

a. Press the left mouse key.
   The Tool Palette System Pull-Down Menu will appear.
b. Move the mouse pointer to the Close command.
c. Press the left mouse key (you may also activate the Close command by typing 'c' on the keyboard).
   The Tool Palette window will disappear.

USE OF POP-UP DIALOG WINDOWS

Pop-up Dialog Windows will appear in the Tool & Dialog Area on the screen, after a menu command is selected, to guide you with data entries and data selections and to confirm the intended action. The Dialog Window will contain all or some of the following items: a title bar; lines of text, headings, or lists; and data input/seletion boxes with a vertical or horizontal cursor bar that represents the keyboard cursor location.
There are three types of data input/selection boxes in the Pop-up Dialog Window: action boxes which contain confirmation words such as YES, NO, SAVE, CANCEL; data boxes which are either blank or contain alphanumeric data or lists; and selection boxes or circles which are blank or contain an 'X' or a dot.

Refer to the following general guidelines when using Pop-up Dialog Windows.

To select a data input/selection box:

When the pop-up dialog window first appears, the cursor is automatically located in the first data input/selection box. If the first box is a data box, you may enter data by typing it from the keyboard. If the first box is an action box, you may press the [Space bar] to initiate the action/confirmation.

For other data input/selection boxes:

1. Move the mouse pointer to the appropriate data input/selection box.

   For some data boxes you may use the [Tab] key on the keyboard to move sequentially through the data boxes.

   We want to caution you about using the [Enter] key when entering data in the Dialog Windows. Pressing the [Enter] key automatically accepts the default selections, plus any changes you made, and closes the Dialog window.

2. Press the left mouse key.

   For the action boxes, pressing the left mouse key will confirm the action initiated by a menu command or stated by the word in the action box. When a horizontal cursor is located under the action box and statement, pressing the [Space bar] may be used instead of pressing the left mouse key.

   For the selection box, pressing the left mouse key will add or delete an 'X' or dot, which represents either a selection or nonselection of the item specified.

   For the data box, pressing the left mouse key will position the vertical cursor for data entry or call up another data window for preselected data entry.
For a blank data window, position the vertical cursor at the left end of the empty box with the mouse and press the left key. Type in the appropriate entry. Do not use the [Enter] key when you have completed your entry.

For a data box which already has an entry, you may:

Move the mouse pointer to the entry, press and hold the left mouse key, and drag the pointer across the entry. Release the mouse key when the entry is highlighted. Typing in the new entry will overwrite the old entry.

-OR-

Move the mouse pointer to any point on the current entry; press the left mouse key and the vertical cursor will appear at the designated point on the current entry. New characters as you type them from the keyboard will be inserted in the current entry. Use the [Backspace] key to delete letters.

For a data box that has an associated list of entries, you may:

Select an entry from the list by moving the mouse pointer to the desired item on the list. You may double click (press and release twice in quick succession) the left mouse key to automatically move the item from the list to the data box. After the item is in the data box, you may edit/modify the item by use of the backspace key and by typing new characters.

-OR-

An alternate method is to press the left mouse key once to highlight the item. Then move the mouse pointer to the 'OK' box and press the left mouse key to transfer the item to the data box.

**SAVING YOUR WORK ON DISK**

This version of CASM does not have an automatic save feature. You must use the SAVE or SAVE AS commands from the FILE pull-down menu in order to save your project files to a specified disk. The data that are saved in the project file include load lists, criteria data, and modeling data. The file name extension .bld is automatically added to the 8-character or less project file name when the file is saved.

When the CASM program calculates the snow and wind load, all your output files for wind or snow loads are automatically saved to disk with the file name which you specify. The extension .txt is automatically added to the 8-character load output file name when the file is created and saved.

**To SAVE the project file:**

Select the Save or Save As commands from the File Menu.

1. Move the mouse pointer to the File menu selection on the Pull-Down Menu Bar (you may also use [ALT] + [F]).
2. Press the left mouse key.
   
   The File Pull-Down Menu will appear.
3. Move the mouse pointer to the Save or Save As command.
4. Press the left mouse key (you may also activate the Save command by typing [S] on the keyboard or the Save As command by typing [A] on the keyboard).

SAVE

If the file has been saved before:

The SAVE command automatically replaces (adds changes to) the last disk copy of the project file name displayed on the Title Bar in the CASM program window. The hourglass symbol will appear to indicate that the file is being saved to the hard disk.

If the file has not been saved before:

The label (untitled) is in the Title Bar, and you will be prompted for a file name by a pop-up dialog window.

1. Type the desired project file name (8 characters or less). The extension .bld is automatically added to the project file name by the CASM program when you press ENTER or select SAVE in the pop-up dialog window with the mouse pointer.

To designate a specific directory or drive to store the file on other than the default directory, you will need to add the disk and/or directory location before the 8-character name.

A:filename.bld

The designation A: specifies that the file is to be saved on a floppy disk in the A: drive.

2. Select SAVE with the mouse pointer and press the left mouse key to save the file (you may also press the [Enter] key to activate the SAVE command).

SAVE AS

You may use the SAVE AS command if you do not want to replace (add changes to) the data stored under the file name displayed in the Title Bar in the CASM program window.

A pop-up dialog window will appear to permit you to enter a project file name.
1. Type the desired project file name (8 characters or less). The extension .bld is automatically added to the project file name by the CASM program.

   If you enter the same name as a file that is currently stored on the disk, a pop-up window will warn you and confirm if you want to replace the file.

2. Select SAVE with the mouse pointer and press the left mouse key to save the file (you may also press the [Enter] key to activate the SAVE command).

   The current data file in the CASM Title Bar will be the new file name.

To print/save output files:

You may print or save a variety of output files to the hard disk or floppy disks from CASM in order to provide documentation for your selection of a building system. Project criteria and load values can be printed to an output file or to a printer when you select the Print Data command on the File pull-down menu. Model views can be printed to an output file in an IN*A*VISION .PIC format or an AutoCAD .DXF format when you select the Print Screen command on the File pull-down menu. When calculating loads and analyzing members, all calculations are printed to output files on disk.

Using Print Data command to print/create a file

1. Move the mouse pointer to the File selection on the pull-down menu bar.
2. Press the left mouse key.
   The File pull-down menu will appear.
3. Move the mouse pointer to the Print Data command.
4. Press the left mouse key.
   A pop-up dialog window will appear with options to print or create a file with project criteria and/or load data.
5. You may use the mouse pointer to check the appropriate boxes by moving the mouse pointer to the box and pressing the left mouse key. The X in the box indicates a selected option.

If you are saving the data to an output file you need to check the output file name in the box and change it if you desire.

6. After you have made your selections, you can activate the command by pressing the ENTER key or by moving the mouse pointer to the OK box and pressing the left mouse key.

If you are printing data to a file:

The NOTEPAD program will be run with a copy of your output file. You may review the output data and exit NOTEPAD using the CLOSE command on the SYSTEM pull-down menu box or Exit from the NOTEPAD File pull-down menu. Because the output file was automatically saved on disk, there is no need to save it when you exit the NOTEPAD program.

If you make editing changes or entries to the output file while in NOTEPAD, you must use the Save or Save As commands in the NOTEPAD File pull-down menu to save them in the output file.

When you exit the NOTEPAD program, a dialog window will appear to remind you to save your work if you have made any changes or entries to the output file. After you exit NOTEPAD you will be returned to the CASM Program Window.

Using Print Screen command to create a model view file
1. Move the mouse pointer to the File selection on the pull-down menu bar.
2. Press the left mouse key.
   The File pull-down menu will appear.
3. Move the mouse pointer to the Print Screen command.
4. Press the left mouse key.
A pop-up dialog window will appear with options to create a graphic file within either an IN* A* VISION .PIC format or an AutoCAD .DXF format.

![Print Screen]

- In*a*Vision file
- AutoCAD DXF file

File: CASM.PIC

OK Cancel

5. You may use the mouse pointer to check the appropriate boxes by moving the mouse pointer to the box and pressing the left mouse key. A "black dot" in the circle indicates a selected option.

*** If you are saving the data to an output file you need to check the output file name in the box and change it if you desire (the default name is CASM.PIC for the IN* A* VISION file and CASM.DXF for the AutoCAD file).

6. After you have made your selections, you can activate the command by pressing the [Enter] key or by moving the mouse pointer to the OK box and pressing the left mouse key.

7. If you select the IN* a* Vision file, the screen image will be automatically loaded and displayed in IN* a* Vision. Use the CLOSE command in the IN* a* Vision System menu to return to CASM. You may also access the .PIC graphic file by IN* A* VISION or Designer and the .DXF file by AutoCAD.

**Using Snow, Wind, or Min Roof Ld commands to create a text file**

1. **Move** the mouse pointer to the Loads and Design selection on the pull-down menu bar.

2. **Press** the left mouse key.

   The Loads and Design pop-up Tool Palette will appear.

3. **Move** the mouse pointer to the Snow or Wind Icon or use the Loads pull-down menu from the pull-down menu bar.

4. **Press** the left mouse key.

   A pop-up dialog window will appear with project-specific code values and a default filename for saving the output load data after the wind, snow, or minimum roof load on the structure has been calculated.

5. You may use the mouse pointer to check the appropriate boxes by moving the mouse pointer to the box and pressing the left mouse key.

   *** If you are saving the data to an output file you need to check the output file name in the box and change it if you desire.

6. After you have made your selections, you can activate the command by pressing the [Enter] key or by moving the mouse pointer to the OK box and pressing the left mouse key.
If you are printing data to a file:

You can access the file with the Windows Notepad program. To access Notepad you will need to open the MS-DOS Executive Window.

1. Move the mouse pointer to the System Box.
2. Press the left mouse key.
   The System Menu will be displayed.
3. Press the [N] key to Minimize the CASM Window. (You may also move the mouse pointer to the Minimize command and press the left mouse key.)
   The CASM window will be reduced to an icon in the lower left corner of the screen. The MS-DOS Executive Window should automatically be displayed.
   If it is not, use the following procedure:
   a. Place the mouse pointer on the MS-DOS Executive Icon.
   b. Double click the left mouse key.
      The MS-DOS Executive Program Window will be displayed.
   c. Move the mouse pointer to the desired .txt file to edit.
   d. Double click the left mouse key.

You may review and print the output data, then exit Notepad using the Close command on the Notepad System pull-down menu box or Exit from the Notepad File pull-down menu. Because the output file was automatically saved on disk, there is no need to save it when you exit the Notepad program.

If you make editing changes or entries to the output file while in Notepad, you must use the Save or Save As commands in the Notepad File pull-down menu to save them in the output file.

When you exit the Notepad program, a dialog window will appear to remind you to save your work if you have made any changes or entries to the output file.

To re-enter the CASM program:

1. Place the mouse pointer on the CASM Icon.
2. Press the left mouse key.
   The CASM System Menu will be displayed.

For the Single-Monitor System:

Press the [R] key to Restore the CASM Menu.

For the Dual-Monitor System:

Press the [X] key to Maximize the CASM Menu.
You may use the Windows MS-DOS Executive program to manage the quantity of project files and output files which accumulate in the CASM directory. You may use the following commands from the MS-DOS Executive FILE pull-down menu to manage the CASM files:

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run...</td>
<td></td>
</tr>
<tr>
<td>Load...</td>
<td></td>
</tr>
<tr>
<td>Copy...</td>
<td></td>
</tr>
<tr>
<td>Get Info</td>
<td></td>
</tr>
<tr>
<td>Delete...</td>
<td></td>
</tr>
<tr>
<td>Print...</td>
<td></td>
</tr>
<tr>
<td>Rename...</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td>About MS-DOS Exec...</td>
</tr>
</tbody>
</table>

**COPY**
To copy the CASM project files with the .bld, .txt, .plc, or .dxf extensions to another directory or disk.

**DELETE**
To delete unwanted CASM project files with the .bld, .txt, .plc, or .dxf file extension. Do not delete filenames with extensions other than .bld, .txt, .plc, or .dxf.

**RENAME**
To rename CASM project files. You must add the .bld, .txt, .plc, or .dxf extension to the new file name.

**Starting CASM from a project .bld file:**
1. Find the desired project .bld file name on the list of files.
2. Move the mouse pointer to the desired file name.
3. Double click the left mouse key.

   The CASM program window will automatically appear with the project file.

   Before you can start CASM by double clicking on a project .bld file, you must add the auto-start feature. See page 2-6 in the Installation section.

   You may also load new project files while in the CASM program by using the Open command from the CASM File pull-down menu. Refer to the Reference section on how to use the Open command.

**Starting Notepad from an output .txt file:**
1. Find the desired output .txt file name on the list of files.
2. Move the mouse pointer to the desired file name.
3. Double click the left mouse key.

The Notepad program window will automatically appear with the output file.

You cannot open an existing output file while in the CASM program, unless you access the output file via the MS-DOS Executive program. You will need to open the MS-DOS Executive window over the CASM window, then select the .txt file you desire. You may then rearrange program/file windows on the screen if you want to keep the output file open for reference or close program windows which you do not need.

STOPPING THE PROGRAM

You can stop the CASM program at any point in your project development and resume at a later time. You may stop the CASM program by selecting Exit from the CASM File pull-down menu or Close from the System, pull-down menu box.

Stopping CASM using Exit from the File pull-down menu:

1. Move the mouse pointer to the File selection on the Pull-Down Menu Bar.
2. Press the left mouse key.

The File Pull-Down menu will appear.

<table>
<thead>
<tr>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
</tr>
<tr>
<td>Open...</td>
</tr>
<tr>
<td>Save</td>
</tr>
<tr>
<td>Save As...</td>
</tr>
<tr>
<td>Print Data...</td>
</tr>
<tr>
<td>Print Screen...</td>
</tr>
<tr>
<td>Import...</td>
</tr>
<tr>
<td>Export...</td>
</tr>
<tr>
<td>Exit</td>
</tr>
<tr>
<td>About CASM...</td>
</tr>
</tbody>
</table>

3. Move the mouse pointer to the Exit selection on the menu.
4. Press the left mouse key to activate the command (you may also activate the Exit command by typing [X]).

The CASM program window will disappear.

If changed/new entries have been made to your project file from the last time you saved the file, a pop-up dialog window will appear to prompt you to save changes to the file.

Stopping CASM using Close from the System pull-down menu:

1. Move the mouse pointer to the System Box in the top left corner of the CASM window.
2. Double click the left mouse key.

   The CASM Window will disappear.

   You may also use the following method:

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore</td>
<td>Alt+F5</td>
</tr>
<tr>
<td>Move</td>
<td>Alt+F7</td>
</tr>
<tr>
<td>Size</td>
<td>Alt+F8</td>
</tr>
<tr>
<td>Minimize</td>
<td>Alt+F9</td>
</tr>
<tr>
<td>Maximize</td>
<td>Alt+F10</td>
</tr>
<tr>
<td>Close</td>
<td>Alt+F4</td>
</tr>
</tbody>
</table>

   a. Move the mouse pointer to the Close selection on the menu.

   b. Press the left mouse key to activate the command (you may also activate the Close command by typing [C]).

   The CASM program window will disappear.

   ![Save current changes: TEMP.BLD](image)

   If changed/new entries have been made to your project file from the last time you saved the file, a pop-up dialog window will appear to prompt you to save changes to the file.
Windows also provides several useful Desktop application programs. Detailed instruction covering the use of these applications is contained in the Windows Desktop Applications User Guide which is contained in the Microsoft Windows User's Guide.

CARDFILE

Cardfile is a very simple database management program which permits you to store data on program-generated notecards. With Cardfile you can avoid sorting paper note cards by hand. Enter any information you want (i.e., names, addresses, phone numbers, structural data, material cost data) in any order and let Cardfile do the sorting for you. CASM criteria data are saved in a Cardfile datafile based on city/installation location. Whenever a location is selected for a building project, all the regional and site-specific data will be automatically copied into the CASM project criteria file. You may modify or create new CASM criteria data cards for future installations using the Cardfile program. Cardfile is also used by CASM to display structural engineering guidelines about structural systems.

NOTEPAD

Notepad is a program-generated memo pad. You can copy or cut (delete) text from other applications and paste it into Notepad or cut text from Notepad and paste it into other applications. Output files such as design criteria and load and structural data from CASM are automatically formatted for review, editing, and printing via Notepad. Notepad is an ASCII text editor. It can also be used for editing batch files instead of EDLIN, the standard DOS editor.

CALCULATOR

Use the Calculator program to perform standard arithmetic functions while running other programs. You may want to start the Calculator program and keep it handy as an icon while using the CASM program.

CALENDAR

The Calendar program helps you keep track of your daily appointments. It also has an alarm to remind you of your appointment time.

CLOCK

Shrink the clock to an Icon, and the familiar clockface--complete with sweeping second hand--remains on the screen without taking work space.

WRITE

Write is a word processor provided with the Windows program. With Write you can write, edit, and print all kinds of documents. Graphic or other information can be electronically "pasted" from other applications into your Write documents.
from the CASM program or data from the Structure, Loads, or Criteria files may be "pasted" from Notepad onto your Write documents.

PAINT

Paint is a basic drawing tool provided with the Windows program. With Paint you can create, enhance, save, and print graphics such as charts or diagrams.

OTHER APPLICATION PROGRAMS

There are several other programs which interface with Windows and are used with CASM. These programs are not included in the Windows package and must be purchased separately. User guides which describe the operating procedures are provided with each of these programs.

IN*A*VISION by Micrografx

IN*A*VISION is a CAD program for use with Microsoft Windows. With IN*A*VISION you can create, enhance, save, and print CASM graphics such as plans, elevations, and sections. A library of architectural symbols is available for your use. Views from the CASM program may be electronically pasted on your IN*A*VISION canvas. This is an old program that has been replaced by the Micrografx Designer graphic program.

DESIGNER by Micrografx

Designer is a graphics program for use with Microsoft Windows. With Designer you can create, enhance, save, and print structural graphics such as plans, elevations, and sections for presentations or for inclusion in a document. Special libraries of symbols are available for your use. Views from the CASM program may be electronically pasted on your Designer canvas.

EXCEL by Microsoft

EXCEL is a spreadsheet program for use with Microsoft Windows. A series of EXCEL spreadsheets have been developed for use with CASM in order to allow the user to evaluate several structural framing alternatives based on project criteria and to select preliminary member sizes for cost evaluation and structural analysis.

In addition, Windows supports a variety of other programs, such as databases, publishing programs, and structural analysis programs. Windows is the primary menuing/ utility program for use with DOS. Windows permits multi-tasking and multi-displays for the IBM and IBM-compatible 386 and 286 computers.
This chapter describes all of the elements on the CASM screen. It includes a graphic display of each of the special graphic Tool Palette windows used in the CASM program. Refer also to the Program Overview section which describes the basic operations of CASM.

A discussion and listing of the operational sequence for each of the graphic Tool Palettes, menu selections, and window dialog boxes accompanies each graphic display. Also included in this chapter are brief instructions for using three of the Microsoft Windows Desktop Applications: Notepad for the editing and printing of the Design Criteria and Load lists including Snow and Wind loads; Cardfile for recording standard Design Criteria data used frequently for building projects; and EXCEL for the selection of preliminary structural member sizes.

A detailed description on the use of MS-DOS, Microsoft Windows, and Microsoft EXCEL is not included in this chapter. You may want to refer to the MS-DOS, Microsoft Windows, and Microsoft EXCEL user guides for additional information concerning their use.
The System Menu is common to all program windows. It contains commands for manipulating the Program Windows. The System menu is a pull-down menu. It is accessed via the System Menu Box in the upper left corner of the current Program Window. Several of the commands have alternate activation methods for the keyboard or mouse. The System Menu command list and operation sequence are defined below.

To select a command from the SYSTEM Menu with the mouse:

1. Move the mouse pointer to the small box in the upper left corner of the CASM Application Window.
2. Press the left mouse key.
3. Move the mouse pointer down the command list to the selection you want.
4. Press the left mouse key to carry out the command.

The SYSTEM Pull-down menu has been designed specifically for the keyboard. For the mouse there are several alternate methods which are faster than using the SYSTEM pull-down menu.

<table>
<thead>
<tr>
<th>Command</th>
<th>Alternate Mouse Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move</td>
<td>Place the mouse pointer on the Title Bar and double click the left mouse key. Or place the mouse pointer on the double arrows and press the left mouse key.</td>
</tr>
<tr>
<td>Size</td>
<td>Place the mouse pointer on the Window Border, press the left mouse key, and hold it down to move the window border.</td>
</tr>
<tr>
<td>Minimize</td>
<td>Place the mouse pointer on the down arrow at the top right corner of the window and press the left mouse key.</td>
</tr>
<tr>
<td>Maximize</td>
<td>Place the mouse pointer on the up arrow at the top right corner of the window and press the left mouse key.</td>
</tr>
</tbody>
</table>

To select a command from the SYSTEM Menu with the keyboard:

2. Type the underlined letter of the command to carry out the command.

-OR-

Use the up or down arrows on the keyboard to move the selection bar up or down to the desired selection and press the [Enter] key. The right or left arrow keys on the keyboard will allow you to select other menus on the menu bar.
The SYSTEM Menu commands are listed on the following pages:

**RESTORE**

The Restore command is active after you have maximized the current program window (expanded the current program window to fill the screen) or minimized the current program window (changed the window to an icon). It permits you to return the program window display to a shared (overlay) display with other program windows. If you have a mouse you can also Restore the program window by using the double arrow box on the top right corner of the screen or double click the mouse pointer on the Title Bar.

The Restore command is only active when the program window has been maximized or minimized on the Dual-Monitor system. The Restore command is not active on the Single-Monitor system when the CASM window is Maximized. If the Restore command is not active, the print will appear to be light grey, not black.

Select the RESTORE command with the mouse:

1. Move the mouse pointer to the double arrow box at the top right corner of the screen. (If the double arrow box is not displayed, Restore command is not active.)
2. Press the left mouse key.
   The program window display will return to a shared (overlay) display with other program windows (Dual-Monitor system only).

Select the RESTORE command with the keyboard:

1. Press the [ALT] + [SPACEBAR] to display the System Pull-Down Menu ([ALT] + [F5] will automatically carry out the Restore command without displaying the System Menu.)
2. Press the [R] key (or [ENTER] key if the Restore Command is highlighted) to carry out the command.
   The program window display will return to a shared (overlay) display with other program windows.

The shared (overlay) display may not be desirable in the Single-Monitor system due to the limited display area for the structural model graphics.

To select the RESTORE command from the SYSTEM Menu of the CASM Icon with the mouse:

1. Move the mouse pointer to the CASM Icon in the Icon Area.
2. Double click the left mouse key.
   The CASM Icon automatically changes into a CASM Program Window on the screen.
The MOVE command lets you move a program window or toolbox window to another position on the screen. If you have a mouse you can move the window by using the Title Bar.

Select the MOVE command with the mouse:
1. Move the mouse pointer to the Title Bar in the Application Window.
2. Press the left mouse key and hold it down.
   The active program window border is highlighted.
3. Move the mouse pointer (and window border) to another location on the screen where you want to locate the program window.
4. Release the left mouse key to change the current window location to the new location.
   The program windows will move to the new location on the screen.

Select the MOVE command with the keyboard:
1. Press the [ALT] + [SPACEBAR] keys to display the System Menu. (You may activate the Move command by pressing the [ALT] + [F7] keys without displaying the System Menu.)
2. Press the [M] key to activate the Move command.
   The mouse pointer changes to a four-headed arrow, and the active program window border is highlighted.
3. Use the cursor arrow keys on the keyboard to move the outline of the window to the desired new location.
4. Press the [Enter] key to move the program window to the new location on the screen.
   The program window will move to the new location on the screen.

Moving the program windows may not be desirable in the Single-Monitor System due to the limited display area for the structural model graphics.

The SIZE command lets you change the size of a program window when the window is sharing the screen with several program windows. If you have a mouse, you can change the size of a window by moving the mouse pointer to one of the four borders or corners of the program window.

To select the SIZE command with the mouse:
1. Move the mouse pointer to the any of the borders or corners of the current Program Window.
The mouse pointer changes to a double-ended arrow.

2. Press the left mouse key and hold it down.

A dashed boundary line is created which is attached to the mouse pointer.

3. Move the boundary line until the desired Window size is achieved.

4. Release the left mouse key to change the current Window size to the new size indicated by the dashed boundary line.

Select the SIZE command with the keyboard:

1. Press the [ALT] + [SPACEBAR] to display the System Menu. (You may use [ALT] + [F8] to activate the Size command without displaying the System Menu.)

2. Press the [S] key to carry out the Size command.

The mouse pointer changes to a double-ended arrow.

3. Use the cursor keys to move the mouse pointer to the side or corner that you want to move.

When the pointer moves beyond the border of the window, a dashed boundary line is created and attaches to the pointer.

4. Move the boundary line until the desired Window size is achieved.

5. Press the [Enter] key to change the current Window size to the new size indicated by the dashed boundary line.

Changing the program window size may not be desirable in the Single-Monitor system due to the limited display area for the structural model graphics.

MINIMIZE

The Minimize command shrinks the selected program window into an Icon and places the Icon in the Icon area. If you have a mouse you can change the program window to an Icon by using the down arrow on the top left corner of the screen.

Select the MINIMIZE command with the mouse:

1. Move the mouse pointer to the down arrow on the top right corner of the program window.

2. Press the left mouse key.

The CASM Program Window automatically changes into a CASM Icon (small house) located in the Icon Area.

For the Single-Monitor system, an Icon of the XGVIEW program window will also appear in the Icon area.

Select the MINIMIZE command with the keyboard:
1. Press the [ALT] + [SPACEBAR] to display the System Menu. (You may use [ALT] + [F9] to activate the Minimize command without displaying the System Menu.)

2. Press the [N] key to carry out the Minimize command.

The CASM Program Window automatically changes into a CASM Icon (small house) located in the Icon Area.

> For the Single-Monitor system, an Icon of the XGVIEW program window will also appear in the Icon area.

**MAXIMIZE**

The Maximize command expands the CASM Window to the full screen by placing the active program window over the icon area and other program windows on the screen. If you have a mouse you can maximize the program window by using the up arrow on the top left corner of the screen.

> For the Single-Monitor system, you SHOULD NOT select the Maximize command or you will lose the display of the structural model. Use the Restore command instead.

**Select the MAXIMIZE command with the mouse:**

1. Move the mouse pointer to the up arrow on the top right corner of the program window.
2. Press the left mouse key.

   The program window automatically expands to fill the entire screen. All other Application Windows and the Icon area are hidden.

**Select the MAXIMIZE command with the keyboard:**

1. Press the [ALT] + [SPACEBAR] to display the System Menu. (You may use [ALT] + [F10] to activate the Maximize command without displaying the System Menu.)
2. Press the [X] key to carry out the Maximize command.

   The program window automatically expands to fill the entire screen. All other Application Windows and the Icon area are hidden.

**To select the MAXIMIZE command from the SYSTEM Menu of the CASM Icon with the mouse:**

1. Move the mouse pointer to the CASM Icon in the Icon Area.
2. Press the left mouse key.

   The CASM System Menu will appear.

3. Press the [X] key to Maximize the CASM Program Window on the screen.
   (You may also move the mouse pointer to the Maximize command and press the left mouse key.)
The CASM Icon automatically changes into a CASM Program Window on the screen.

CLOSE

The Close command closes the CASM program and project file running in the CASM Window and removes the CASM program from memory. To use the CASM program again, you must start it from the MS-DOS Executive Window. A pop-up dialog window will appear which displays the current directory, the file name, and options to save the file (YES, NO, or CANCEL) if you have made changes to the project file and have not saved them. If you have a mouse you can Close the program by moving the mouse pointer to the System Menu box and double clicking the left mouse key.

Select the CLOSE command with the mouse:
1. Move the mouse pointer to the System Menu box on the top left corner of the current program window.
2. Double click the left mouse key.
   A pop-up dialog window appears to permit you to save changes to the current project file.

Select the CLOSE command with the keyboard:
1. Press the [ALT] + [SPACEBAR] to display the System Menu. (You may use [ALT] + [F4] to activate the Close command without displaying the System Menu.)
2. Press the [C] key to carry out the Close command.
   A pop-up dialog window appears to permit you to save changes to the current project file.

To save changes if the file is (untitled):
1. Move the mouse pointer to the YES box with the mouse or the [Tab] key.
2. Press the left mouse key or the [Spacebar].
   A pop-up dialog window appears which displays the current directory, a box for the file name, and options to SAVE the file or CANCEL the save command.
3. Type in an appropriate file name with 8 characters or less. The extension .BLD will be automatically added. Do not use another extension.
4. Move the mouse pointer to the SAVE box with the mouse or the [TAB] key.
5. Press the left mouse key or the [Spacebar].
If you save the project file and a project file of the same name exists, you will be prompted if you want to replace (add changes to) the existing project file.

The project file will be saved, the CASM program will stop, and you will be returned to the Windows MS-DOS Executive program.

To save changes if the file has a name:

A pop-up dialog window appears which displays the current directory, the file name, and options to save the file (YES, NO, or CANCEL).

1. Move the mouse pointer to the appropriate box with the mouse or the [Tab] key.
2. Press the left mouse key or the [Spacebar].

Changes will be added to the current project file if YES is selected. If NO is selected, changes will not be added. The CASM program will stop, and you will be returned to the Windows MS-DOS Executive program.

If CANCEL is selected, you will be returned to the CASM program window.
The File Menu is a pull-down menu used to manipulate CASM project data files. Use the File Pull-Down Menu to create a new project file, to open an existing project file, to print project data or project views, to save a project file, and to stop the program operation.

Both the Open and New commands remind you to save any changes to the current project model before proceeding.

To select a command from the FILE Menu with the mouse:
1. Move the mouse pointer to the File heading on the pull-down menu bar of the CASM program window.
2. Press the left mouse key.
3. Move the mouse pointer down the command list to the selection you want (you may also activate the command by typing the underlined letter in the desired command).
4. Press the left mouse key to carry out the command.
   A dialog window will appear.

To select a command from the FILE Menu with the keyboard:
1. Press the [Alt] key and the [F] key together.
   The File Menu will appear.
2. Type the first letter of the command to carry out the command.
   -OR-
   Use the up or down arrows on the keyboard to move the selection bar up or down. Then press the [Enter] key to carry out the command.

The FILE Menu command selections are listed on the following pages:
The New command removes the current modeling window and project file, then opens a new modeling window and an 'untitled' project file. When you first enter the CASM program you are automatically in the New mode. The default project file name is (untitled). When you select the New command after doing work on a project file in the CASM program, a dialog box will remind you to save changes to the current project file before starting a new project file.

Select the NEW command from the FILE menu.

If changes have been made to the current project file:

A dialog box prompts you to save changes to the current project file.

![Save current changes: WESDEMO.BLD](image)

1. Move the mouse pointer to the YES or NO box with the mouse (or use the [Tab] key on the keyboard).
2. Press the left mouse key to indicate your selection (or press the [Spacebar] on the keyboard).
   a. If you select YES to save a named project file, the file will be saved and a new (untitled) file will be started.
   b. If you select YES to save the project file and the file is (untitled), you will be prompted for a project file name.
   c. If you select NO to not save the project file, the current project file will be stopped without adding the changes and a new 'untitled' file will be started.

To save changes if the file is (untitled):

A pop-up dialog window appears which displays the current directory, a box for the file name, and options to SAVE the file or CANCEL the save command.

1. Type in an appropriate file name with 8 characters or less. The extension .BLD will be automatically added. Do not use another extension.
2. Move the mouse pointer to the SAVE box (or use the [Tab] key on the keyboard).
3. Press the left mouse key (or press the [Spacebar] on the keyboard).
   The file will be saved and a new (untitled) file will be started.

   If you select SAVE to save the project file and a project file of the same name exists, you will be prompted if you want to replace (add changes to) the existing project file.
The Open command opens a project file and modeling window of a previously created project. When you select the Open command after doing work on a project file in the CASM program, a dialog box will remind you to save changes to the current project file before opening another project file.

Select the OPEN command from the FILE menu.

If changes have been made to the current project file:
A dialog box prompts you to save changes to the current project file.

1. Move the mouse pointer to the YES or NO box using the mouse (or the [TAB] key on the keyboard).
2. Press the left mouse key (or press the [Spacebar]) to indicate your selection.
   a. If you select YES to save a named project file, the file will be saved.
   b. If you select YES to save the project file and the file is 'untitled,' you will be prompted for a .ject file name.
   c. If you select NO to not save the project file, the current project file will be stopped without adding the changes.

To save changes if the file is (untitled):
A pop-up dialog window appears which displays the current directory, a box for the file name, and options to SAVE the file or CANCEL the save command.

1. Type in an appropriate file name with 8 characters or less. The extension .BLD will be automatically added. Do not use another extension.
2. Move the mouse pointer to the SAVE box using the mouse (or the [Tab] key on the keyboard).
3. Press the left mouse key (or press the [Spacebar]) to indicate your selection. The file will be saved.
If you select SAVE to save the project file and a project file of the same name exists, you will be prompted if you want to replace (add changes to) the existing project file.

A dialog box will appear with a listing of CASM project files (filename.BLD). The dialog box prompts you either to choose a project model from the list box or type the project name of the model you want.

**To select a project file:**

1. Move the mouse pointer to a listed filename. Use the vertical arrows on the side to scroll the list up or down.
   
   You may use the list box to select another drive or directory.

2. Double click the left mouse key in order to automatically open the project file.

   **-OR-**

   Press the left mouse key to highlight the file selection. Then move the mouse pointer to the OPEN box and press the left mouse key.

   The selected project file will be opened. The model will be displayed on the modeling screen. Criteria and load data will be loaded.

**To cancel the OPEN command:**

1. Move the mouse pointer to the CANCEL box using the mouse (or the [Tab] key on the keyboard).

2. Press the left mouse key (or [Spacebar] on the keyboard) to cancel the command.

   The dialog window will disappear.
**SAVE**

The `Save` command saves the current project file on disk storage under the existing project file name. The program is interrupted momentarily during the save. An hourglass symbol will be displayed on the screen while the project file is being saved. If the file is untitled, a dialog window will appear to prompt you for a file name.

Select the `SAVE` command from the `FILE` Menu.

If the file is named, the program will pause momentarily while the changes are added.

The project file will be automatically replaced without confirming that you want to replace it.

To save changes if the file is (untitled):

A pop-up dialog window appears which displays the current directory, a box for the file name, and options to `SAVE` the file or `CANCEL` the save command.

1. Type in an appropriate file name with 8 characters or less. The extension `.BLD` will be automatically added. Do not use another extension.
2. Move the mouse pointer to the `SAVE` box using the mouse (or the `[Tab]` key on the keyboard.
3. Press the left mouse key once and release (or press the `[Spacebar]`) to activate the command.

The file will be saved with the designated file name.

If you select `SAVE` to save the project file and a project file of the same name exists, you will be prompted if you want to replace (add changes to) the existing project file.

---

**SAVE AS**

The `Save As` command saves the current model in a project file on the disk storage. The file may be saved under the current file name or a new file name may be inserted in place of the existing file name. When the file is saved under a new file name, the original version will remain unchanged. The extension `.BLD` is automatically added to the project file name.

Select the `SAVE AS` command from the `FILE` Menu.

A dialog window appears in order to verify the project file name and directory where the file is to be stored. If the file has a name, the name will be highlighted in the box.

You may select another drive and/or directory by adding the path to the drive and/or directory in front of the new file name.
1. Type in a new file name (8 characters or less). The extension, .BLD will be automatically added to the file name.

2. Move the mouse pointer to the SAVE box in order to save the file (or press the [Enter] key on the keyboard).

3. Press the left mouse key once and release (or press the [Spacebar]) to activate the command.

The CASM program will check for another file with the same name. If the program finds another file with the same name, a dialog window appears to confirm if you desire to replace (add changes to) the existing file which has the same name.

4. Select YES to replace the existing file or select NO to not replace the existing file.

You will be prompted again for a file name if you selected NO.

**PRINT DATA**

The PRINT DATA command prints specified criteria or load data. A dialog window prompts you for the data to be printed, Basic Design Criteria, Loads, or both. Choose an option from the selections given. You may print to the printer or to a file which you may review and edit before printing. A 'File Name' box is provided so that you may assign a file name to the data file.

If you print to a file, the Windows Notepad program window is automatically opened with your designated file. You may edit your output file in Notepad by using the mouse pointer to position the cursor to insert text by typing from the keyboard or to delete text by using the backspace key. When you are done editing the file, you may save it, then print it by selecting the Save and Print commands from the Notepad File Pull-down Menu from the Menu Bar. Specific procedures for using Notepad are contained in the Windows Desktop Applications User Guide. You must close the Notepad window to return to CASM. Use Close on the System Menu or Exit on the Notepad File Menu.

*Select the PRINT DATA command from the FILE Menu.*

A dialog window appears with several options. You may print out Basic Design Criteria, Loads, or both.

You may print to the printer or to a file which you may review and edit before printing. A 'File Name' box is provided so that you can assign a file name to the data file.
To select a print option:
1. Move the mouse pointer to the empty box to the left of the desired option.
2. Press the left mouse key once and release to select the desired option.
   An 'X' will appear in the box.

To deselect an item:
1. Move the mouse pointer to a box with an 'X' in it.
2. Press the left mouse key once.
   The 'X' will disappear.

To print to a file:
1. Move the mouse pointer to the box to the left of the heading 'Print to file.'
2. Press the left mouse key and release.
   An 'X' will appear in the box. Deselect the 'X' in the 'Print to printer' box.

   You may use the current file name for output or type in a new file name.
3. Move the mouse pointer to the 'File Name' box.
4. Press the left mouse key and drag the pointer across the current name in the box. Release the key when a dark bar highlights the current file name.

   OR

   Move the mouse pointer to the location in the current name where you want to delete characters with the backspace key and type in new characters. Press the left mouse key and a vertical cursor will appear.
5. Type in the new file name (8 characters or less, does not include the extension). The extension .TXT will automatically be added to the new file name.

To start printing the data file to a file:
1. Move the mouse pointer to the 'OK' box.
2. Press the left mouse key once to initiate the command to print the data to a file.
The CASM program will check for another file with the same name. If the program finds another file with the same name, a dialog window appears to confirm if you desire to replace (add changes to) the existing file which has the same name.

The Windows Notepad program window is automatically opened with your designated file. You may edit the file in Notepad by using the mouse pointer to position the cursor to insert text by typing from the keyboard or to delete text by using the backspace key. When you are done editing the file, you may save it, then print it by selecting the SAVE and PRINT commands from the File Pull-down Menu from the Notepad Menu Bar. Specific procedures for using Notepad are contained in the Microsoft Windows User Guide.

To return to the CASM program:

1. Move the mouse pointer to the System Box in the top left-hand corner of the Notepad window.
2. Double click the left mouse key.

-OR:
   a. Press the left mouse key.
   b. Move the mouse pointer down to the Close command in the System Pull-down Menu.
   c. Press the left mouse key (or type the [C] key) to activate the command.

The Notepad program window will disappear and is replaced by the CASM program window.

To print to a printer:

1. Move the mouse pointer to the box to the left of the heading 'Print to printer.'
2. Press the left mouse key and release.

An 'X' will appear in the box. Deselect the 'X' in the 'Print to file' box.
To start printing the data file to the printer:

1. Move the mouse pointer to the 'OK' box to start the printing.
2. Press the left mouse key once to initiate the command.

The Windows Spooler Icon will appear in the Icon area (Dual-Monitor System only). You may open the Spooler program window if you want to verify the active printing device and the port where it is connected. You may also use the Spooler program window to pause or resume printing or to terminate the print out.

PRINT SCREEN

The Print Screen command saves view of model currently on the screen to a graphic file. The graphic file may be written in several formats which can be accessed, modified, and printed by AutoCAD or IN*A*VISION. A dialog window prompts you for the desired file format. If the view is copied to an IN*A*VISION file, it can be modified and then transferred to the WINDOWS CLIPBOARD, where it can be added to Windows Write or another Windows program which can Paste graphics.

Select the PRINT SCREEN command from the FILE Menu.

A dialog window appears with several options. You may save (print) the screen to a disk in the IN*A*VISION .PIC file format or the AutoCAD .DXF file format. A 'File Name' box is provided so that you can assign a file name to the screen file.

To select a print option:

1. Move the mouse pointer to the empty circle to the left of the desired option.
2. Press the left mouse key once and release to select the desired option.
   A 'black dot' will appear in the circle. Only one can be selected.

   You may use the current file name for output or type in a new file name.

3. Move the mouse pointer to the 'File:' box.
4. Press the left mouse key and drag the pointer across the current name in the box. Release the key when a dark bar highlights the current file name.

OR
Move the mouse pointer to the location in the current name where you want to delete characters with the backspace key and type in new characters. Press the left mouse key and a vertical cursor will appear.

5. Type in the new file name (8 characters or less, does not include the extension). The extension .PIC or .DXF will automatically be added to the new file name.

To start saving the screen display to a file:
1. Move the mouse pointer to the "OK" box to save the data to a file.
2. Press the left mouse key once to initiate the command.

The current view of the model displayed on the screen will be saved to the designated file.

The CASM program will check for another file with the same name. If the program finds another file with the same name, a dialog window appears to confirm if you desire to replace (add changes to) the existing file which has the same name.

The IN*A*VISION program window is automatically opened with your designated file. You may edit the file in IN*A*VISION by using the mouse pointer and the graphics commands in the Draw and Edit pull-down menus. When you are done editing the file, you may save it, then print it by selecting the Save Dwg and Print commands from the File Pull-down Menu from the IN*A*VISION Menu Bar. Specific procedures for using IN*A*VISION are contained in the IN*A*VISION User Guide.

To return to the CASM program:
1. Move the mouse pointer to the System Box in the top left-hand corner of the IN*A*VISION window.
2. Double click the left mouse key.

-OR-

a. Press the left mouse key.

b. Move the mouse pointer down to the Close command in the System Pull-down Menu.

c. Press the left mouse key (or type the [C] key) to activate the command.

The IN"A"VISION program window will disappear and is replaced by the CASM program window.

**IMPORT**

The Import command will permit you to load an AutoCAD 2-D or 3-D graphic reference file or a Design 4-D graphic reference file. (Design 4-D is an architectural modeling program developed by the Construction Engineering Research Laboratory.) You may use the reference file to aid in developing the building geometry or structural framing layout based on the architect's initial concept.

**Select the IMPORT command from the FILE Menu.**

An Import dialog window appears with several options. You may select a .DXF graphics file or a Design 4-D graphics file to use as a reference.

A 'File Name' box is provided so that you may designate a file name to Import.

To select a file to Import:

1. Move the mouse pointer to the empty circle to the left of the desired option.

2. Press the left mouse key once and release to select the desired option.

   A 'black dot' will appear in the circle. Only one item can be selected.

   You may use the current file name for output or type in a new file name.

3. Move the mouse pointer to the 'File Name:' box.

4. Press the left mouse key and drag the pointer across the current name in the box. Release the key when a dark bar highlights the current file name.
Move the mouse pointer to the location in the current name where you want to delete characters with the backspace key and type in new characters. Press the left mouse key and a vertical cursor will appear.

5. Type in the new file name (8 characters or less, does not include the extension). The extension will automatically be added to the file name.

To import the reference graphics file to your project file:
1. Move the mouse pointer to the 'Import' box.
2. Press the left mouse key once to initiate the command.

The designated reference graphics file will be drawn on the Ground Plane. Use the Reference Menu (Not Implemented) in the Draw Model Tool Palette to control the reference file.

The Export command will permit you to create an AutoCAD .DXF graphics file that you can load into a CADD program such as AutoCAD and create structural drawings such as framing plans or building sections. The Export command generates a 3-D .DXF file while the Print Screen command generates a 2-D projection of the current view on the screen.

Select the Export command from the File Menu.

A dialog window appears with a block for the Export file name. You may use the current file name for output or type in a new file name.

1. Move the mouse pointer to the 'Export Filename:' box.
2. Press the left mouse key and drag the pointer across the current name in the box. Release the key when a dark bar highlights the current file name.

OR

Move the mouse pointer to the location in the current name where you want to delete characters with the backspace key and type in new characters. Press the left mouse key and a vertical cursor will appear.

3. Type in the new file name (8 characters or less, does not include the extension). The extension .DXF will automatically be added to the new file name.

To start saving the structural model geometry to a .DXF file:
1. Move the mouse pointer to the 'EXPORT' box to save the model geometry to a file.
2. **Press the left mouse key once to initiate the command.**

   The geometry of the structural model will be saved to the designated file. Structural framing plans and sections can be generated from the Exported files once they have been loaded into a CADD program.

---

**EXIT**

The Exit command will permit you to close the file. A prompt will appear to remind you to SAVE the file if you have made changes to it.

Select the EXIT command from the FILE Menu.

A dialog window appears to confirm if you want to save the changes to the project file. It allows you to save changes to the file if you have forgotten to do so.

**If changes have been made to the current project file:**

A dialog box prompts you to save changes to the current project file.

---

1. Move the mouse pointer to the YES or NO box.
2. Press the left mouse key to indicate your selection.
   a. If you select YES to save the project file and the file is named, the hourglass symbol will be displayed while the file is saved to disk.
   b. If you select YES to save the project file and the file is (untitled), you will be prompted for a project file name.
   c. If you select NO to not save changes to the project file, the current project file will be stopped without adding the changes.

**To save changes if the file is (untitled):**

A pop-up dialog window appears which displays the current directory, a box for the file name, and options to SAVE the file or CANCEL the save command.

1. Type in an appropriate file name with 8 characters or less. The extension .BLD will be automatically added. Do not use another extension.
2. Move the mouse pointer to the SAVE box.
3. Press the left mouse key once and release.

The project file will be saved, the CASM program will stop, and you will be returned to the Windows MS-DOS Executive program.
If you select SAVE to save the project file and a project file of the same name exists, you will be prompted if you want to replace (add changes to) the existing project file.

## ABOUT CASM

The About CASM command displays information about the application running in the active window. For example, the About CASM command on the MS-DOS Executive System Menu displays the amount of RAM currently available to the system and the current CASM software version in use.

Select the ABOUT CASM command from the FILE Menu.

A pop-up dialog window appears to which displays the program name, current program version, and memory configuration.

---

**CASM**

Computer Aided Structural Modeling

- **Version 1.00**
- **December 1989**

**Graphics Library** : Version 1.00
**Analysis Library** : Version 1.00
**Conventional Memory** : 225K
**Expanded Memory** : H/I
**Graphics Memory** : 225K

To return to the current program window:
1. Move the mouse pointer to the 'OK' box in the middle of the pop-up window.
2. Press the left mouse key once and release.

The pop-up dialog window will disappear.
The Criteria Menu is used to produce a data file of project-specific data and meteorological data which influence the design live loads on the structural model. Four dialog windows which contain project-related data will appear. Data entered via the Criteria pull-down menu will be added to a project criteria file that may be printed by the Print Data command on the CASM Files pull-down menu.

Data for specific Cities/Installations may be stored and recalled by using the Wind Rosette Windows Cardfile program. Thus several criteria data boxes may be automatically filled in by entering the desired City/Installation.

Data entered via the Criteria pull-down menu are used for the Loads Menu. When applying wind or snow loads to the model, the initial values and building code parameters are taken from the Criteria lists.

To select a criteria dialog window from the CRITERIA pull-down Menu with the mouse:
1. Move the mouse pointer to the Criteria heading on the system menu bar of the CASM Application Window.
2. Press the left mouse key.
   The Criteria Pull-Down Menu will appear.
3. Move the mouse pointer down the command list to the selection you want.
4. Press the left mouse key to carry out the command.
   A Criteria dialog window will appear.

To select a command from the CRITERIA Menu with the keyboard:
1. Press the [Alt] key and the [C] key together.
   The Criteria Pull-Down Menu will appear.
2. Type the first letter of the command to carry out the command.
   -OR-
   Use the up or down arrows on the keyboard to move the selection bar up or down. Press the [Enter] key to carry out the command.
   A Basic Design Criteria Dialog window will appear to permit the entry of data or the selection of preset data from a variety of data windows.

To enter or change selections or data in the criteria dialog windows:
1. Move the mouse pointer to the appropriate box.
2. Press the left mouse key once and release.
   For data boxes that contain preset data from a data list, a dialog window will appear with a list of choices.
For data boxes that do not contain preset data, a dialog window will not appear. A vertical cursor line will be flashing in the data box. You may type the appropriate data into the box. Use the [Backspace] key to edit the input.

You may use the Windows Cardfile to develop a database of code and meteorological data for a variety of City/Installations. The City/Installation will be displayed in a list when you select the City/Installation box on the Project Data Criteria. Choosing the appropriate City/Installation from the list will automatically fill in several boxes on the three Criteria dialog windows. If the desired City/Installation is not on the list, the Criteria Data must be entered item by item. Specific procedures for using Cardfile are contained in the Microsoft Windows User’s Guide.

Datablocks on Cardfile cards:

- Country
- State
- County
- Design Load
- Elevation
- Ave Rain
- Max Rain
- Ground Snow Load
- Max Snow Depth
- Basic Wind Speed
- Max Wind Spd
- Wind Dirctn
- Coastal
- Max Temp
- Min Temp
- Frost Depth
You may create new data cards by:

1. While in the MS-DOS Executive program window, find the CITIES.CRD file.
2. Move the mouse pointer to the file name and double-click the left mouse key.
   The Cardfile program window will appear with the current listing of cities displayed on notecards.
3. You may use the mouse pointer to position the cursor or the backspace key, or hold the mouse key down and drag the pointer across the characters to replace characters, and touch the keyboard to input new characters.
4. You may use the Duplicate Command in the Card pull-down menu to create more cards. Then you can replace the data in the duplicated cards as necessary to create new data cards.

Use the following sequence to input or select data for the Design Criteria lists.

A Basic Design Criteria: Project Data dialog window appears. Use the following sequence to enter or change Project Data selections, entries, or values.
To enter or change the Project Name:
If the value is already highlighted, type in the appropriate entry. If the value is not highlighted:
1. Move the mouse pointer to the 'Project Name' box.
2. Press and hold the left mouse key and drag the pointer over the current entry. Release the mouse key when the current entry is highlighted.
3. Type in a new value. Use the backspace key to make corrections.
The project name will be used as a heading for the printed data such as Project Criteria and Loads.

To select the City/Installation from a list of Cities/Installations prepared by the CARDFILE program:
1. Move the mouse pointer to the 'City/Installation' box.
2. Press the left mouse key and release.
A dialog window will appear which contains a Cardfile listing of Cities/Installations.

<table>
<thead>
<tr>
<th>City/Installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ft. Huachuca</td>
</tr>
<tr>
<td>Ft. Stewart (Savannah)</td>
</tr>
<tr>
<td>Ft. Wainwright</td>
</tr>
<tr>
<td>Sacramento</td>
</tr>
<tr>
<td>Tulsa</td>
</tr>
<tr>
<td>Wes Jackson</td>
</tr>
<tr>
<td>Westover AFB</td>
</tr>
</tbody>
</table>

3. Move the mouse pointer to the desired selection.
Use the up or down arrows or the white rectangle on the vertical bar between the arrows to see more selections on the list. Place the mouse pointer on the white rectangle, then press and hold the left mouse key as you move the mouse toward and away from you to view more selections.
4. Double click the left mouse key.

OR
a. Press the left mouse key once and release to select a City/Installation.
The selection will be highlighted by a dark bar.
b. Move the mouse pointer to the 'OK' box at the bottom of the dialog window in order to transfer the selection to the Project Data dialog window.
c. Press the left mouse key and release.
The selection will appear in the 'City/Installation' box. Also, the following data selections and entries will be automatically inserted in the Criteria windows.
## Project Data:
- Country
- State
- County
- Elevation

## Regional Data:
- Wind Data
- Snow Data
- Rain Data
- Temperature Data
- Frost Depth

Verify the database entries. Complete the remaining entries in the Criteria Windows.

**To enter or change the City/Installation entry if it is NOT listed in the CARDFILE database:**

1. Move the mouse pointer to the 'City/Installation' box.
2. Press the left mouse key.
   
   A dialog window will appear which contains a database listing of Cities/Installations.
3. Move the mouse pointer to the CANCEL box at the base of the dialog window.
4. Press the left mouse key.
   
   The City/Installation dialog window will disappear. The City/Installation box on the Project Data dialog window will have a flashing vertical cursor at the end of the current entry.
5. Type in the appropriate City/Installation. Use the backspace key or drag the mouse pointer to modify or correct entries.

**The procedures listed below apply to the following data boxes.**

<table>
<thead>
<tr>
<th>Country</th>
<th>No. of Stories</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Floor Area</td>
</tr>
<tr>
<td>County</td>
<td>Occupancy</td>
</tr>
<tr>
<td>Elevation</td>
<td>Type Construction</td>
</tr>
</tbody>
</table>

**To enter or change entries:**

1. Move the mouse pointer to the appropriate data box.
2. Press and hold down the left mouse key and drag the pointer over the current entry. Release the mouse key when the entry is highlighted.
3. Type in the appropriate data. Use the backspace key to modify or correct entries.

**The procedures listed below apply to the following data boxes.**

| Design Load |
| Building Code |
| Seismic Code |

The Design Load data box permits you to select the design load criteria which controls the design load values and calculations.
To enter or change entries:

1. Move the mouse pointer to the appropriate data box.
2. Press the left mouse key and release.
   A dialog window which contains a list of selections will appear on the screen.
3. Move the mouse pointer to the desired selection.
   Use the up or down arrows or the white rectangle on the vertical bar between
   the arrows to see more selections on the list.
4. Double click the left mouse key.

OR

a. Press the left mouse key once and release to make a selection.
   The selection will be highlighted by a dark bar.

b. Move the mouse pointer to the 'OK' box at the bottom of the dialog
   window in order to transfer the selection to the Project Data dialog
   window.

c. Press the left mouse key and release.
   The selection will appear in the appropriate data box.

To verify the entries in the Project Data dialog window and add them to the Project
data file:

1. Move the mouse pointer to the 'OK' box at the bottom of the 'Project Data'
   dialog window.
2. Press the left mouse key once and release.
   All entries in the dialog window will be added to the Project File. The Project
   Data Criteria dialog window will disappear.

REGIONAL ...

The Regional selection displays a regional information data form including
meteorological influences on the structural model. Regional information is used
for applied loads and design influences on the structural model. Data may be
preselected by the Project information or overwritten by direct input.

Select the Regional command from the Criteria Menu.

A Basic Design Criteria: Regional Data dialog window appears. Use the
following sequence to enter or change Regional Data selections, entries, or
values.

If a Windows Cardfile database is used to store City/Installation data,
all of the values on the Regional Data dialog window will be automatic-
ically inserted from the Cardfile database.
The procedures listed below apply to the following data boxes:

Wind: Basic Wind Speed, Max Wind Speed, Direction, Snow: Ground Snow Load, Maximum Depth, Snow Density
Rain: Annual Average, Max Storm, Temperature, Min, Frost Depth, Seismic Zone

The Basic Wind Speed value and Ground Snow Load values are used for Wind Load and Snow Load calculations.

To change or enter values:
1. Move the mouse pointer to the appropriate data box.
2. Press and hold down the left mouse key and drag the pointer over the current value. Release the mouse key when the value is highlighted.
3. Type the appropriate value in the data box. Use the backspace key to modify or correct entries.

The Snow Density value is automatically calculated based on the Ground Snow Load value. To display the calculated value, move the mouse pointer to the Snow Density box, press the left mouse key and release. The calculated value will appear with the vertical cursor flashing at the end of the value. Use the back-space key and keyboard to enter new values if necessary.

To select/de-select the Coastal hurricane coefficient:
1. Move the mouse pointer to the Coastal data box.
2. Press the left mouse key once and release.
To select the Coastal condition (within 100 miles of a hurricane coastline), press the mouse key until there is an 'X' in the box.

**To verify the entries in the Regional Data dialog window and add them to the Project data file:**

1. Move the mouse pointer to the 'OK' box at the bottom of the 'Regional Data' dialog window.
2. Press the left mouse key once and release.

All entries in the dialog window will be added to the Project File. The Regional Data Criteria dialog window will disappear.

**SITE...**

The Site selection displays a site-specific information data form including data which directly affect the meteorological influences on the structural model and data on the soil at the site. Site-specific information is used for equation factors for applied loads and for influence on foundation design.

**Select the SITE command from the CRITERIA Menu.**

A Basic Design Criteria: Site Specific Data dialog window appears. Use the following sequence to enter or change Site Specific Data selections, entries, or values.

<table>
<thead>
<tr>
<th>Wind</th>
<th>Snow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Importance: I</td>
<td>Importance: I</td>
</tr>
<tr>
<td>Exposure</td>
<td>Exposure</td>
</tr>
<tr>
<td>Distance to oceanline</td>
<td>Roof Slippery</td>
</tr>
<tr>
<td>Roof Heated</td>
<td></td>
</tr>
</tbody>
</table>

**Soil Name:** Boring 1

- Allow. Bearing Pressure: 2000 psf
- Equiv. Fluid Pressure: 40 pcf
- Water Table: 4 ft
- Slope: 0.1

---

**The procedures listed below apply to the following data boxes:**

Wind: Importance | Snow: Importance

Exposure

The Exposure and Importance factors are used for Wind Load and Snow Load calculations.
To change or enter Importance or Exposure factors:
1. Move the mouse pointer to the appropriate input box.
2. Press the left mouse key once and release.
   A dialog window will appear with code values and descriptions.
3. Move the mouse pointer to the circle in front of the desired selection.
4. Press the left mouse key once and release.
   A solid dot will appear in the circle to indicate your selection.

To transfer the selection to the Site Specific Data dialog window:
1. Move the mouse pointer to the 'OK' box at the bottom of the window.
2. Press the left mouse key once to transfer the selection.
   The selected value will appear in the Site Specific Data dialog window.

To change or enter the Distance to Oceanline value:
1. Move the mouse pointer to the 'Distance to Oceanline' box.
2. Press and hold down the left mouse key and drag the pointer over the current value. Release the mouse key when the current value is highlighted.
3. Type in the appropriate value.
   Appropriate values range from 0 to 100 miles from a hurricane coastline.

To change the 'Roof Slippery' or 'Roof Heated' boxes:
1. Move the mouse pointer to the appropriate input box.
2. Press the left mouse key once and release.
   To select the condition noted, press the mouse key until there is an 'X' in the box. An empty box indicates the condition is not selected (i.e. no 'X' in the Roof Heated box means the roof is NOT heated).

To enter soil data:
1. Move the mouse pointer to the 'Soil Name' box.
2. Press and hold down the left mouse key and drag the pointer over the current entry. Release the mouse key when the current entry is highlighted.
3. Type in an appropriate soil information heading.

To enter values for the Soil Bearing Pressure, Equivalent Fluid Pressure, Water Table depth, Slope, and the three blank data blocks:
1. Move the mouse pointer to the appropriate data box.
2. Press and hold down the left mouse key and drag the pointer over the current value. Release the mouse key when the current value is highlighted.
3. Type in the appropriate values.

Once the Soil Information List is complete, several options are available:
SAVE
Permits you to SAVE the soil information type in the project list under the name you gave to it (i.e., Boring 1). Move the mouse pointer to the SAVE box, and press the left mouse key. After saving the information, you may modify the values, enter a new soil information name, and save it as another type. The CASM program checks for another soil information type of the same name and, if one exists, will provide you with a warning dialog window.

NEXT
Permits you to select different soil types from the list of types that was created. You may use NEXT to review the soil types and modify the entries. Move the mouse pointer to the NEXT box, and press the left mouse key.

To verify the entries in the Site Specific Data dialog window and add them to the Project data file:
1. Move the mouse pointer to the 'OK' box at the bottom of the 'Site Specific Data' dialog window.
2. Press the left mouse key once and release.
   All entries in the dialog window will be added to the Project File. The Site Specific Data Criteria dialog window will disappear.

WIND ROSETTE (NOT IMPLEMENTED)
Aids the user in developing a chart depicting seasonal wind speed and directions. The wind rosette is used to influence building design.
The Draw Model Tool Palette is used to develop the building structural geometry. The building geometry is created by stacking electronic building blocks on the screen. These blocks can be quickly stretched, squeezed, and arranged in order to create the desired building geometry. The Draw Model Window consists of a tool palette icon area and pull-down menus which have the same function as the tool icons. The menus or icons on the Draw Model Tool Palette permit you to select the desired building block with the Shapes Menu, edit the shapes by stretching or squeezing with the Edit Menu, control the initial model size and positioning with the Layout Menu, and select an initial reference outline from the Architectural CADD drawing with the Reference Menu.

You will need to be in the Perspective (3-D) option on the Viewpoint Tool Palette in order to use the Shapes and Edit menus in the Draw Model Tool Palette.

The Draw Model Tool Palette Window is shown below:

The Draw Model Tool Palette will appear as shown above on the primary monitor of the Dual-Monitor System. On the Single-Monitor System only the Title Bar and the Pull-Down Menu headings of the Tool Palette will appear at the bottom of the screen. Instead of the menus “pulling down” from the menu bar, they will “push up” on the Single-Monitor System.

To select a command from the Draw Model Menu with the mouse:

1. Move the mouse pointer to the Draw Model heading on the system menu bar of the CASM Application Window.
2. Press the left mouse key.
   The Draw Model Tool Palette will appear. On the Single-Monitor System only the Draw Model title bar and pull-down menu bar will be visible.

For the Dual-Monitor System:

1. Move the mouse pointer to the desired tool icon in the Draw Model Tool Palette.
2. Press the left mouse key.
   The tool icon will be highlighted and a dialog window may appear.
**For the Single-Monitor System and Dual-Monitor System:**

1. Move the mouse pointer to the desired pull-down menu option on the Draw Model Window.
2. Press the left mouse key.
   The selected pull-down menu will appear.
3. Move the mouse pointer to the desired menu option (you may also activate the command by typing the underlined letter in the desired command).
4. Press the left mouse key to activate the command.
   A dialog window will appear. Refer to the Draw Model command sequences listed on the following pages.

**To select a command from the Draw Model Window with the keyboard:**

   The Draw Model Tool Palette will appear. On the Single-Monitor System only the Draw Model title bar and pull-down menu bar will be visible.
2. Hold down the [Alt] key and press the underlined key of the desired pull-down menu.
   The pull-down menu will be displayed on the screen.
3. Type the underlined letter of the desired command to activate the command.
   -OR-
   Use the up or down arrows on the keyboard to move the selection bar up or down to the desired selection; then press the [Enter] key.

*The Draw Model Menu command selections are listed on the following pages.*
SHAPES MENU

Use the Shape pull down menu commands to select a 3-D shape which is used as a building block for the structural design. The graphic Shape Tool Icons on the screen may also be used. Initial size and orientation of the shape (length, width, height, radius, and slope) are determined by the Initial Object Size command on the Layout menu. Also, the initial size of the shape will conform to the size of the previous shape or designated plane when the Stack On Last Shape or Stack On Plane commands are selected on the Layout menu.

You must be in the Perspective (3-D) option in order to stack 3-D shapes.

NOTE: Before you begin placing shapes there are several items which you should know that will aid in the proper placement of the shape. These items will also be discussed in the menu command sequences described below.

Once the shape appears on the screen, movement of the mouse pointer on the modeling screen corresponds to the mouse movements listed below:

- Moving the mouse right/left corresponds to E-W on the screen.
- Moving the mouse toward/away from you corresponds to N-S on the screen.
- Pressing the right mouse key and moving the mouse toward/away from you will move the shape up/down.
- Pressing the left mouse key will accept the shape location. A new shape will appear or handles will appear if you are stacking shapes on planes.
- Double click the right mouse key to exit the add shape mode.

The LAYOUT command selections control the initial placement of your selected shape. At any time you may modify the Layout selections to aid your initial selection and placement of the shape.

LAYOUT Selection - DRAW SHAPE command response

Define Ground Plane - Permits you to define the ground plane size and spacing for an initial placement reference.

Define Units - Permits you to select dimension increments for placing the object.

Snap to Units - Permits you to activate the unit snap for the selected increment.

Initial Object Size - Permits you to select the initial object dimensions and orientation. (You may also use the Edit commands if you have already placed the shape on the screen.)

Stack on Ground - The selected shape is initially displayed on the center of the ground grid.

Stack on Last Shape - The selected shape automatically appears on top of the previous stackable shape and assumes the same width and length of the previous shape. Shapes like Prisms are not considered stackable.
Stack on Plane - Colored dots or "handles" appear on all the "visible" planes of previous shapes. Select a "handle" with the mouse pointer and press the left mouse key to stack the new shape. Only stackable planes will have handles.

Stack Underground - The selected shape is initially displayed on the center of the ground grid below the ground grid.

For the Dual-Monitor System:
1. Move the mouse pointer to the desired shape icon in the Draw Model Tools Palette.
2. Press the left mouse key.

The shape icon will be highlighted (white on black) and the shape will appear on the Modeling Screen. The mouse pointer will change to the Matrox modeling screen.

For the Single-Monitor System and the Dual-Monitor System:
1. Move the mouse pointer to the Shapes Pull-Down Menu title. (You may also select [Alt] + [S] from the keyboard to display the Shapes Pull-Down Menu.)
2. Type the underlined letter of the desired shape from the menu. (You may also move the mouse pointer down the list to the desired shape and press the left mouse key.)

The shape will appear on the Modeling Screen. (For the Dual-Monitor System the mouse pointer will change to the Matrox modeling screen.)

A dialog box appears which shows you the shape dimensions. The lower portion of the dialog box indicates the translated dimensions of the shape from its initial position. You may refer to the translated dimensions to aid you in positioning the plane in the STACK ON GROUND and STACK UNDERGROUND options on the Layout Menu.

The selected shape will be "stacked" on the modeling screen, based on the STACK selection in the Layout Menu.
If the STACK ON PLANE option has been selected on the Layout Menu, colored dots or "handles" will appear on all the visible planes. Move the mouse pointer to the desired plane the new shape is to be stacked on (you may need to get out of the Shapes command in order to rotate the model if the handle for the desired plane is not accessible). Press the left mouse key to select the plane and the new shape will appear with the same dimensions as the plane.

If the shape location default is STACK ON GROUND or STACK UNDERGROUND the shape may be moved horizontally and/or vertically with the mouse to its final position.

- Moving the mouse right/left corresponds to E-W on the screen.
- Moving the mouse toward/away from you corresponds to N-S on the screen.
- Pressing the right mouse key and moving the mouse toward/away from you will move the shape up/down.

If you do not like the shape location or size, you may double click the right mouse key to cancel the add shape mode.

3. Press the left mouse once to accept the shape location and size.

The program will remain in the add shape mode and a new shape will appear on the screen or handles will appear on all visible planes if the Stack on Plane option is selected.

4. Double click the right mouse key to exit the add shape mode.

You may modify the shape dimensions later by using the commands from the Edit Menu.
**EDIT MENU**

Use the Edit pull down menu commands to change a shape which is used as a building block for the structural design. The graphic Edit Tool Icons on the screen may also be used. Except for Undo, all of the Edit Menu commands require that you first select an item to edit. Use the mouse pointer to select an object.

- The Edit Menu commands work only in the Perspective Wireframe or Solid display of the model.
- You will find the Lock N-S, Lock E-W, and Lock Vertical commands on the Layout Menu useful when you Drag Edge or Drag Vertex.
- NOTE: Before you begin editing shapes there are several items which you should know that will aid in the proper editing of the shape. These items will also be discussed in the menu command sequences described on the following pages.

Once the shape appears on the screen, movement of the mouse pointer on the modeling screen corresponds to the mouse movements listed below:

- Clicking the left mouse key once on a yellow dot "handle" which represents a shape or shape part selects the shape or part and permits you to move or modify the shape or part.
- Moving the mouse right/left corresponds to E-W on the screen.
- Moving the mouse toward/away from you corresponds to N-S on the screen.
- Pressing the right mouse key and moving the mouse toward/away from you will move the object up/down.
- Pressing the left mouse key will accept the edit changes. Handles will reappear for further editing operations.
- Double click the right mouse key to exit the editing mode.

The colored dots or "handles" will be located on "visible" parts or front sides and top of the structural model. There will not be any handles on the "nonvisible" or back side of the structural model. You may need to rotate the model in order to access objects that you desire to modify. The handles are located as follows:

<table>
<thead>
<tr>
<th>Object</th>
<th>Handle Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shape</td>
<td>Center of visible planes</td>
</tr>
<tr>
<td>Plane</td>
<td>Center of visible planes</td>
</tr>
<tr>
<td>Edge</td>
<td>Midpoint of edge on visible planes</td>
</tr>
</tbody>
</table>

The Layout command selections control the editing of your selected shape. At any time you may modify the Layout selections to aid you in the editing of the shape.

**Layout Selection - Influence on editing sequence**

- Define Units - Permits you to select dimension increments for editing the objects.
- Snap to Units - Permits you to activate the unit snap for the selected increment.
Lock N-S - Permits you to prevent the editing changes or object movement in the N-S direction.

Lock E-W - Permits you to prevent the editing changes or object movement in the E-W direction.

Lock VERT - Permits you to prevent the editing changes or object movement in the VERT direction.

To select a command from the Edit Menu:

For the Dual-Monitor System:
1. Move the mouse pointer to the desired edit icon in the Draw Model Tools Palette.
2. Press the left mouse key.

   The edit icon will be highlighted and a dialog window may appear or handles will appear on objects on the Modeling Screen. The mouse pointer will change to the Matrox modeling screen.

For the Single-Monitor System and the Dual-Monitor System:
1. Move the mouse pointer to the Edit Pull-Down Menu title. (You may also select [Alt] + [E] from the keyboard to display the Edit Pull-Down Menu.)
2. Type the underlined letter of the desired edit command from the menu. (You may also move the mouse pointer down the list to the desired edit command and press the left mouse key.)

   A dialog window may appear or handles will appear on objects on the Modeling Screen. (For the Dual-Monitor System the mouse pointer will change to the Matrox modeling screen.)

The Edit Menu commands are listed on the following pages:
UNDO (NOT IMPLEMENTED)

The Undo command cancels the last modeling action or last editing action performed on a selected shape. Choosing Undo a second time restores these actions.

DRAG VERTEX

A designated prism vertex at the ridge may be moved. All edges connected to the vertex are realigned dynamically to the new vertex location.

- Use the Lock options in combination with this command to control the movement of the vertex.
- The Drag Vertex command works only in the Perspective Wireframe or Solid display of the model.

Select the Drag Vertex command from the Edit menu or tool icon.

2. Press the left mouse key.

The vertex selected will be highlighted. A Dimension Dialog Window will appear which displays dynamic dimensions, roof slopes, and translated distances. Movement of the vertex will match the mouse movements, and the values in the dialog window will change to aid you in positioning the vertex:

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>Roof Slopes</th>
</tr>
</thead>
<tbody>
<tr>
<td>N-S : 20.00 ft</td>
<td>North: 0.00 in 12</td>
</tr>
<tr>
<td>E-W : 75.00 ft</td>
<td>South: 0.00 in 12</td>
</tr>
<tr>
<td>Vert.: 18.00 ft</td>
<td>East: 0.00 in 12</td>
</tr>
<tr>
<td>Ridge: 75.00 ft</td>
<td>West: 0.00 in 12</td>
</tr>
</tbody>
</table>

- Moving the mouse right/left corresponds to E-W on the screen.
- Moving the mouse toward/away from you corresponds to N-S on the screen.
- Pressing the right mouse key and moving the mouse toward/away from you will move the vertex up/down.
3. Press the left mouse key to save the vertex change. You will remain in the Drag Vertex edit mode.

4. **Double click** the right mouse key to exit the Drag Vertex edit mode.

**DRAG EDGE**

An object edge for a shape may be selected and moved. All planes and vertices connected to the edge are realigned dynamically to the new edge location.

- Use the Lock options in combination with this command to control the movement of the edge.
- The Drag Edge command works only in the Perspective Wireframe or Solid display of the model.

Select the Drag Edge command from the Edit menu or tool icon.

All edges on visible planes will be highlighted at their midpoint by a colored dot ("handle"). The mouse pointer changes to a +. (For the Dual-Monitor System the mouse pointer changes to the Matrox modeling screen.)

1. Move the mouse pointer to the handle on the desired edge to be modified.

- You may exit the editing mode at any time without saving changes by double clicking the right mouse key.

2. Press the left mouse key. The edge will be highlighted. A Dimension Dialog Window will appear which displays dynamic dimensions, roof slopes, and translated distances. Movement of the edge will match the mouse movements, and the values in the dialog window will change to aid you in positioning the edge:

- Moving the mouse right/left corresponds to E-W on the screen.
- Moving the mouse toward/away from you corresponds to N-S on the screen.
- Pressing the right mouse key and moving the mouse toward/away from you will move the edge up/down.

3. Press the left mouse key to save the edge change. The handles on the edges will reappear. You will remain in the Drag Edge edit mode.
4. **Double click the right** mouse key to exit the Drag Edge edit mode.

## DRAG PLANE

An object plane for a shape may be selected and moved toward or away from its centroid. All planes, edges, and vertices connected to the plane are realigned dynamically to the new plane location.

The Drag Plane command works only in the Perspective Wireframe or Solid display of the model.

Selecting Drag Plane for the following objects will produce the results indicated:

<table>
<thead>
<tr>
<th>Shape</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cubes, columns and planes:</td>
<td>Move shape N-S, E-W, and/or up-down.</td>
</tr>
<tr>
<td>Cylinder, vault and prism:</td>
<td>Move end planes toward or away from centroid.</td>
</tr>
</tbody>
</table>

Select the Drag Plane command from the Edit menu or tool icon.

All "visible" planes will be highlighted at the center of the plane by a colored dot or handle. The mouse pointer changes to a +. (For the Dual-Monitor System the mouse pointer changes to the Matrox modeling screen.)

1. Move the mouse pointer to the handle on the desired plane to be modified.

2. Press the left mouse key. The plane will be highlighted. A Dimension Dialog Window will appear which displays dynamic dimensions, roof slopes, and translated distances. Movement of the plane will match the mouse movements, and the values in the dialog window will change to aid you in positioning the plane:

   ![Dimensions Table]

   - Moving the mouse toward/away from you will drag the plane on the screen.

3. Press the left mouse key to save the plane change.
The handles on the planes will reappear. You will remain in the Drag Plane edit mode.

4. **Double click the right mouse key to exit the Drag Plane edit mode.**

**DELETE OBJECT**

You may designate a shape for deletion. Deleting a shape removes it from the graphic file.

- **The Delete Object command works only in the Perspective Wireframe or Solid display of the model.**

*Select the Delete Object command from the Edit menu or tool icon.*

All "visible" planes of shapes will be highlighted at their center by a colored dot or handle. The mouse pointer changes to a + . (For the Dual-Monitor System the mouse pointer changes to the Matrox modeling screen.)

1. Move the mouse pointer to the handle on a plane of the shape to be deleted.

- **You may exit the editing mode at any time without deleting a shape by double clicking the right mouse key.**

2. Press the left mouse key.

The designated shape will be deleted. The handles on the shapes will reappear. You will remain in the Delete Object edit mode.

3. **Double click the right mouse key to exit the Delete Object edit mode.**

**MOVE OBJECT**

You may designate a shape to be moved. A dialog window will appear to dynamically display the distance the designated shape is being moved in the N-S, E-W, and vertical directions.

- **Use the Lock options in combination with this command to control the movement of the shape.**

- **The Move Object command works only in the Perspective Wireframe or Solid display of the model.**

*Select the Move Object command from the Edit menu or tool icon.*

All "visible" planes of shapes will be highlighted at the center of the plane by a colored dot or handle. The mouse pointer changes to a + . (For the Dual-Monitor System the mouse pointer changes to the Matrox modeling screen.)

1. Move the mouse pointer to the handle on a plane of the shape to be moved.

- **You may exit the editing mode at any time without saving changes by double clicking the right mouse key.**

2. Press the left mouse key.
The shape will be highlighted. A Dimension Dialog Window will appear which displays dynamic dimensions, roof slopes, and translated distances. Movement of the shape will match the mouse movements, and the values in the dialog window will change to aid you in positioning the shape:

- Moving the mouse right/left corresponds to E-W on the screen.
- Moving the mouse toward/away from you corresponds to N-S on the screen.
- Pressing the right mouse key and moving the mouse toward/away from you will move the shape up/down.

3. Press the left mouse key to save the shape change.

The handles on the shapes will reappear. You will remain in the Move Object edit mode.

4. **Double click the right mouse key to exit the Move Object edit mode.**

---

**ROTATE**

You may use the **Rotate** command to rotate a designated shape about its centroidal axes (north-south, east-west, or vertical) or any designated edge of the shape.

**The Rotate command works only in the Perspective Wireframe or Solid display of the model.**

**Select the Rotate command from the Edit menu tool icon.**

- All "visible" planes of shapes will be highlighted at the center of the plane by a colored dot or handle. The mouse pointer changes to a + . (For the Dual-Monitor System the mouse pointer changes to the Matrox modeling screen.)

1. Move the mouse pointer to the handle on a plane of the shape to be rotated.

**You may exit the editing mode at any time without saving changes by double clicking the right mouse key.**

2. Press the left mouse key.

The shape will be highlighted. Centroidal axes with handles will appear at the centroid of the shape and handles will appear on the midpoints of edges on visible planes.

3. Select the desired axis or edge by moving the mouse pointer to the handles on an edge or at one end of the axis.
4. Press the left mouse key.
A Rotate Dialog Window will appear which displays dynamic rotations and slopes. Movement of the shape will match the mouse movements, and the values in the dialog window will change to aid you in positioning the shape:
   • Moving the mouse right/left corresponds to rotation on the screen.
5. Press the left mouse key to save the shape rotation change.
The handles on the shapes will reappear. You will remain in the Rotate edit mode.
6. Double click the right mouse key to exit the Rotate edit mode.

SLICE OBJECT

You may use the Slice Object command to slice a shape in order to remove a portion of the shape. New wall, roof, or floor planes will be created at the location where the shape was sliced.

The Slice Object command works only in the Perspective Wireframe or Solid display of the model.

You may need to use the Viewpoint Rotate Tool to orient the shape and cutting plane so that all handles are visible.

Select the Slice Object command from the Edit menu or tool icon.

All "visible" planes of shapes will be highlighted at the center of the plane by a colored dot or handle. The mouse pointer changes to a +. (For the Dual-Monitor System the mouse pointer changes to the Matrox modeling screen.)

1. Move the mouse pointer to the handle on a plane of the shape to be sliced.
   You may exit the editing mode at any time without saving changes by double clicking the right mouse key.
2. Press the left mouse key.
The shape will be highlighted.
3. Move the mouse pointer to the handle on the plane that is to slice the shape.
4. Press the left mouse key.
The plane that you selected will be highlighted by a different color and linetype. Then the intersection of the plane and the shape will be highlighted by colored lines. The shape will be split into two separate shapes at the intersection. Solid lines will mark the intersection.
The handles on the shapes will reappear. You will remain in the Slice Object edit mode.
   You may use the Delete Object command on the Edit Menu to delete the unwanted shape.
5. Double click the right mouse key to exit the Slice Object edit mode.
You may duplicate shapes based on the parameters defined in the Duplicate dialog window. Indicate the number of duplicate shapes in the N-S, E-W, and/or vertical direction and the spacing of the duplicate shapes in the N-S, E-W, and/or vertical directions. Positive number entries correspond to N, E, or up. Negative number entries correspond to S, W, or down.

**The Duplicate command works only in the Perspective Wireframe or Solid display of the model.**

Select the Duplicate command from the Edit menu or tool icon.

A Duplicate Dialog Window will appear. The top three selections in the dialog window permit you to specify the number of duplicate shapes to be generated in the N-S, E-W, or Vertical directions. The bottom three selections permit you to specify the spacing of the duplicate shapes in the N-S, E-W, and Vertical directions.

<table>
<thead>
<tr>
<th>Duplicate</th>
</tr>
</thead>
<tbody>
<tr>
<td>N-S Direction : 2</td>
</tr>
<tr>
<td>E-W Direction : 0</td>
</tr>
<tr>
<td>Vertical : 0</td>
</tr>
<tr>
<td>N-S Space : 17.25 ft</td>
</tr>
<tr>
<td>E-W Space : 0.00 ft</td>
</tr>
<tr>
<td>Vertical Space : 0.00 ft</td>
</tr>
</tbody>
</table>

Spacing is the distance between the shapes and not the space between the centroids of the shapes.

For example, if you would like to create a four-story building with floor levels the same as the ground-floor level (14 feet), you would enter "3" in the Vertical block and verify 0.0 in the Vertical Space block.

1. Enter the desired number of duplicate shapes and spacing in the desired direction.
2. Move the mouse pointer to the OK block at the bottom of the window.
3. Press the left mouse key.
   All "visible" planes of shapes will be highlighted at the center of the plane by a colored dot or handle. The mouse pointer changes to a +. (For the Dual-Monitor System the mouse pointer changes to the Matrox modeling screen.)
4. Move the mouse pointer to the handle on a plane of the shape to be duplicated.
1. Press the left mouse key. The shape will be duplicated. The duplicate shapes will appear on the screen. The handles on the shapes will reappear. You will remain in the Duplicate edit mode with the same duplicate options.

6. **Double click the right mouse key to exit the Duplicate edit mode.**

### TAPE MEASURE

The distance between two designated vertices will be measured. The measurement is displayed on the Windows screen in a dialog window.

The Tape Measure command works only in the Perspective Wireframe or Solid display of the model.

**Select the Tape Measure command from the Edit menu or tool icon.**

The mouse pointer changes to a +. (For the Dual-Monitor System the mouse pointer changes to the Matrox modeling screen.)

1. Move the mouse pointer to the first vertex of the shape where the measurement is to begin.

2. Press the left mouse key. The vertex will be highlighted by a colored dot.

3. Next move the mouse pointer to the second vertex of the shape where the measurement is to end.

4. Press the left mouse key. The vertex will be highlighted by a colored dot. A dashed line will be drawn joining the two dots. A Tape Measure Dialog Window will appear which displays distance and the slope between the dots in three dimensions.

<table>
<thead>
<tr>
<th>Distance</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>H-S</td>
<td>20.00 ft</td>
</tr>
<tr>
<td>E-W</td>
<td>0.00 ft</td>
</tr>
<tr>
<td>Vertical</td>
<td>20.00 ft</td>
</tr>
<tr>
<td>True Length</td>
<td>20.20 ft</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Slop</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>H-S</td>
<td>12.00 in 12</td>
<td></td>
</tr>
<tr>
<td>E-W</td>
<td>0.00 in 12</td>
<td></td>
</tr>
<tr>
<td>True</td>
<td>12.00 in 12</td>
<td></td>
</tr>
</tbody>
</table>

The Tape Measure option and window remain active for the selected vertices until you cancel the dialog window. If you perform an editing command which includes...
one of the measured vertices, the measure information will reflect the movement of the vertices.

When you want to stop tape measure.
1. Move the mouse pointer to the Cancel block at the bottom of the window.
2. Press the left mouse key.
   The Tape Measure Dialog Window will disappear. You will need to select Tape Measure again in order to find another distance or slope.
**LAYOUT MENU**

Use the Layout Menu commands to aid in creating a dimensionally correct model. The Layout Menu commands control the initial placement of the selected modeling shapes, the snap increment, the spacing of the ground plane lines, and the movement of selected objects.

To select a command from the Layout Menu:

*For the Dual-Monitor System:*

1. Move the mouse pointer to the desired layout icon in the Draw Model Tools Palette.
2. Press the left mouse key.
   - The selected layout icon will be highlighted and a dialog window may appear.
   - The highlighted icon will be a reminder to the selected Layout option.

*For the Single-Monitor System and the Dual-Monitor System:*

1. Move the mouse pointer to the Layout Pull-Down Menu title. (You may also select [Alt] + [L] from the keyboard to display the Layout Pull-Down Menu.)
2. Type the underlined letter of the desired layout selection from the menu. (You may also move the mouse pointer down the list to the desired layout selection and press the left mouse key.)
   - A dialog window may appear. A checkmark will be placed in front of several selections as a reminder for the selected Layout option.

The Layout Menu commands are listed on the following pages:
SHOW GROUND PLANE

Initially a light grid system is displayed on the modeling screen. The grid system represents the ground plane. A North arrow is included adjacent to the ground plane as a reference. When the ground plane is displayed on the screen, selecting Show Ground Plane will hide the ground plane. You may want to hide the ground plane in order to observe an underground shape. There is no icon for Show Ground Plane on the Draw Model Tool Palette.

Select the Show Ground Plane command from the Layout Menu or tool icon.

The Layout Menu will disappear. The ground plane on the screen will disappear. To display the ground plane select the Show Ground Plane command again. The checkmark indicates that the ground plane is displayed.

DEFINE GROUND PLANE

Permits the selection of the ground plane grid size and spacing. The initial default size is 100 x 100 feet with a 20-foot grid spacing. You may change the grid spacing and size by entering new values in the dialog window. The ground plane can also be rotated for the insertion of model shapes at a specified angle to other shapes. The ground plane size, spacing, and angle will aid in the initial layout of your structural model. You will note a change in color on the screen when a shape border line overlays a grid line.

Select the Define Ground Plane Tool Icon or command from the Layout Menu.

The Define Ground Plane Dialog Window will appear in the Dialog area of the Windows screen. You may change the overall ground plane width, spacing, or angle.

<table>
<thead>
<tr>
<th>Ground Plane</th>
</tr>
</thead>
<tbody>
<tr>
<td>N-S Width</td>
</tr>
<tr>
<td>N-S Spacing</td>
</tr>
<tr>
<td>E-W Width</td>
</tr>
<tr>
<td>E-W Spacing</td>
</tr>
<tr>
<td>North angle 1:</td>
</tr>
<tr>
<td>North angle 2:</td>
</tr>
</tbody>
</table>

1. Move the mouse pointer to the data block(s) to be modified. (You may also use the [Tab] key.)
2. Press the left mouse key.

Ground Plane Rotated 45°
A vertical cursor will appear in the selected data block. (You may also press and hold the left mouse key as you drag the cursor over the existing entry to highlight it in reversed text.)

3. Type in the new entry. Use the [Backspace] and [Delete] keys as necessary.
4. Move the mouse pointer to the OK action box at the bottom of the window. (You may use the CANCEL option if you decide not to change the ground plane.)
5. Press the left mouse key.

The ground plane will be modified and redrawn on the screen.

You may need to adjust your viewing height or distance to view the entire ground plane.

**DEFINE UNITS**

You may select a dimension increment to aid in the placement or editing of shapes, planes, edges, and vertices. When an increment is specified and used, an exact placement of elements can be achieved. You must use the Snap to Units selection to activate the unit snap increment. The initial default unit increment is 12 inches.

Select the *Define Units Tool Icon* or command from the Layout Menu.

The Define Units Dialog Window will appear in the Dialog area of the Windows screen. You may change the snap increments by using the selection blocks or by entering data in the "other" data block and checking its selection block.

```
<table>
<thead>
<tr>
<th>Define Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snap Increment (inches)</td>
</tr>
<tr>
<td>12</td>
</tr>
<tr>
<td>OK</td>
</tr>
</tbody>
</table>
```

1. Move the mouse pointer to the desired increment selection block. (You may also use the [Tab] key.)
2. Press the left mouse key.

A solid dot will appear in the selected circle. Because only one increment can be selected, a solid dot in one of the other circles will disappear.

If you desire to add a unit increment other than the displayed increments:

a. Move the mouse pointer to the "other" data block.

b. Press the left mouse key.

A vertical cursor will appear in the selected data block. (You may also press and hold the left mouse key as you drag the cursor over the existing entry to highlight it in reversed text.)
c. Type in the new entry. Use the [Backspace] and [Del] keys as necessary.

To save the unit increment entry:
3. Move the mouse pointer to the OK action box at the bottom of the window. (You may use the CANCEL option if you decide not to change the unit increment.)
4. Press the left mouse key.

The dialog window will disappear.

**SNAP TO UNITS**

Activates or deactivates the unit snap increment set by the Define Units command. When the snap increment is specified and used, an exact placement of elements can be achieved. The Snap to Units default is on as signified by a checkmark in front of the Snap to Units option and a highlighted icon.

Select the Snap To Units Tool Icon or command from the Layout Menu.

The Layout Menu will disappear. You may verify that the Snap to Units option is active by checking the Layout Menu for a checkmark in front of the Snap to Units option or the Tool Icons for a highlighted Snap to Units icon. To turn off the Snap to Units option, select the Snap to Units command or Tool Icon again. The checkmark will disappear and the Tool Icon will no longer be highlighted.

With Snap to Units off, the snap increment is 1 inch.

**INITIAL OBJECT SIZE**

The initial size of the Shape when it first appears on the screen may be defined. An Initial Object Size dialog window will guide you in specifying the initial N-S and E-W dimensions, the diameter, the height, the floor, wall, column thickness, orientation (N-S or E-W) of the shape, and if the shape is to maintain its initial size when stacking on another shape.

Select the Initial Object Size Tool Icon or command from the Layout Menu.

The Initial Object Size Dialog Window will appear in the Dialog area of the Windows screen. You may specify the initial width, diameter, height, thickness, or orientation of the selected shape.

To change an Initial Size Dimension:
1. Move the mouse pointer to the data block(s) to be modified. (You may also use the [Tab] key.)
2. Press the left mouse key.

A vertical cursor will appear in the selected data block. (You may also press and hold the left mouse key as you drag the cursor over the existing entry to highlight it in reversed text.)
DRAW MODEL TOOL PALETTE

3. Type in the new entry. Use the [Backspace] and [Delete] keys as necessary.

**To change orientation or select maintain size:**
1. Move the mouse pointer to the selection box.
2. Press the left mouse key.
   The selection box will be changed.

**To save the Initial Size selections:**
1. Move the mouse pointer to the OK action box at the bottom of the window. (You may use the CANCEL option if you decide not to change the initial object size.)
2. Press the left mouse key.

Shapes stacked on ground and underground will be sized to the specified initial dimensions. For shapes stacked on last shape or plane the specified initial height dimension will be used for the distance perpendicular to the plane.

**STACKING SHAPE OPTIONS**

There are four Shape Stacking Options. These options control the initial location of the selected shape when it is placed on the Modeling Screen. Only one option can be selected. The initial default option is Stack on Ground. The four options are:

**STACK ON GROUND**

As new shapes appear they will be stacked (located) at the center of the ground plane. The initial size of the shape is based on dimensional data saved with the Initial Object Size command. The shape may be moved to the desired location with the mouse.
STACK ON LAST SHAPE

As new shapes appear they will automatically be stacked (located) on the roof plane of the last shape placed if the last shape is compatible with the selected shape (i.e., a cube will not stack on a prism). The shape will automatically be sized to cover the roof plane of the last shape placed, if the Maintain Initial Object Size option is off on the Initial Object Size Dialog window. Remaining dimensions will be sized based on dimensional data saved with the Initial Object Size command. The first shape placed will be placed on the ground grid.

STACK ON PLANE

After selecting a shape you will be prompted for a plane to stack (locate) the shape on. Each stackable plane is highlighted by a yellow dot. Select the desired plane by moving the cursor on the dot and by clicking the left mouse key once. The shape may be stacked on the top, sides, or bottom of another shape. The shape will automatically be sized to cover the designated plane, if the Maintain Initial Object Size option is off on the Initial Object Size Dialog window. Remaining dimensions will be sized based on dimensional data saved with the Initial Object Size command.

STACK UNDERGROUND

As new objects appear they will be stacked (located) at the center of the ground plane under the ground floor plane of the model. The initial size of the shape is based on dimensional data saved with the INITIAL OBJECT SIZE command.

Select one of the Stack option Tool Icons or menu commands from the Layout Menu.

The Layout Menu will disappear. You may verify that the desired Stack option is active by checking the Layout Menu for a checkmark in front of the desired Stack option or look for a highlighted tool icon. To change the Stack option, select another Stack option. The checkmark will change on the Layout Menu. The highlighted tool icon will change.

LOCKING OPTIONS

You may find that moving objects in 3-Dimensions on a 2-Dimensional screen is difficult. The translated distances on the Dimension Dialog window help, but you will find that the Lock options are more convenient. There are three Locking options. These options prevent the dimensional changes or object movement in the specified directions. None, one, two, or three locking options can be selected. The three options are:

LOCK N-S

Prevents dimensional changes or object movement in the N-S direction.
LOCK E-W

Prevents dimensional changes or object movement in the E-W direction.

LOCK VERTICAL

Prevents dimensional changes or object movement in the vertical direction.

*Select one of the Locking option Tool Icons or menu commands from the Layout Menu.*

The Layout Menu will disappear. You may verify that the desired Lock option is active by checking the Layout Menu for a checkmark in front of the desired Lock option or look for a highlighted tool icon. To change the Lock option, select the Lock option again. The checkmark will disappear on the Layout Menu. The highlighted tool icon will change to unhighlighted.
REFERENCE

REFERENCE MENU (NI)

Use the Reference Menu commands to aid in creating a dimensionally correct structural model based on the CADD geometry of the Architectural Model. You can use the Import command in the Files Menu to load the Reference CADD file. Once loaded you can use the Reference Menu commands to control the reference model. There are no icons for the Reference Menu commands.

To select a command from the Reference Menu:

For the Single-Monitor System and the Dual-Monitor System:

1. Move the mouse pointer to the Reference Pull-Down Menu title. (You may also select [Alt] + [R] from the keyboard to display the Reference Pull-Down Menu.)
2. Type the underlined letter of the desired reference selection from the menu. (You may also move the mouse pointer down the list to the desired reference selection and press the left mouse key.)

A dialog window will appear.

The Reference Menu commands are:

VIEW REFERENCE (NOT IMPLEMENTED)

A dialog window appears to permit you to select specific drawings and layers of an imported CADD drawing or 3-D Architectural model.

MOVE REFERENCE (NOT IMPLEMENTED)

You may move the reference model as necessary in order to compare it with the structural model.

ROTATE REFERENCE (NOT IMPLEMENTED)

You may rotate the reference model as necessary in order to compare it with the structural model.

DELETE REFERENCE (NOT IMPLEMENTED)

You may delete reference models that are no longer necessary.
You may use the Draw Structure Window to define and lay out a structural system for the model. The Draw Structure Window consists of a tool palette icon area and pull-down menus which have the same function as the tool icons. The menus and icons on the Draw Structure Tool Palette permit you to define a structural grid system and add openings with the Grid/Open Menu; modify structural members, structural grids, and openings with the Edit Menu; lay out structural members with the Floor/Roof, Col/Wall, and Bracing Menus; and designate connectivity with the Frame Menu.

You must be in a Viewpoint Tool Plane display option in order to use the Draw Structure menus.

The Draw Structure Tool Palette Window is shown below:

The Draw Structure Tool Palette will appear as shown above on the primary monitor of the Dual-Monitor System. On the Single-Monitor System only the Title Bar and the Pull-Down Menu headings of the Tool Palette will appear at the bottom of the screen. Instead of the menus "pulling down" from the menu bar, they will "push up" on the Single-Monitor System.

To select a command from the Draw Structure Menu with the mouse:

1. Move the mouse pointer to the Draw Structure heading on the system menu bar of the CASM Application Window.
2. Press the left mouse key.

The Draw Structure Tool Palette will appear. On the Single-Monitor System only the Draw Structure title bar and pull-down menu bar will be visible.

For the Dual-Monitor System:

1. Move the mouse pointer to the desired tool icon in the Draw Structure Tool Palette.
2. Press the left mouse key.

The tool icon will be highlighted and a dialog window may appear.

For the Single-Monitor System and Dual-Monitor System:
1. Move the mouse pointer to the desired pull-down menu option on the Draw Structure Window.
2. Press the left mouse key.
   The selected pull-down menu will appear.
3. Move the mouse pointer to the desired menu option. (You may also activate the command by typing the underlined letter in the desired command.)
4. Press the left mouse key to activate the command.
   A dialog window may appear. Refer to the Draw Structure command sequences listed on the following pages.

To select a command from the Draw Structure Window with the keyboard:

   The Draw Structure Tool Palette will appear. On the Single-Monitor System only the Draw Structure title bar and pull-down menu bar will be visible.
2. Hold down the [Alt] key and press the underlined key of the desired pull-down menu.
   The pull-down menu will be displayed on the screen.
3. Type the underlined letter of the desired command to activate the command.
   -OR-
   Use the up or down arrows on the keyboard to move the selection bar up or down to the desired selection, then press the [Enter] key.

The Draw Structure Menu commands selections are listed on the following pages:
EDIT MENU

The Edit pull-down menu contains commands that enable you to modify an existing structural framing system on a selected structural Plane or take components from other locations or other projects and use them in the selected structural Plane. The graphic Edit Tool Icons on the Draw Structure Window may also be used.

You must be in a Viewpoint Tool Plane display option in order to use the Edit Menu.

You may use the Viewpoint Tool Pan Tool to move the displayed plane on the screen and the Viewpoint Tool Distance Tool to Zoom In and out.

To select a command from the Edit Menu:

For the Dual-Monitor System:
1. Move the mouse pointer to the desired edit icon in the Draw Structure Tools Palette.
2. Press the left mouse key.
   The edit icon will be highlighted and a dialog window may appear, or handles will appear on objects on the Modeling Screen. The mouse pointer will change to the Matrox modeling screen.

For the Single-Monitor System and the Dual-Monitor System:
1. Move the mouse pointer to the Edit Pull-Down Menu title. (You may also select [Alt]+[E] from the keyboard to display the Edit Pull-Down Menu.)
2. Type the underlined letter of the desired edit command from the menu. (You may also move the mouse pointer down the list to the desired edit command and press the left mouse key.)
   A dialog window may appear or handles will appear on objects on the Modeling Screen. (For the Dual-Monitor System the mouse pointer will change to the Matrox modeling screen.)

The Edit Menu commands are listed on the following pages:
COPY STRUCTURE (NOT IMPLEMENTED)
Permits you to copy a structural system layout for one structural bay into a group of
designated bays. Selected structural elements are copied to the clipboard and
Paste Structure is used to Paste the elements into other locations.

PASTE STRUCTURE (NOT IMPLEMENTED)
Permits you to Paste structural elements from the clipboard to designated locations
on your structural model.

DELETE STRUCTURE
You may designate structural elements for deletion. Deleting a structural element
removes it from the graphic file.

You must be in a Viewpoint Tool Plane display option in order to use
the Delete Structure command.

Select the Delete Structure command from the Edit menu or the tool icon.

All structural elements will be highlighted at their midpoint by a colored dot
("handle"). Groups of structural elements such as narrowly spaced elements
will be represented by a single handle at the first member. The mouse pointer
changes to a + . (For the Dual-Monitor System the mouse pointer changes
to the Matrox modeling screen.)

1. Move the mouse pointer to the handle on a structural element to be deleted.

You may exit the editing mode at any time without deleting an element
by double clicking the right mouse key.

2. Press the left mouse key.
The designated structural element will be deleted. The handles on the structural
elements will reappear. You will remain in the Delete Structure edit mode.

3. Double click the right mouse key to exit the Delete Structure edit mode.

MODIFY STRUCTURE (NOT IMPLEMENTED)
The Modify Structure command permits you to modify (change) the attributes of a
structural element.

DELETE GRID LINE
The Delete Grid Line command permits you to Delete a main structural grid line
or a structural sub grid line on the selected structural Plane. Deleting a grid line
removes it from the graphic file.
You must be in a Viewpoint Tool Plane display option in order to use the Delete Grid Line command.

The main grid line will be deleted on all floors (structural planes) the sub grid line will be deleted only on the floor (structural plane) which you have selected.

Select the Delete Grid Line command from the Edit menu or the tool icon.

All grid lines are marked near the end of the grid line by a colored dot ("handle"). The mouse pointer changes to a + . (For the Dual-Monitor System the mouse pointer changes to the Matrox modeling screen.)

1. Move the mouse pointer to the handle on a grid line to be deleted.
2. Press the left mouse key.
   The designated grid line will be deleted. The grid line dimensions will be automatically revised. The handles on the grid lines will reappear. You will remain in the Delete Grid Line edit mode.
3. Double click the right mouse key to exit the Delete Grid Line edit mode.

MOVE GRID LINE

The Move Grid Line command permits you move main grid lines or sub grid lines on the selected structural plane.

The main grid line will be shifted on all floors (structural planes) the sub grid line will be shifted only on the floor (structural plane) which you have selected.

You must be in a Viewpoint Tool Plane display option in order to use the Move Grid Line command.

Select the Move Grid Line command from the Edit menu or the tool icon.

All grid lines are marked near the end of the grid line by a colored dot ("handle"). The mouse pointer changes to a + . (For the Dual-Monitor System the mouse pointer changes to the Matrox modeling screen.)

1. Move the mouse pointer to the handle on a grid line to be moved.
2. Press the left mouse key.
   The grid line will be highlighted. You may continue to select other grid lines to be moved.
   After marking all the grid lines to be moved--
3. Double click the right mouse key.
   The grid lines will change to their normal color. As you move the mouse the selected grid lines will move. Grid line dimensions will be dynamically updated as you move the grid lines.
   • Moving the mouse toward/away from you moves the selected grid lines.
You may exit the Move Grid Line editing mode at this time without saving changes by double clicking the right mouse key and the selected grid lines will return to their original locations.

4. Press the left mouse key to save the grid line change. The selected grid lines will be redrawn in their new locations.

DETERMINE OPENING

The Delete Opening command permits you to Delete an opening on the selected structural Plane. Deleting a grid line removes it from the graphic file.

You must be in a Viewpoint Tool Plane display option in order to use the Delete Opening command.

If the opening is continuous, you will be prompted by a dialog window if you want the openings deleted at all levels. Select either YES or NO.

Select the Delete Opening command from the Edit menu or the tool icon.

All openings are marked at their center at the intersection of the opening symbol by a colored dot ("handle"). The mouse pointer changes to a +. (For the Dual-Monitor System the mouse pointer changes to the Matrox modeling screen.)

1. Move the mouse pointer to the handle on an opening to be deleted.
2. Press the left mouse key. The designated opening will be deleted. The grid line dimensions will be automatically revised. The handles on the remaining openings will reappear. You will remain in the Delete Opening edit mode.
3. Double click the right mouse key to exit the Delete Opening edit mode.

MODIFY OPENING

The Modify Opening command permits you to Modify an opening on the selected structural Plane.

You must be in a Viewpoint Tool Plane display option in order to use the Modify Opening command.

If the opening is continuous, you will be prompted by a dialog window if you want the openings modified at all levels. Select either YES or NO.

Select the Modify Opening command from the Edit menu or the tool icon.

All openings are marked at their corners and center at the intersection of the opening symbol by a colored dot ("handle"). The mouse pointer changes to a +. (For the Dual-Monitor System the mouse pointer changes to the Matrox modeling screen.)
To move the opening:
1. Move the mouse pointer to the center handle on an opening to be moved.
2. Press the left mouse key.
The designated opening will be highlighted. The grid line dimensions will be automatically revised as you move the opening.
- Moving the mouse right/left corresponds to E-W on the screen.
- Moving the mouse toward/away from you corresponds to N-S on the screen.
3. Press the left mouse key to save the change.
The handles on the remaining openings will reappear. You will remain in the Modify Opening edit mode.

To change the size of the opening:
1. Move the mouse pointer to the corner handle on an opening to be redimensioned.
2. Press the left mouse key.
The designated opening will be highlighted. The grid line dimensions will be automatically revised as you drag the opening corner.
- Moving the mouse right/left corresponds to E-W on the screen.
- Moving the mouse toward/away from you corresponds to N-S on the screen.
3. Press the left mouse key to save the change.
The handles on the remaining openings will reappear. You will remain in the Modify Opening edit mode.
4. Double click the right mouse key to exit the Modify Opening edit mode.
GRID/OPENING MENU

The Grid/Opening pull-down menu contains commands that enable you to develop a structural grid for a structural framing system on a selected structural Plane or add openings to the structural plane. The Grid system will define locations for structural elements which you will add later. The opening may be continuous (extend through several stories) or unique for the selected structural Plane. The graphic Grid/Opening Tool icons on the Draw Structure Window may also be used.

You must be in a Viewpoint Tool Plane display option in order to use the Grid/Opening Menu.

You may use the Viewpoint Tool Pan Tool to move the displayed plane on the screen and the Viewpoint Tool Distance Tool to zoom in and out.

To select a command from the Grid/Opening Menu:

For the Dual-Monitor System:
1. Move the mouse pointer to the desired Grid/Opening icon in the Draw Structure Tools Palette.
2. Press the left mouse key.
   The selected Grid/Opening icon will be highlighted and a dialog window may appear, or handles will appear on objects on the Modeling Screen. The mouse pointer will change to the Matrox modeling screen.

For the Single-Monitor System and the Dual-Monitor System:
1. Move the mouse pointer to the Grid/Opening Pull-Down Menu title. (You may also select [Alt] + [G] from the keyboard to display the Grid/Opening Pull-Down Menu.)
2. Type the underlined letter of the desired Grid/Opening command from the menu. (You may also move the mouse pointer down the list to the desired edit command and press the left mouse key.)
   A dialog window may appear or handles will appear on objects on the Modeling Screen. (For the Dual-Monitor System the mouse pointer will change to the Matrox modeling screen.)

The Grid/Opening Menu commands are listed on the following pages:
The Define Grid command permits you to define the main structural Grid system for the entire model or for a specified section of the model. The Grid will be spaced based on model dimensions and specified spacing. After activating the command, a dialog box will appear which will permit you to specify spacing and offsets. You may also add new grids, delete grids, define limits, and modify the bubble locations, spacings, and labels by selecting the Options box. The program will lay out the Grid system based on the dimensions of the model and the parameters which you have set.

>> The Defined Grid is aligned with the ground plane. In order to create a rotated Grid system, the Ground Plane must be rotated first by the Define Ground Plane command in the Draw Model Layout menu. Then the rotated structural grid can be defined.

>> If you add more shapes after you define the structural grid, a dialog window will remind you to redefine the grid.

Select the Define Grid Tool icon or command from the Grid/Opening Menu.

The Define Grid Dialog Window will appear in the Dialog area of the Windows screen. You may change the structural grid spacing and offsets. Select the Options selection box to add new grids, delete grids, define limits, and change bubble locations, grid areas, and labels.

<table>
<thead>
<tr>
<th>Define Grid</th>
</tr>
</thead>
<tbody>
<tr>
<td>N-S Spacing</td>
</tr>
<tr>
<td>E-W Spacing</td>
</tr>
<tr>
<td>Perimeter Offset</td>
</tr>
<tr>
<td>OK</td>
</tr>
<tr>
<td>N-S Beginning Number</td>
</tr>
<tr>
<td>E-W Beginning Letter</td>
</tr>
<tr>
<td>Bubbles</td>
</tr>
<tr>
<td>north side</td>
</tr>
</tbody>
</table>

To define the grid spacings and offsets:
1. Move the mouse pointer to the data block(s) to be modified. (You may also use the [Tab] key.)
2. Press the left mouse key.
A vertical cursor will appear in the selected data block. (You may also press and hold the left mouse key as you drag the cursor over the existing entry to highlight it in reversed text.)

3. Type in the new entry. Use the [Backspace] and [Delete] keys as necessary. You may select the OK box to save the grid settings and display the grid on the model or you may modify the grid by the following methods.

To designate a specific area for the structural grid:
1. Move the mouse pointer to the Options selection box.
2. Press the left mouse key.
3. Move the mouse pointer to the Define Limits box.
   The Define Grid window will disappear and the mouse pointer will change to a graphic cursor.
4. Position the mouse pointer to a corner of the grid area.
5. Press the left mouse key.
6. Drag the mouse pointer to the opposite corner of the grid area.
7. Press the left mouse key.

To define new grid spacings and offsets:
1. Move the mouse pointer to the Options selection box.
2. Press the left mouse key.
3. Move the mouse pointer to the Add New Grid box.
   The Define Grid window will disappear and the mouse pointer will change to a graphic cursor.
4. Position the mouse pointer to a corner of the grid area.
5. Press the left mouse key.
6. Drag the mouse pointer to the opposite corner of the grid area.
7. Press the left mouse key.

To modify grid spacings and offsets:
1. Move the mouse pointer to the Options selection box.
2. Press the left mouse key.
3. Move the mouse pointer to the Select Grid box.
   The Define Grid window will disappear and the mouse pointer will change to a graphic cursor. Handles will appear at the center of the displayed grid systems.
4. Move the mouse pointer to the handle of the grid that you want to modify.
5. Press the left mouse key.
   The Define Grid window will reappear.
6. Make the grid spacing and offset changes in the data boxes.
To delete a structural grid:
1. Move the mouse pointer to the Options selection box.
2. Press the left mouse key.
3. Move the mouse pointer to the Delete Grid box.
   The last defined grid will disappear.

To save the Define Grid selections:
1. Move the mouse pointer to the OK action box at the bottom of the window.
   (You may use the CANCEL option if you decide not to define the structural grid.)
2. Press the left mouse key.
   The structural grid will be drawn/redrawn on the screen.

ADD MAIN GRID LINE

The Add Main Grid Line command will add a Main Grid line between two existing Main Grid lines.

The new Grid line is added to all levels.
You must be in a Viewpoint Tool Plane display option in order to use the Add Main Grid Line command.

Select the Add Main Grid Line command from the Grid/Opening menu or the tool icon.

Colored dots (handles) will appear on the building perimeter midway between the existing Main Grid lines near the grid line bubbles. The mouse pointer changes to a +. (For the Dual-Monitor System the mouse pointer changes to the Matrox modeling screen.)

1. Move the mouse pointer to a handle between the existing grid lines.
2. Press the left mouse key.

The new main grid line will appear midway between the existing grid lines at the handle location. The grid line dimensions will be automatically revised.
3. Moving the mouse toward/away from you will move the grid line.
   Double clicking the right mouse key will set the new grid line midway between the existing grid lines.
4. Press the left mouse key to save the new Main Grid at the selected location.

ADD SUB GRID LINE

The Add Sub Grid Line command will add a Sub Grid line between two existing main Grid lines.

The new Sub Grid line is only added to the selected level.
You must be in a Viewpoint Tool Plane display option in order to use the Add Sub Grid Line command.
Select the Add Sub Grid Line command from the Grid/Opening menu or the tool icon.

Colored dots (handles) will appear on the building perimeter midway between the existing Main Grid lines near the grid line bubbles. The mouse pointer changes to a +. (For the Dual-Monitor System the mouse pointer changes to the Matrox modeling screen.)

1. Move the mouse pointer to a handle between the existing grid lines.
2. Press the left mouse key.

The new sub grid line will appear midway between the existing grid lines at the handle location. The grid line dimensions will be automatically revised.
3. Moving the mouse toward/away from you will move the new grid line.
   - Double clicking the right mouse key will set the sub grid line midway between the existing grid lines.
4. Press the left mouse key to save the new Sub Grid at the selected location.

## ADD OPENING

The Add Opening command will add an Opening on the selected structural plane.

- You must be in a Viewpoint Tool Plane display option in order to use the Add Opening command.
- You may add an opening at the selected floor/roof plane or you may designate the opening as continuous for all structural floor planes.

Select the Add Opening command from the Grid/Opening menu or the tool icon.

A Tributary Area dialog window will appear with opening dimensions and mouse pointer location from the lower left corner of the floor plan.
1. Locate the mouse pointer at the desired location of one corner of the opening.
2. Press the left mouse key.
3. Moving the mouse will drag the opposite corner of the opening. Opening dimension changes will appear in the dialog window as you drag the mouse.
   >> You may exit the Add Opening mode at any time without adding an opening by double clicking the right mouse key.
4. Press the left mouse key again to save the opening dimensions. Another dialog box will appear with an opening name and an option to make the opening continuous through all levels of the structure. You may move the mouse pointer to the Continuous check box and press the left mouse key to make the opening continuous.
5. Move the mouse pointer to the OK action box.
6. Press the left mouse key.
The Floor/Roof pull-down menu contains commands that enable you to lay out a structural framing system on your structural grid on a selected structural Plane.

- You must be in a Viewpoint Tool Plane display option in order to use the Floor/Roof Menu.
- You may use the Viewpoint Tool Pan Tool to move the displayed plane on the screen and the Viewpoint Tool Distance Tool to Zoom in and out.

To select a command from the Floor/Roof Menu:

For the Dual-Monitor System:
1. Move the mouse pointer to the desired Floor/Roof icon in the Draw Structure Tools Palette.
2. Press the left mouse key.
   - The selected Floor/Roof icon will be highlighted and a dialog window will appear, and handles will appear on grid segments on the Modeling Screen. The mouse pointer will change to the Matrox modeling screen.

For the Single-Monitor System and the Dual-Monitor System:
1. Move the mouse pointer to the Floor/Roof Pull-Down Menu title. (You may also select [Alt] + [F] from the keyboard to display the Floor/Roof Pull-Down Menu.)
2. Type the underlined letter of the desired Floor/Roof command from the menu. (You may also move the mouse pointer down the list to the desired Floor/Roof command and press the left mouse key.)
   - A dialog window will appear and handles will appear on grid segments on the Modeling Screen. (For the Dual-Monitor System the mouse pointer will change to the Matrox modeling screen.)

The sequence for adding Floor/Roof structural members for all Floor/Roof Menu commands is listed below:

To define the structural framing area/location:
After the menu command is activated, all the Grid lines segments are marked by a colored dot (handle) at their midpoint.

To define a structural framing area you need to select Grid line segments in a clockwise orientation until you have defined the complete area where you desire to lay out the structural system. You do not need to select all the grid segments which represent the four sides of an area. For a simple bay defined by four Grid line segments, you need only to select Grid line segments on opposite sides of the area to define the area.
1. Position the mouse pointer on the handle of a grid line which borders the desired structural framing area.

2. Press the left mouse key to designate the boundaries or location(s).

   The selected GRID line segment will be highlighted. Continue to select grid segments until you have defined a rectangular area. Selecting a single grid segment will permit you to define a single beam.

3. Double click the right mouse key after you have defined the entire area or locations for laying out the framing members.

   A dialog window will appear to provide you with options to change number of members, spacing, or orientation. (Not all options are available for the different commands.) N-S and E-W spans are listed for reference.

   **You may exit the Floor/Roof mode at any time double clicking the right mouse key.**
To make changes to the dialog window:
1. Move the mouse pointer to the desired data box to make changes.
2. Press the left mouse key to position the cursor.
3. Enter the value change.

To view the change on the screen:
1. Move the mouse pointer to the Recalc action box.
2. Press the left mouse key.
   The structural elements will be rearranged to match the data in the Surface Element or Linear Element Dialog Window.

To accept the framing layout:
1. Move the mouse pointer to the SAVE action box.
2. Press the left mouse key.
   The dialog window will disappear. The members will remain on the screen.
   You may select CANCEL if you do not want to save the framing layout.

The Floor/Roof Menu commands are listed on the following pages.

SURFACE

ONE WAY

Defines a One-Way structural framing system by drawing a One-Way symbol on the framing plan. You may change orientation by selecting N-S or E-W orientation. The Surface Element dialog window displays the span.

TWO WAY

Defines a Two-Way structural framing system by drawing a Two-Way symbol on the framing plan. The Surface Element dialog window displays the span.

LINEAR

NARROWLY SPACED

Draws and defines a Narrowly Spaced structural framing system by drawing Narrowly Spaced elements in areas which you designate at the spacing or number of elements selected in the Linear Elements dialog window. The Linear Element dialog window displays the span. You may vary the orientation, span, and spacing and review the changes before selecting the desired layout.
**WIDELY SPACED**

Draws and defines a Widely Spaced structural framing system by drawing Widely Spaced elements within the designated area on the framing plan. The members are initially spaced evenly in the designated area. You may vary the orientation, span, and spacing and review the changes before selecting the desired layout. You may also select a single grid line for a single beam using the Widely Spaced command.

**BEAMS ALL GRID LINES**

Automatically draws and defines Beams on all Main Grid lines.

**TRUSS (NOT IMPLEMENTED)**

Draws and defines Trusses in the area or location which you designate.

**NON-HORIZONTAL ARCH (NOT IMPLEMENTED)**

Draws and defines Non-Horizontal Arches in the area or location which you designate.

**GRIDS TWO-WAY (NOT IMPLEMENTED)**

Draws and defines a Two-Way Grid system in the area or location which you designate.
COL/WALL

The Col/Wall pull-down menu contains commands that enable you to develop a column and/or bearing wall system for a selected structural plane.

You must be in a Viewpoint Tool Plane display option in order to use the Col/Wall Menu.

You may use the Viewpoint Tool Pan Tool to move the displayed plane on the screen and the Viewpoint Tool Distance Tool to Zoom in and out.

To select a command from the Col/Wall Menu:

For the Dual-Monitor System:
1. Move the mouse pointer to the desired Col/Wall icon in the Draw Structure Tools Palette.
2. Press the left mouse key.
   The selected Col/Wall icon will be highlighted and a dialog window will appear. The mouse pointer will change to the Matrox modeling screen.

For the Single-Monitor System and the Dual-Monitor System:
1. Move the mouse pointer to the Col/Wall Pull-Down Menu title. (You may also select [Alt] + [C] from the keyboard to display the Col/Wall Pull-Down Menu.)
2. Type the underlined letter of the desired Col/Wall command from the menu. (You may also move the mouse pointer down the list to the desired Col/Wall command and press the left mouse key.)
   A dialog window will appear. (For the Dual-Monitor System the mouse pointer will change to the Matrox modeling screen.)

<table>
<thead>
<tr>
<th>Column Elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orientation: ○ H-S □ E-W</td>
</tr>
<tr>
<td>Height          : 14.0 ft</td>
</tr>
<tr>
<td>Distance from grid : 0.1</td>
</tr>
<tr>
<td>H-S             : 0.0 ft</td>
</tr>
<tr>
<td>E-W             : 0.0 ft</td>
</tr>
<tr>
<td>All Floors</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Recalc  Save   Cancel</td>
</tr>
</tbody>
</table>

The Floor/Roof Menu commands are listed on the following pages.
**COLUMN**

**ALL GRID INTERSECTIONS**

Activating the All Grid Intersection command will draw columns at all Main Grid intersections on the structural plane which you have selected. A dialog box will permit you to change orientations and draw columns on all floors.

- You must be in a Viewpoint Tool Plane display option in order to use the All Grid Intersections command.
- You may add columns at the selected floor/roof plane or you may designate the columns as continuous for all structural floor planes.

Select the All Grid Intersections command from the Col/Wall menu or the tool icon.

Columns will be drawn at all Main Grid intersections. A Column Element dialog window will appear with column orientation information and an option box for all floors.

1. Move the mouse pointer to a check box.
2. Press the left mouse key to change the selection.
3. Move the mouse pointer to the SAVE action box.
4. Press the left mouse key again to save the column layout. (Selecting CANCEL will remove the columns from the grid lines without saving.)

**ONE GRID INTERSECTION**

Activating the One Grid Intersection command will draw a column at the designated Main or Sub Grid intersections on the structural plane which you have selected. A dialog box will permit you to change orientations and draw the Column on all floors.

- You must be in a Viewpoint Tool Plane display option in order to use the One Grid Intersection command.
- You may add a column at the selected floor/roof plane or you may designate the column as continuous for all structural floor planes.

Select the One Grid Intersections command from the Col/Wall menu or the tool icon.

The mouse pointer changes to a +. (For the Dual-Monitor System the mouse pointer changes to the Matrox modeling screen.)

1. Move the mouse pointer to a grid intersection where you intend to place a column.
2. Press the left mouse key.
A column symbol will appear at the intersection. A Column Element dialog window will appear with column orientation information and an option box for all floors.

3. Move the mouse pointer to a check box.
4. Press the left mouse key to change the selection.
5. Move the mouse pointer to the SAVE action box.
6. Press the left mouse key again to save the column layout. (Selecting CANCEL will remove the column from the grid lines without saving.)

**DRAGGED (NOT IMPLEMENTED)**

Permits you to draw and define a Column which is not on an existing Grid intersection.

**WALL**

**2 GRID POINTS**

Permits you to draw and define a bearing/shear Wall between two Grid intersections.

>> You must be in a Viewpoint Tool Plane display option in order to use the 2 Grid Points command.

**Select the 2 Grid Points command from the Col/Wall menu or the tool icon.**

The mouse pointer changes to a +. (For the Dual-Monitor System the mouse pointer changes to the Matrox modeling screen.)

1. Move the mouse pointer to a grid intersection where you intend to start the wall.
2. Press the left mouse key.
3. Move the mouse pointer to the second grid intersection where you intend to end the wall.

>> You may exit the 2 Grid Intersection command without adding the wall by double clicking the right mouse key.

4. Press the left mouse key.

A wall will be drawn joining the two intersections. A Wall Element dialog window will appear with data boxes to designate wall heights and wall thickness.

5. Move the mouse pointer to a data box.
6. Press the left mouse key to move the cursor to the data box.
7. Enter the change.
8. Move the mouse pointer to the SAVE action box.
9. Press the left mouse key again to save the wall layout. (Selecting CANCEL will remove the wall from the grid lines without saving.)

**DRAGGED (NOT IMPLEMENTED)**

Permits you to draw and define a bearing/shear Wall in a location where there are no existing Grid intersections.

**PILASTER (NOT IMPLEMENTED)**

Permits you to draw and define a Pilaster on a Wall.

**FOOTING (NOT IMPLEMENTED)**

Enables or disables the placement of a footing at the base of columns and walls.
The Bracing pull-down menu contains commands that enable you to develop a bracing system for a selected structural frame.

**X-BRACE (NOT IMPLEMENTED)**

Adds X-bracing on the structural plane within the selected border.

**K-BRACE (NOT IMPLEMENTED)**

Adds K-bracing on the structural plane within the selected border.

**SPREAD K (NOT IMPLEMENTED)**

Adds SPREAD K-bracing on the structural plane within the selected border.

**SINGLE DIAGONAL (NOT IMPLEMENTED)**

Adds a SINGLE DIAGONAL brace between points selected on two borders on the structural plane.

**OFFSET DIAGONAL (NOT IMPLEMENTED)**

Adds an OFFSET DIAGONAL brace between two selected borders on the structural plane.

**KNEE BRACE (NOT IMPLEMENTED)**

Adds a KNEE BRACE at the corner of two selected borders on the structural plane.
* FRAME (NOT IMPLEMENTED)

The FRAME pull-down menu contains commands that enable you to develop the connectivity for a structural framing system on a selected structural PLANE.

**ALL CONNECTIONS (NOT IMPLEMENTED)**

Draws a framed connection in all structural connections on the structural plane.

**ONE CONNECTION (NOT IMPLEMENTED)**

Draws one framed connection at the designated intersection of two structural members on the structural plane.
LOADS AND DESIGN TOOL PALETTE

The Loads and Design Tool Palette Window is used to define the loads acting on the structural model and make preliminary structural system selections based on the loading conditions on the preliminary structural frame developed in Draw Structure. The Loads pull-down menu will permit you to generate loads and apply them to the structural model. The Mat'l pull-down menu permits you to select a material such as steel or concrete for your preliminary design. The material selection will determine the list of displayed systems in the Floor/Roof and Col/Wall pull-down menus. The Fdtn pull-down menu when implemented will permit you to do preliminary foundation designs based on the specified loading conditions. The Design pull-down menu permits you to do a preliminary analysis and design of designated structural elements. You may then use a spreadsheet in order to select a preliminary element size. The Loads and Design Tool Palette Window is shown below:

<table>
<thead>
<tr>
<th>Loads</th>
<th>Mat'l</th>
<th>Floor/Roof</th>
<th>Col/Wall</th>
<th>Fdtn</th>
<th>Design</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Loads Icon]</td>
<td>![Mat'l Icon]</td>
<td>![Floor/Roof Icon]</td>
<td>![Col/Wall Icon]</td>
<td>![Fdtn Icon]</td>
<td>![Design Icon]</td>
</tr>
</tbody>
</table>

The Loads and Design Tool Palette will appear as shown above on the primary monitor of the Dual-Monitor System. On the Single-Monitor System only the Title Bar and the Pull-Down headings of the Tool Palette will appear at the bottom of the screen. Instead of the menus "pulling down" from the menu bar, they will "push up."

**You must be in a Viewpoint Tool Plane display option in order to use the Loads and Design menus.**

To select a command from the Loads and Design Window with the mouse:

1. Move the mouse pointer to the Loads and Design heading on the system menu bar of the CASM Application Window.
2. Press the left mouse key.

The Loads and Design Tool Palette will appear. On the Single-Monitor System only the Loads and Design title bar and pull-down menu bar will be visible.

For the Dual-Monitor System:

1. Move the mouse pointer to the desired tool icon in the Loads and Design Tool Palette.
2. Press the left mouse key.
   The tool icon will be highlighted and a dialog window will appear.

For the Single-Monitor System and Dual-Monitor System:
1. Move the mouse pointer to the desired pull-down menu option on the Loads and Design Window.
2. Press the left mouse key.
   The selected pull-down menu will appear.
3. Move the mouse pointer to the desired menu option (you may also activate the command by typing the underlined letter in the desired command).
4. Press the left mouse key to activate the command.
   A dialog window will appear. Refer to the Loads and Design command sequences listed on the following pages.

To select a command from the Loads and Design Window with the keyboard:

5. Hold down the [ALT] key and press the L-key.
   The Loads and Design Tool Palette will appear. On the Single-Monitor System only the Loads and Design title bar and pull-down menu bar will be visible.
6. Hold down the [ALT] key and press the underlined key of the desired pull-down menu.
   The pull-down menu will be displayed on the screen.
7. Type the underlined letter of the desired command to activate the command.
   -OR-
   Use the up or down arrows on the keyboard to move the selection bar up or down to the desired selection, then press the [ENTER] key.

The Loads and Design Tool Palette pull-down menus are listed on the following pages:
**LOADS MENU**

The Loads pull-down menu commands permit you to develop a list of building materials and their corresponding dead load (DL) values for floor, wall, ceiling, and roof assemblies. You may develop a list of concentrated (Point) loads and moments. You may develop a list of occupancy live loads (LL) which apply to your project. All of the loads may be selectively applied to surfaces on the model in order to simulate anticipated loading conditions.

In addition, this version of the CASM program will automatically calculate wind, snow, and minimum roof live loads based on the structural model geometry. Later versions will automatically calculate seismic loads.

You must be in one of the Plane displays (i.e., Plane Name, Horizontal Plane, Incline Plane) in order to assign area loads or point loads.

The Loads Menu command selections are listed on the following pages:

**LOAD COMBINATIONS**

Before structural members can be analyzed, you need to define load combinations and load factors. The Load Combinations menu selection displays a dialog window where you can define load factors and load combinations.

A Load Combination must be selected before a member can be analysed.

Select the Load Combinations Icon or command from the Loads Menu.

A Load Combination Dialog Window will appear.

To add load combinations to the Name block:

1. Move the mouse pointer to a load factor value box.
2. Press the left mouse key (you may also hold the left mouse key and drag the cursor over the current factor value to highlight it).

A vertical cursor will appear. Use the keyboard keys to type in a new factor value.

After you have entered all the factors for the desired load combination:

3. Move the mouse pointer to the ADD action block.

4. Press the left mouse key.

The load combination with factors will be added to the list in the Load Combination Name block.

If you need a reference for the code-specified combinations:

1. Move the mouse pointer to the Guidelines action block.

2. Press the left mouse key.


To select a Load Combination:

1. Move the mouse pointer to a Load Combination in the Name box.

2. Press the left mouse key.

The selected Load Combination will be highlighted and will be used in the analysis.

After you have entered all the desired Load Combinations:

1. Move the mouse pointer to the OK action block.

2. Press the left mouse key.

The dialog window will disappear.

- AREA DEAD LOADS

All of the Area Dead Load command sequences are similar. The pop-up dialog window that appears when an area dead load is selected contains a space for the load type name, a list of materials with corresponding weights (PSF), a summary of all the weights, and action boxes. The four area dead load commands and their Tool Palette symbols are listed below:

- FLOOR (DL)

Permits you to define a floor system of floor materials and their corresponding weights. Floor materials and weights may be selected from a floor material listing or may be entered from the keyboard. Several systems may be defined for the project. Permits you to selectively assign the floor system to a designated floor area.

- WALL (DL)
Permits you to define a wall system of wall materials and their corresponding weights. Wall materials and weights may be selected from a wall material listing or may be entered from the keyboard. Several systems may be defined for the project. Permits you to selectively assign the wall system as a line load on the designated plane. The default units (PSF) value is automatically converted to PLF for floor loadings.

**CEILING (DL)**

Permits you to define a ceiling system of ceiling materials and their corresponding weights. Ceiling materials and weights may be selected from a ceiling material listing or may be entered from the keyboard. Several systems may be defined for the project. Permits you to selectively assign the ceiling system to a designated floor/ceiling area.

**ROOF (DL)**

Permits you to define a roof system of roof materials and their corresponding weights. Roof materials and weights may be selected from a roof material listing or may be entered from the keyboard. Several systems may be defined for the project. Permits you to selectively assign the roof system to a designated roof area.

Select the Floor, Wall, Ceiling or Roof command from the Loads menu or Tool Palette.

A loads dialog window appears.

To enter a name for a system type and corresponding loads:

1. Move the mouse pointer to the 'Name' box at the top of the dialog window.
When the dialog box first appears, the cursor is automatically placed at the 'Name' box. A new name may be added by typing the new name from the keyboard.

2. Press the left mouse key and drag the pointer over the characters to be changed or move the pointer to the desired correction location and press the left mouse key to position the cursor.

3. Type in the appropriate characters to modify the system type name.

Several system types for each roof, wall, ceiling, and floor may be assigned for the project.

To select the material and weight from a list of materials and corresponding weights (PSF):

1. Move the mouse pointer to the appropriate 'Type' box.
2. Press the left mouse key once and release.

A dialog window will appear which contains a list of materials and their corresponding weights.

<table>
<thead>
<tr>
<th>Name</th>
<th>Floor Type 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition</td>
<td>0-50 PLF</td>
</tr>
<tr>
<td>Finish</td>
<td>Marble Tile 1/2</td>
</tr>
<tr>
<td>Deck</td>
<td>MT/OK 1.5/MLWT</td>
</tr>
<tr>
<td>Structure</td>
<td></td>
</tr>
<tr>
<td>Mechanical</td>
<td></td>
</tr>
<tr>
<td>Electrical</td>
<td></td>
</tr>
<tr>
<td>Fire Protection</td>
<td></td>
</tr>
<tr>
<td>Ceiling</td>
<td></td>
</tr>
</tbody>
</table>

Use the up or down arrows or the white rectangle on the vertical bar between the arrows to see more selections on the list.

4. Press the left mouse key twice in quick succession (double-click).

OR

a. Press the left mouse key once to select an item.

The item will be highlighted by a dark bar.

b. Move the mouse pointer to the 'OK' box at the bottom of the pop-up dialog window in order to transfer the selection to the construction type dead load (DL) list.

c. Press the left mouse key once and release.
The material will appear in the material type column and the weight will appear in the PSF column. The weight will be added to the weights in the 'Total' box.

To modify a material type:

After the item data from the list appears in the 'Type' and 'PSF' boxes, the vertical cursor will be flashing at the end of the material type name.

1. Use the backspace key or press down on the left mouse key and drag the pointer to the left to highlight the characters you want to replace.
2. Type in the desired entry.

To change a weight:

1. Move the mouse pointer to the weight that is to be changed.
2. Press the left mouse key and hold down while dragging the pointer over the weight that is to be changed.
3. Type in the new weight.

The new weight will be added to the 'Total' when another data box is selected by the mouse.

Once the system type is complete:

1. Move the mouse pointer to the SAVE box at the bottom of the dialog window.
2. Press the left mouse key once to SAVE the Area Load.

Several options are available once you have completed the list:

ASSIGN

Permits you to ASSIGN the display construction type and total load to the designated plane displayed on the screen.

1. Move the mouse pointer to the ASSIGN action block.
2. Press the left mouse key.

In order to assign a load you must have a horizontal or inclined plane displayed. Floor loads can only be assigned to floor planes.

After selecting ASSIGN the graphic cursor will appear on the modeling screen. You designate the area where the load is to be applied. A Tributary Area Dialog Window is displayed to aid you in locating the area load.

To assign Area Loads:

1. Move the graphic cursor to the first corner of the area load.
   Refer to the values in the dialog window to aid in the placement of the area load.
2. Press the left mouse key.

At any time you may double click the right mouse key to exit the Area Load Assign sequence.
3. Move the graphic cursor to the diagonally opposite corner of the area load.
4. Press the left mouse key.

The assigned load area will be shaded and the load values will be printed on the screen. The Area Load Dialog window will reappear.

To assign Wall Loads:
1. Move the graphic cursor to the one end of the wall load.
   Refer to the values in the dialog window to aid in the placement of the wall load.

2. Press the left mouse key.
   At any time you may double click the right mouse key to exit the Area Load Assign sequence.
3. Move the graphic cursor to the other end of the wall load.
4. Press the left mouse key.

The assigned wall load will be drawn and the wall load values will be printed on the screen. The Wall Load Dialog window will reappear.

SAVE
Moving the mouse pointer to the SAVE box and pressing the left mouse key permits you to SAVE the area load type in the project list under the name you gave to it (i.e., Floor Type 1). After saving an area load type, you may create a new load type by modifying the materials and weights, enter a new area load name and save it as another area load type. The CASM program checks for another area load type of the same name and will provide you with a warning dialog window if one exists.
NEXT
Permits you to select and display different area load types from the list of types that were created. You may use NEXT to review the area load types and modify the materials or select area load types for assignment to model surfaces. Move the mouse pointer to the NEXT box and press the left mouse key.

STOP
Moving the mouse pointer to the STOP box and pressing the left key returns you to the main CASM screen.

POINT LOADS AND MOMENTS

All of the point loads and moment loads command sequences are similar. The dialog window that appears when a point load or moment is selected contains spaces for the load type and weight and action boxes. The point load and moment load commands and their Tool Palette symbols are:

POINT (DL)
Permits you to define a concentrated load type and corresponding weight. Concentrated load types and weights are entered from the keyboard. Several concentrated loads may be defined for the project. Permits you to selectively assign the concentrated load to a designated floor or roof area. Default units - Pounds.

POINT (LL)
Same as POINT (DL) except concentrated load types and weights may be selected from a listing.

MOMENT (DL)
Permits you to define a moment type and corresponding magnitude. Moment types and values may be entered from the keyboard. Several moments may be defined for the project. Permits you to selectively assign the moment to a designated structural member. Default units - Ft-lbs. The Assign option is not implemented.

MOMENT (LL)
Same as MOMENT (DL)

In order to assign a load you must have a horizontal or inclined plane displayed.
Select the Point Dead Load (DL) or Point Live Load (LL) from the LOADS pull-down menu or Tool Palette.

A Point Load dialog window will appear.

To add loads to the Project List:
1. Move the mouse pointer to the 'ADD' box in the LOADS dialog window.
2. Press the left mouse key once and release.
   An input load dialog window will appear.

For Point Load (LL):

To select a point load from the list of code minimums:
1. Move the mouse pointer to the desired point load.
2. Press the left mouse key twice in quick succession (double-click).

OR
   a. Press the left mouse key once and release.
      The selection is highlighted by a color bar.

To transfer the load to the Project List:
   b. Move the mouse pointer to the 'OK' box at the bottom of the menu.
   c. Press the left mouse key once and release.
      The load list disappears and the selected load is added to the project list.

For Point Load (DL), Moment (DL), or Moment (LL):

To enter a load to the Project List:
1. Move the mouse pointer to the 'ADD' box.

   NOTE: You may press the space bar if the cursor is under the ADD box in the dialog window to eliminate the need to use the mouse.

2. Press the left mouse key once and release.
A dialog window will appear.

3. Type in the desired load name.

4. Move to the Pounds (Ft-lbs) box with the mouse pointer or by pressing the tab key on the keyboard.

5. Type in the load value.

To transfer the load to the Project List:

6. Press ENTER on the keyboard or move the mouse pointer to the 'OK' box at the bottom of the menu and press the left mouse key once and release.

The dialog window disappears and the selected load is added to the project list.

For Point (DL), Point (LL), Moment (DL), and Moment (LL):

To modify a material type or weight:

1. Move the mouse pointer to a load type on the 'Project List.'

2. Double click the left mouse key.

   A dialog window will appear with the load type and its value. The name is highlighted by a dark bar.

3. Type in the new name or move the mouse pointer to the value box; press and hold the left mouse key while dragging the pointer over the old load value. Type in the new value.

4. Press the ENTER key or move the mouse pointer to the 'OK' box and press the left mouse key to verify the modification.

The modified item will appear on the Project List.

Once the Project List is complete, several options are available.

ADD

Permits you to ADD a new load to the Project List. Moving the mouse pointer to the ADD box and pressing the left mouse key will display the Load Input dialog window.

ASSIGN

Permits you to ASSIGN the load to a surface on the model.

1. Move the mouse pointer to the desired load name on the project list of point loads.

2. Press the left mouse key to highlight the selection.

3. Move the mouse pointer to the ASSIGN block.

4. Press the left mouse key.

   The graphic cursor will appear on the modeling screen. The Tributary Load Dialog Window will appear to aid you in locating the Point Load.

5. Move the graphic cursor to locate the designated point load.

6.
REFERENCE LOADS AND DESIGN TOOL PALETTE

Distance from lower-left corner:
- Horizontal: 13.00 ft
- Vertical: 0.00 ft
- Horizontal Length: 0.00 ft
- Horizontal Length: 0.00 ft

Double click the right mouse key at any time to exit the ASSIGN option without assigning a load.

7. Press the left mouse key.
   The designated point load will be marked and the load value will be printed on the screen. The Point Load list will reappear to assign another load.

STOP
Moving the mouse pointer to the STOP box and pressing the left mouse key returns you to the main CASM screen.

OCCUPANCY (LL)

The dialog window that appears when the OCCUPANCY Load is selected contains a space for the occupancy load type name, weight, Live Load Reduction guidelines, and action boxes.

The OCCUPANCY (LL) command permits you to select occupancy loads from an occupancy load listing or enter an occupancy load from the keyboard. Several occupancy loads may be specified for the project. Permits you to selectively assign the occupancy load to a designated floor area. Default units - PSF.

You must be in one of the Plane displays (i.e., Plane Name, Horizontal Plane, Incline Plane) in order to assign occupancy loads.

Select the OCCUPANCY command from the Loads menu or Tool Palette.

An Occupancy loads dialog window appears.

To select the project occupancy types, code load values, and live load reduction factors from a list of occupancy types:

1. Move the mouse pointer to the ADD box in the OCCUPANCY (LL) dialog window.
2. Press the left mouse key once and release.
A dialog window will appear which contains a list of occupancy types and their corresponding load values.

<table>
<thead>
<tr>
<th>Occupancy (LL)</th>
<th>psf</th>
</tr>
</thead>
<tbody>
<tr>
<td>Office: Offices</td>
<td>50</td>
</tr>
<tr>
<td>Office: Files &amp; Storage</td>
<td></td>
</tr>
<tr>
<td>Lounges (small rec rm)</td>
<td>60</td>
</tr>
<tr>
<td>Manufacturing: Light</td>
<td>125</td>
</tr>
<tr>
<td>Manufacturing: Heavy</td>
<td>250</td>
</tr>
<tr>
<td>Marquees/canopies</td>
<td>75</td>
</tr>
<tr>
<td>Mech telephone/radio equip rm</td>
<td>150</td>
</tr>
<tr>
<td>Office buildings:</td>
<td></td>
</tr>
<tr>
<td>Office: Business mach. equip</td>
<td>100a</td>
</tr>
<tr>
<td>Office: Corridor (main)</td>
<td>100</td>
</tr>
<tr>
<td>Office: Corridor (secondary)</td>
<td>60</td>
</tr>
<tr>
<td>Office: Files &amp; storage</td>
<td>80a</td>
</tr>
<tr>
<td>Office: Lobbies</td>
<td>100</td>
</tr>
<tr>
<td>Office: Offices</td>
<td>50</td>
</tr>
</tbody>
</table>

3. Move the mouse pointer to the desired selection.
   Use the up or down arrows or the white rectangle on the vertical bar between the arrows to see more selections on the list.

4. Double click the left mouse key.

   OR
   a. Press the left mouse key once to select an item. The item will be highlighted by a dark bar.
   b. Move the mouse pointer to the 'OK' box at the bottom of the dialog window in order to transfer the selection to the Occupancy (LL) Project List.
   c. Press the left mouse key once and release.

Some occupancy types and their corresponding loads may also have additional notes. For these occupancy loads, a special pop-up dialog window will appear with additional information.

- Variable design load. Increase may be necessary.

The occupancy type and load value will appear on the project list.

To modify an occupancy type or load value:
1. Move the mouse pointer to the Occupancy type on the 'Project' list.
2. Double click the left mouse key.
A dialog window will appear with the load type, value, and note (if applicable). The name is highlighted by a dark bar.

3. Type in the new name or move the mouse pointer to the value box; press and hold the left mouse key while dragging the pointer over the old load value. Type in the new value.

4. Press the ENTER key or move the mouse pointer to the 'OK' box and press the left mouse key to verify the modification. The modified item will appear on the Project List.

5. If Live Load Reductions are to be used, move the mouse pointer to the Live Load Reduction box and press the left mouse key to place an X in the box.

Once the Occupancy Load List is complete:

1. Move the mouse pointer to the appropriate action box at the bottom of the dialog window.
2. Press the left mouse key once to activate the command.

The Action Box options are:

**LLR GUIDELINES**
Pop-up windows provide building code criteria for determining if live load reductions apply. Select the OK box to remove the window from the screen.

**ADD**
Permits you to ADD a new occupancy type and load to the Project List. Moving the mouse pointer to the 'ADD' box and pressing the left mouse key will display the list of Occupancy types dialog window. Use procedures listed above to select an occupancy load from the list.

**ASSIGN**
Permits you to ASSIGN the occupancy load value to a surface on the model.

1. Move the mouse pointer to the desired load name on the project list of point loads.
2. Press the left mouse key to highlight the selection.
3. Move the mouse pointer to the ASSIGN block.
4. Press the left mouse key.

The graphic cursor will appear on the modeling screen. The Tributary Load Dialog Window will appear to aid you in locating the Occupancy Load.

5. Move the graphic cursor to the first corner of the area load.

Refer to the values in the dialog window to aid in the placement of the area load.

At any time you may double click the right mouse key to exit the Area Load Assign sequence.
6. Press the left mouse key.
7. Move the graphic cursor to the diagonally opposite corner of the area load.
8. Press the left mouse key.

The assigned load area will be shaded and the load values will be printed on the screen. The Area Load Dialog window will reappear.

STOP
Moving the mouse pointer to the STOP box and pressing the left mouse key returns you to the main CASM screen.

MIN ROOF (LL)

The CASM program will calculate the minimum live load for roof structural members based on the roof slope and the defined tributary area of the load supported by the member. The calculations and value is automatically printed to an output file.

Select the MIN ROOF (LL) from the LOADS menu or Tool Palette.

In order to calculate the Minimum Roof Live Load you must have a horizontal or inclined plane displayed. A preliminary structural framing layout helps to define the tributary area.

To change the output file name:
1. Move the mouse pointer to the Output File name box.
2. Press and hold the left mouse key while dragging the pointer over the current file name. Release the key when the name is highlighted.
3. Type in a new file name. Use the backspace key to make corrections.

You may use the current file name for output or type in a new file name. Roofout.txt is the default output file. When entering a new output file name, the file name must be eight characters or less. The extension .TXT must be added to the new file name.
The CASM program will check for another file with the same name. If the program finds another file with the same name, a dialog window appears to confirm if you desire to replace (add changes to) the existing file which has the same name.

When the Minimum Roof (LL) file name has been verified:
1. Move the mouse pointer to the 'OK' box.
2. Press the left mouse key once and release.
   The file name dialog window will disappear and a Tributary Area Dialog Window will appear. The mouse pointer will change to a graphic cursor.
3. Move the graphic cursor to the first corner of the tributary area.
   Refer to the values in the dialog window to aid in the placement of the area load.
4. Press the left mouse key.

At any time you may double click the right mouse key to exit the Minimum Roof Live Load calculation sequence.
5. Move the graphic cursor to the diagonally opposite corner of the area load.
6. Press the left mouse key.
   Minimum Roof Live Load values will be calculated based on the defined tributary area. The output data will automatically be placed in the designated output file.
   The Minimum Roof Live Load area will be shaded and the load values will be printed on the screen. The Minimum Roof Live Load File Name window will reappear.

When you have finished calculating Minimum Roof Live Loads:
7. Select CANCEL with the mouse pointer and press the left mouse key to terminate the Minimum Roof Live Load Command.

You can access the Minimum Roof Live Load file with the Windows NOTEPAD program. To access NOTEPAD you will need to open the MS-DOS Executive Window.

To access Notepad:
1. Move the mouse pointer to the Minimize (down) arrow in the top right corner of the screen. (You may also use the Minimize command from the System menu.)
2. Press the left mouse key.
   The CASM program window will be reduced to an icon in the icon area.
3. Place the mouse pointer on the MS-DOS Executive Icon.
4. Double click the left mouse key.
   The MS-DOS Executive window will be displayed.
5. Find the desired .txt file to edit, place the mouse pointer on the file name and double click the left mouse key.
You may review the output data and exit NOTEPAD using the CLOSE command on the SYSTEM pull-down menu box or Exit from the NOTEPAD File pull-down menu. Because the output file was automatically saved on disk, there is no need to save it when you exit the NOTEPAD program.

If you make editing changes or entries to the output file while in NOTEPAD, you must use the Save or Save As commands in the NOTEPAD File pull-down menu to save them in the output file.

When you exit the NOTEPAD program, a dialog window will appear to remind you to save your work if you have made any changes or entries to the output file.

To return to the CASM program window:

1. Move the mouse pointer to the CASM icon.
2. For the Single-Monitor Display, double click the left mouse key. For the Dual-Monitor Display, press the left mouse key and select the Maximize command from the CASM System menu.
**SNOW LOADS**

The dialog window that appears when the SNOW LOAD is selected contains input boxes for snow load building code values such as ground snow load, importance factor, exposure, and roof types. If the CRITERIA snow values have been entered prior to selecting SNOW LOAD, the SNOW LOAD dialog window will initially contain the CRITERIA snow values. The values may be verified or modified as desired. Once all the snow data have been entered and confirmed, the program will calculate the roof snow load for the model and provide you with a formatted list of calculations and values in an output file (snowout.txt is the default file).

After the snow loads for the model have been calculated, the modeling screen changes to a SECTION display. You need to position the horizontal line on the building plan at the top of the screen in order to select the section you desire. You may review alternate sections and snow loads by pressing the left mouse key. **Double click** the right mouse key to select the desired section. When the section is displayed, the snow load values for balanced, unbalanced, drifting, and sliding snow are displayed on the screen.

Select the SNOW LOAD from the LOADS pull-down menu or Tool Palette.

The SNOW LOAD dialog window will appear. The ground snow value will be highlighted. Verify the displayed values and selections which were entered in the CRITERIA dialog window or input the values directly to the boxes provided.

![Snow Loads Dialog](snowloads.png)

Use the following sequence to change or enter a SNOW LOAD value or selection.

**To enter a new ground snow value:**

1. Move the mouse pointer to the appropriate input box.
2. Press and hold the left mouse key while dragging the pointer over the Ground Snow Value. Release the key and type in a new value. Use the backspace key to make corrections.

To enter a new Importance or Exposure factor:
1. Move the mouse pointer to the appropriate input box.
2. Press the left mouse key once and release.
   A dialog window will appear with code values and descriptions.
3. Move the mouse pointer to the circle in front of the desired selection.
4. Press the left mouse key once and release.
   A solid dot will appear in the circle to indicate your selection.

To transfer the selection to the SNOWLOAD dialog window:
1. Move the mouse pointer to the 'OK' box at the bottom of the window.
2. Press the left mouse key once to transfer the selection.
   The selected value will appear in the SNOWLOAD dialog window. A vertical cursor will appear after the value. You may change the value by pressing the backspace key and typing a new value.

To change the 'Roof Slippery' or 'Roof Heated' boxes:
1. Move the mouse pointer to the appropriate input box.
2. Press the left mouse key once and release.
   To select the condition noted, press the mouse key until there is an 'X' in the box. An empty box indicates the condition is not selected (i.e., no 'X' in the Roof Heated box means the roof is NOT heated).

To calculate the snow load and print the load values to an output file:
You may use the current file name for output or enter a new file name.
1. Move the mouse pointer to the data box for the output file.
2. Press and hold down the left mouse key and drag the pointer over the current name. Release the mouse key when the name is highlighted.
3. Type in a file name for the output values.
   The file name must be eight characters or less. The extension .TXT is automatically added to the file name.

When all snow load data have been entered and verified:
1. Move the mouse pointer to the 'OK' box.
2. Press the left mouse key once and release.
   The CASM program will check for another file with the same name. If the program finds another file with the same name, a dialog window appears to confirm if you desire to replace (add changes to) the existing file which has the same name.

Snow load values will be calculated based on the selections and data displayed in the Snow Load dialog boxes. The output data will automatically be placed in the designated output file.
After the snow loads for the model have been calculated, the modeling screen changes to a SECTION display. You need to position the horizontal line on the building plan at the top of the screen in order to select the section you desire.

**To change the section:**
1. Move the mouse toward/away from you.
2. Press the left mouse key to review alternate building sections and snow loads.
3. **Double click** the right mouse key to select the desired section.

When the section is displayed, the snow load values for balanced, unbalanced, drifting, and sliding snow are displayed on the screen. You may use the Print Screen command on the Files Menu to copy the section and snow loads displayed on the screen.

You may use the Pan and Distance tools from the Viewpoint Tool Palette to vary the section location and size on the screen. You may also view the Snow Load in 3-D Perspective. Verify that the Snow Load is turned on in the Viewpoint Options Show Loads command.

You can access the Snow Load file with the Windows NOTEPAD program. To access NOTEPAD you will need to open the MS-DOS Executive Window.

**To access Notepad:**
1. Move the mouse pointer to the Minimize (down) arrow in the top right corner of the screen. (You may also use the Minimize command from the System menu.)
2. Press the left mouse key.

The CASM program window will be reduced to an icon in the icon area.
3. Place the mouse pointer on the MS-DOS Executive Icon.
4. Double click the left mouse key.
The MS-DOS Executive SYSTEM Menu will be displayed.
5. Press the [X] key (or move the mouse pointer to the MAXIMIZE Command and press the left mouse key or [ENTER] to maximize the program window).
The MS-DOS Executive Program Window will be displayed.
6. Find the desired .txt file to edit, place the mouse pointer on the file name and double click the left mouse key.

You may review the output data and exit NOTEPAD using the CLOSE command on the SYSTEM pull-down menu box or Exit from the NOTEPAD File pull-down menu. Because the output file was automatically saved on disk, there is no need to save it when you exit the NOTEPAD program.

If you make editing changes or entries to the output file while in NOTEPAD, you must use the Save or Save As commands in the NOTEPAD File pull-down menu to save them in the output file.

When you exit the NOTEPAD program, a dialog window will appear to remind you to save your work if you have made any changes or entries to the output file.

To return to the CASM program window:
1. Move the mouse pointer to the CASM icon.
2. For the Single-Monitor Display, double click the left mouse key. For the Dual-Monitor Display, press the left mouse key and select the Maximize command from the CASM System menu.
The dialog window that appears when the WIND LOAD is selected contains input boxes for wind load building code values such as basic wind speed, importance factor, exposure, and opening coefficients. Check boxes are provided for main wind force resisting systems and components & cladding. If the CRITERIA wind values have been entered prior to selecting WIND LOAD, the WIND LOAD dialog window will initially contain the CRITERIA wind values. The values may be verified or modified as desired. Once all the wind data have been entered and confirmed, the program will calculate the wind load based on the model geometry and provide you with a formatted list of calculations and values (windout.txt is the default output file).

After the wind loads for the model have been calculated, the modeling screen changes to a SECTION display. You need to position the horizontal line on the building plan at the top of the screen in order to select the section you desire. You may review alternate sections and snow loads by pressing the left mouse key. Double click the right mouse key to select the desired section. When the section is displayed, the wind load values for walls and roof are displayed on the screen.

Select the WIND LOAD from the LOADS pull-down menu or Tool Palette.

The WIND LOAD dialog window will appear. The Basic Wind Speed Value is highlighted. Verify the displayed values and selections which were entered in the CRITERIA dialog window or input the values directly to the spaces provided.

Use the following sequence to change or enter a WIND LOAD value or selection.

To enter a new Basic Wind Speed value:

If the value is already highlighted, type in the appropriate entry. If the value is not highlighted:

1. Move the mouse pointer to the appropriate input box.
2. Press and hold the left mouse key and drag the pointer over the current entry. Release the mouse key when the entry is highlighted.

3. Type in a new value. Use the backspace key to make corrections.

To enter a new Importance Factor or Exposure Category:
1. Move the mouse pointer to the appropriate input box.
2. Press the left mouse key once and release.
   A dialog window will appear with code values and descriptions.
3. Move the mouse pointer to the circle in front of the desired selection.
4. Press the left mouse key once and release.
   A solid dot will appear in the circle to indicate your selection.

To transfer the selection to the WIND LOAD dialog window:
1. Move the mouse pointer to the 'OK' box at the bottom of the window.
2. Press the left mouse key once to transfer the selection.
   The selected value will appear in the WIND LOAD dialog window. The flashing vertical cursor will appear after the selected value. Use the backspace key to modify the value if necessary.

% Opening Coefficients:
   The internal pressure coefficients can be selected or computed automatically. If the coefficient is computed, all the openings on the walls must have been drawn.

Select type of system:
   Select Main Force Resisting, Components & Cladding, or Open Structure.

For Main Force Resisting System: Wind Loads are calculated; then a building section and Wind Load values are displayed.

For Components & Cladding: The "a" distance is computed. You select a plane and define the tributary area in 2-D. Then the loads are calculated and saved to a file. The display is returned to 3-D.

For Open Structure: You select and open plane. Loads are calculated and saved to a file. The model remains in 3-D.

To calculate the wind load and print the load values to an output file:
1. You may use the current file name for output or enter a new file name. To change the name:
   a. Move the mouse pointer to the data box for the output file.
   b. Press and hold down the left mouse key and drag the pointer over the current name. Release the mouse key when the name is highlighted.
   c. Type in a new file name for output values.
   The file name must be eight characters or less. The extension .TXT must be added to the new file name.
When all wind load data have been entered and verified:

1. Move the mouse pointer to the 'OK' box.
2. Press the left mouse key once and release.

The CASM program will check for another file with the same name. If the program finds another file with the same name, a dialog window appears to confirm if you desire to replace (add changes to) the existing file which has the same name.

Wind load values will be calculated based on the selections and data displayed in the dialog boxes. The output data will automatically be placed in the designated output file.

After the wind loads for the model have been calculated, the modeling screen changes to a SECTION display. You need to position the horizontal line on the building plan at the top of the screen in order to select the section you desire.

Wind Load: \( G_{Cpi} = 0 \) (psf)

To change the section:

1. Move the mouse toward/away from you.
2. Press the left mouse key to review alternate building sections and snow loads.
3. **Double click** the right mouse key to select the desired section.

When the section is displayed, the wind load values are displayed on the screen. You may use the Print Screen command on the Files Menu to copy the section and wind loads displayed on the screen.

You may use the Pan and Distance tools from the Viewpoint Tool Palette to vary the section location and size on the screen. You may also view the Wind Load in 3-D Perspective. Verify that the Wind Load is turned on in the Viewpoint Options Show Loads command.
You can access the Wind Load file with the Windows NOTEPAD program. To access NOTEPAD you will need to open the MS-DOS Executive Window.

**To access Notepad:**

1. Move the mouse pointer to the Minimize (down) arrow in the top right corner of the screen. (You may also use the Minimize command from the System menu.)
2. Press the left mouse key.
   The CASM program window will be reduced to an icon in the icon area.
3. Place the mouse pointer on the MS-DOS Executive Icon.
4. Double click the left mouse key.
   The MS-DOS Executive SYSTEM Menu will be displayed.
5. Press the [X] key (or move the mouse pointer to the MAXIMIZE Command and press the left mouse key or [ENTER] to maximize the program window).
   The MS-DOS Executive Program Window will be displayed.
6. Find the desired .txt file to edit, place the mouse pointer on the file name, and double click the left mouse key.

You may review the output data and exit NOTEPAD using the CLOSE command on the SYSTEM pull-down menu box or Exit from the NOTEPAD File pull-down menu. Because the output file was automatically saved on disk, there is no need to save it when you exit the NOTEPAD program.

> If you make editing changes or entries to the output file while in NOTEPAD, you must use the Save or Save As commands in the NOTEPAD File pull-down menu to save them in the output file.

> When you exit the NOTEPAD program, a dialog window will appear to remind you to save your work if you have made any changes or entries to the output file.

**To return to the CASM program window:**

1. Move the mouse pointer to the CASM icon.
2. For the Single-Monitor Display, double click the left mouse key. For the Dual-Monitor Display, press the left mouse key and select the Maximize command from the CASM System menu.

**SEISMIC LOADS (Not Implemented)**

Design seismic load values based on Criteria data are applied to the model. Seismic loads in pounds per level are displayed near the floor surfaces when in the PERSPECTIVE display and the SECTION display. Dead load values must be assigned to all levels and walls.
EARTH LOADS (Not Implemented)

TEMPERATURE LD (Not Implemented)

DELETE LOADS

You may use the Delete Loads command to delete a load assignment from the structural model. Only loads you ASSIGN can be deleted.

Select the Delete Loads command from the Loads menu:

All loads will be highlighted at the center of the area load or point load by a colored dot or handle. The mouse pointer changes to a +. (For the Dual-Monitor System the mouse pointer changes to the Matrox modeling screen.)

1. Move the mouse pointer to the handle on the desired load to be deleted.

>> You may exit the Delete Loads mode at any time without saving changes by double clicking the right mouse key.

2. Press the left mouse key.

The designated load will disappear. The handles on the remaining loads will reappear. You will remain in the Delete Loads mode.

3. Double click the right mouse key to exit the Delete Loads mode.

MODIFY LOADS

You may use the Modify Loads command to modify the load area or location assignment on the structural model. Only loads you ASSIGN can be modified.

Select the Modify Loads command from the Loads menu:

A Tributary Area dialog window will appear. All loads will be highlighted at the center of the area load or point load by a colored dot (handle). Handles are also located at the corners of area loads. The mouse pointer changes to a +. (For the Dual-Monitor System the mouse pointer changes to the Matrox modeling screen.)

1. Move the mouse pointer to the handle on the desired load to be modified.

- Use the handles at the center of the loads to move the loads. The Tributary Area window will display the location changes.
• Use the handles at the corners of the loads to change the designated load area. The Tributary Area window will display the dimension changes.

<table>
<thead>
<tr>
<th>Tributary Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distance from lower-left corner:</td>
</tr>
<tr>
<td>Horizontal</td>
</tr>
<tr>
<td>Vertical</td>
</tr>
<tr>
<td>Horizontal Length</td>
</tr>
<tr>
<td>Horizontal Length</td>
</tr>
</tbody>
</table>

You may exit the Modify Loads mode at any time without saving changes by double clicking the right mouse key.

2. Press the left mouse key.
   The selected load area will be highlighted. Move the mouse to change the selected load area or position.

3. Press the left mouse key to save the modification.
**MAT'L MENU**

The Material Menu permits you to define the structural material for your proposed framing system from four different materials. Only one material can be selected. The CASM EXCEL spreadsheets will be based on the material and element selected. The menu selections for the Floor/Roof and Col/Wall menus are based on the Material selected. The four material selections are:

- **CONCRETE**
  Selects concrete as the structural material for the members that are to be analyzed and sized.

- **MASONRY**
  Selects masonry as the structural material for the wall or column that is to be analyzed. Preliminary sizing is not implemented.

- **STEEL**
  Selects steel as the structural material for the members that are to be analyzed and sized.

- **WOOD**
  Selects wood as the structural material for the members that are to be analyzed. Preliminary sizing is not implemented.

Select one of the Mat'l option Tool Icons or menu commands from the Mat'l Menu:

The Mat'l Menu will disappear. You may verify that the desired Mat'l option is active by checking the Mat'l Menu for a checkmark in front of the desired Mat'l option or look for a highlighted tool icon. To change the Mat'l option, select another Mat'l option. The checkmark will change on the Mat'l Menu. The highlighted tool icon will change.
The Floor/Roof Menu permits you to define the structural member for your proposed framing system. Pop-up dialog windows are displayed with structural design data based on the material and structural element selected. The Material selection determines what structural members are available based on the type of system you have defined in Draw Structure.

You must be in one of the Plane displays (i.e., Plane Name, Horizontal Plane, Incline Plane) in order to select structural members.

Select a structural member from the menu:

All of the corresponding structural elements on the structural Plane which were drawn and defined by Draw Structure commands are marked by a colored dot (handle) at their midpoint.

Select a marked element with the graphic cursor by placing the cursor on the dot and press the left mouse key. For Linear Elements, Narrowly spaced or Widely spaced:

---

**Floor/Roof Menu**

<table>
<thead>
<tr>
<th>Floor/ Roof</th>
<th>Col/ Wall</th>
<th>Design</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surf Selections</td>
<td>Grids 2-Way</td>
<td></td>
</tr>
<tr>
<td>Form Deck</td>
<td>Rolled Sections</td>
<td></td>
</tr>
<tr>
<td>Roof Deck</td>
<td>Trussed</td>
<td></td>
</tr>
<tr>
<td>Floor Deck</td>
<td>Space</td>
<td></td>
</tr>
<tr>
<td>Narrowly Spaced</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open-Web Joists - K</td>
<td>Truss - Custom</td>
<td></td>
</tr>
<tr>
<td>Open-Web Joists - LH</td>
<td>Arch/Vault</td>
<td></td>
</tr>
<tr>
<td>Open-Web Joists - DLH</td>
<td>Folded Plate</td>
<td></td>
</tr>
<tr>
<td>Lightgage 'C' Channels</td>
<td>Dome</td>
<td></td>
</tr>
<tr>
<td>Widely Spaced</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rolled Sections</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Composite Beam/Slab</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plate Girders</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Truss Girders - SJ</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Two dialog windows will appear. One window lists dimensional information such as span, orientation, and spacing. The other dialog window lists design data such as L/d ratios, approximate depth of member based on the span, span ranges, and typical depth ranges to aid you in selecting the appropriate member type.

<table>
<thead>
<tr>
<th>Roof</th>
<th>Floor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple Contin.</td>
<td>Simple Contin.</td>
</tr>
<tr>
<td>L/d</td>
<td>22</td>
</tr>
<tr>
<td>Approximate d</td>
<td>13.6</td>
</tr>
<tr>
<td>Typical Span Range</td>
<td>12 - 60</td>
</tr>
<tr>
<td>Effective Span Range</td>
<td>25 - 30</td>
</tr>
<tr>
<td>Typical Depth Range</td>
<td>4 to 18 (2), 18 to 36 (3)</td>
</tr>
</tbody>
</table>

If you decide to do a preliminary analysis of the member at this time:

Select PRELIM from the Design menu.

A series of dialog windows prompting for additional information will appear. Then the member loads will be displayed for review and an analysis of the member will be performed to determine the shear, moment, deflection, and a preliminary member size for some structural members.

### COL/WALL MENU

The Col/Wall Menu permits you to define the structural member for your proposed framing system. The Material selection determines what structural members are available based on the type of system you have defined in Draw Structure.

You must be in one of the Plane displays (i.e., Plane Name, Horizontal Plane, Incline Plane) in order to select structural members.

Select a structural member from the menu:

All of the corresponding structural elements on the structural Plane which were drawn and defined by Draw Structure commands are marked by a colored dot (handle) at their midpoint.

Select a marked element with the graphic cursor by placing the cursor on the dot and press the left mouse key.

Two dialog windows will appear. One window lists dimensional information such as span, orientation, and spacing. The other dialog window lists design data such as L/d ratios, approximate depth of member based on the span, span ranges, and typical depth ranges to aid you in selecting the appropriate member type.
Although not implemented at this time, if you decide to do a preliminary analysis of the member at this time, select PRELIM from the DESIGN menu. Maximum axial loads and moments due to eccentricities or lateral loads will be calculated and displayed.

Eventually you will be able to select a preliminary member type and size for material costs and further analysis.

**FDTN MENU (NOT IMPLEMENTED)**

The Fdtn Menu permits you to define the structural member for your proposed foundation system. The Material selection determines what structural members are available based on the type of system you have defined in Draw Structure.

**DESIGN MENU**

The Design Menu permits you to do a PRELIMINARY analysis of the member in order to select a preliminary size for cost estimates and further analysis and evaluation.

Before using the Design Menu you must have assigned loads and assigned a Load Combination from the Loads Menu, laid out a structural framing system in Draw Structure, and selected a member from the Floor/Roof or Col/Wall menus.

**PRELIMINARY**

Currently, the Preliminary design is implemented for Widely Spaced members, Narrowly Spaced members, or one-way surface. The program displays the loading on the member for review. If you elect to continue, the shear, moment, and deflection on the member is calculated and displayed on the screen. A preliminary size for the selected member can be determined from an EXCEL spreadsheet program.

Before doing the Preliminary Analysis the following steps must be completed:
- Define a structural grid.
- Lay out a structural framing plan.
- Assign Loads.
The sequence for the Preliminary analysis is:

1. Select Preliminary Analysis Icon or Preliminary from the Design menu.  
   An Analysis dialog window appears.

2. Select units (feet or inches, pounds or kips)  
3. Select if you want the deck weight included in the dead load or superimposed dead load.  
   There are guidelines for this decision.  
4. Select OK.
   Connectivity dialog window appears.

5. Select connectivity at each end of member.  
   If you selected the connectivity as continuous over a column for both the column above and column below, a red dot appears on the end of the member you are defining for analysis.
a. Enter the end connectivity of the column, either fixed or pinned.
b. Enter the height of the column.
If you entered more than one adjacent span:
c. Enter the approximate connectivity for each adjacent span.
   A red dot appears at the location of the connectivity you are defining.
d. Select the number of adjacent spans at each end.
   There can only be an adjacent span if the connectivity is continuous.
6. Select if there are any internal pins.
   For decking, you select the number of spans, distance from the highlighted edge and the starting span number.
If you selected internal pins:
a. Select Pin 1 and/or Pin 2.
b. Enter either distances from left or right.
   The opposite distance is automatically calculated.
If live load reduction is on:
7. Provide information for the following prompts:
a. Indicate if member is part of a roof.
b. Indicate if member supports more than one floor.
c. Indicate if occupancy is public assembly or is a garage.
d. Enter file name for live load reduction calculations.
If wind loads are included in the load combination. A dialog window will appear.
8. Select the appropriate wind load.
   PLF loads and connectivity diagrams will be displayed on the screen. A Member Self Weight dialog window will appear.

1.00 Dead (klf) 0.04

1.00 Superimposed Dead (klf) 0.67

1.00 Live (klf) 1.10 0.89 1.40

25 0
9. Click on the Member Estimated Self-Weight box and a dialog window appears showing a range of weights for the selected member and span.

<table>
<thead>
<tr>
<th>Self Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Estimated self weight: 0.0 pif</td>
</tr>
<tr>
<td>□ Update area structure loads</td>
</tr>
<tr>
<td>☑ Add self weight</td>
</tr>
</tbody>
</table>

The Estimated Self Weight window is a stand-alone program called BMWTEXE. The data displayed is in a text file called BMWT.DAT. This program can be run at any time.

10. Enter an estimated self weight and CLOSE the estimated self weight dialog window.

For a concrete beam, a dialog window appears asking for an estimated d, b, t, and the weight of concrete, either normal or light weight. The value is automatically entered in the estimated self weight box.

Select if the estimated self weight is going to update the area structure loads. If checked, the area dead loads assigned on the member will have a new structure PSF.

11. Enter an analysis file name and answer if the loads and connectivity are correct.

If the analysis file name is blank, no output will be generated and the analysis will be faster.

The shear, moment, and deflection diagrams will be shown on the screen.
12. Select which load diagram to view from the list of loads shown.

<table>
<thead>
<tr>
<th>View Shear, Moment &amp; Deflection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dead Load</td>
</tr>
<tr>
<td>Superimposed Dead Load</td>
</tr>
<tr>
<td>Live Load</td>
</tr>
<tr>
<td>Total Combined Load</td>
</tr>
</tbody>
</table>

Selecting Print Screen from the CASM File pull-down menu will provide you with a hardcopy of the member loading and the shear, moment, and deflection diagrams.

13. Select whether to execute EXCEL or send data to a file.
   a. Check the appropriate option.
   b. Enter a file name if you are sending data to a file.

The SENDXL.EXE file is a stand-alone program to send the data file to EXCEL at another time. Use this program to send the data if you cannot run CASM and EXCEL at the same time because of memory.

EXCEL is executed if selected. Shear, moment, and deflection data are passed to the CASM EXCEL spreadsheets in order to determine a preliminary size for:

- Steel Beams
- Steel Bar Joists
- Steel Deck
- Concrete Beams
- Concrete Slabs

Two worksheets are provided in EXCEL. The Preliminary Selection worksheet uses data from CASM to make a member selection. The Scratch Pad worksheet initially takes data from the Preliminary Selection spreadsheet; however, you may vary spans, spacings, and loads in order to determine a more optimum framing scheme. The Scratch Pad worksheet provides you with preliminary member sizes for each change you make. You may only make changes to values displayed in blue on the screen. The values in black are calculated and must not be changed. To access the Scratch Pad worksheet, select the Scratch Pad pull-down menu. Select the Return to CASM command in the File pull-down menu.
FINAL

FINAL (NOT IMPLEMENTED)

Once implemented you will be able to do in-depth analysis of the structural system using a finite element analysis program.
VIEWPOINT TOOL

You may use the Viewpoint Options Menu or Viewpoint Tool Icons to change the display of the structural model. You may display the model in 3-D Wireframe or Solid (Dual-Monitor System only) or 2-D Plan, Elevation, or Section. You may also change the viewing angle, the viewing height, and viewing distance of the model. Structural framing systems can be displayed as well as applied loads. The Viewpoint Tool Palette is always displayed on the screen. You may move it to any location on the screen.

To select a command from the Viewpoint Tool with the mouse:

- On the Single-Monitor System, only a portion of the Viewpoint Tool will be visible.

For the Dual-Monitor System:
1. Move the mouse pointer to the desired tool icon in the Viewpoint Tool Palette.
2. Press the left mouse key.
   - The tool icon will be highlighted and a dialog window may appear or the view will change.

For the Single-Monitor System and Dual-Monitor System:
1. Move the mouse pointer to the Options pull-down menu on the Viewpoint Tool Pull-down menu bar.
2. Press the left mouse key.
   - The Options pull-down menu will appear.
3. Move the mouse pointer to the desired menu option (you may also activate the command by typing the underlined letter in the desired command).
4. Press the left mouse key to activate the command.
   - A dialog window may appear or the view will change. Refer to the Viewpoint Tool command sequences listed on the following pages.

To select a command from the Viewpoint Tool Window with the keyboard:
1. Hold down the [ALT] key and press the O-key.
2. The Viewpoint Options pull-down menu will be displayed on the screen.
3. Type the underlined letter of the desired command to activate the command.
-OR-
Use the up or down arrows on the keyboard to move the selection bar up or down to the desired selection; then press the [ENTER] key.

The Viewpoint Tool command selections are:

To Move the Viewpoint Tool:
1. Move the mouse pointer to the Viewpoint title bar.
2. Press the left mouse key and hold it down.
3. While holding down the left mouse key move the Viewpoint Tool to any location on the screen.
   The boundary line of the Viewpoint Tool becomes dashed as it follows the movement of the mouse pointer.
4. Release the mouse key.
   The Viewpoint Tool moves to the new location.

To rotate the model on the modeling screen:
1. Move the mouse pointer to the black arrow that points to the circle.
2. Press the left mouse key and hold it down.
3. While holding down the left mouse key, move the mouse to drag the arrow around the circle.
   When the arrow is moved, the 3-D model will rotate on the modeling screen.
4. Release the mouse key when the desired model orientation is established.
   You may also locate the mouse pointer to a new location on the circle and press the left mouse key. The black arrow will move to the new location, and the model will rotate to the new orientation.

To change your 3-D viewing center (initial location is at the center of the ground plane):
1. Move the mouse pointer to the plus symbol in the center of the circle.
2. Press the left mouse key and hold it down.
3. While holding down the left mouse key, move the mouse in the direction which you desire to move the viewing center:
   Right/Left = E-W
   Toward/Away = N-S
   Hold down right key & Toward/Away = Vertical
   When the mouse is moved, the viewing center mark on the screen will move.
4. Release the mouse key when the desired viewing center location is established.

To pan the 2-D display (change the display vertically or horizontally on the screen):
1. Move the mouse pointer to the black plus symbol in the center of the circle.
2. Press the left mouse key and hold it down.
3. While holding down the left mouse key, move the mouse in the direction which you desire to Pan the display (right, left, away-up, toward-down).
   When the mouse is moved, the display will Pan on the modeling screen.
4. Release the mouse key when the desired model orientation is established.

To change your viewing height:
1. Move the mouse pointer to a black arrow above or below the current height value.
2. Press and release the left mouse key to increment the viewer height up or down.

-OR-
   a. Press and hold the mouse key.
   b. Move the mouse pointer in the direction the height arrow is pointing in order to make large height changes. You may also reverse the direction of the mouse to reverse the height change.

The 3-D model on the modeling screen will be oriented to reflect the change in viewer height.

You are allowed to select a negative height value (less than zero). This will allow you to look at any structure that is below the ground plane grid.

3. Release the mouse key when the desired viewer height is established.

To change your viewing distance:
1. Move the mouse pointer to a black arrow to the right or left of the current distance value.
2. Press and release the left mouse key to increment the viewer distance farther or closer to the model.

-OR-
   a. Press and hold the mouse key.
   b. Move the mouse pointer in the direction the distance arrow is pointing in order to make large distance changes. You may also reverse the direction of the mouse to reverse the viewing distance change.

The 3-D model on the modeling screen will be oriented to reflect the change in viewer distance.

3. Release the mouse key when the desired viewer distance is established.

For the Single-Monitor System, you may use the rotate tool, height tool, or distance tool to redraw the screen.

To Zoom a 2-D view, place the mouse pointer on the Viewpoint Distance box. Right side will zoom out. Left side will zoom in.
OPTIONS MENU

DISPLAY INFORMATION

A dialog window is displayed which shows information about openings and assigned loads on a selected plane (i.e. wall, roof, floor). The plane is selected by using the Plane Name command or by selecting the planar views when in the perspective view of the model. The Plane Name can be changed by modifying the name text. The window remains on the screen and displays information on planes as they are selected. Use the System menu to close the Plane Information window or reselect the Display Information command.

<table>
<thead>
<tr>
<th>Structural Plane Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name: Floor 4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Openings</th>
<th>Name</th>
<th>Continuous</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opening - 1</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Opening - 3</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Loads</th>
<th>Name</th>
<th>psf</th>
</tr>
</thead>
<tbody>
<tr>
<td>Floor Type 1</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>Office: Business mach. equip</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>Office: Files &amp; storage</td>
<td>80</td>
<td></td>
</tr>
</tbody>
</table>

Select the Display Information command from the Options menu.

A Dialog Window will appear. The Dialog Window displays information about openings and assigned loads for a selected plane. Select a different plane and the opening and load information for the plane is displayed.

- To change opening information, double click the left mouse key on the opening name to be changed. An input dialog window will appear.
- To change load information, double click the left mouse key on the load name to be changed. The Loads dialog window will appear.

To close the dialog window:
1. Move the mouse pointer to the system box.
2. Press the left mouse key to display the system menu for the Display Information Dialog Window.
3. Select Close to remove the dialog window from the screen. (Or reselect the Display Information command on the Options menu.)

SHOW LOADS

A window is displayed which permits you to selectively display loads on the model. Only the loads shown in bold print are available. Move the mouse...
pointer to the check box (or load name) and press the left mouse key to select the load you wish to display. After you select OK the load will be displayed on the model.

**Only one load type can be displayed at a time.**

Select the Show Loads command from the Options menu.

The Show Loads Dialog Window will appear.

### Show Loads

<table>
<thead>
<tr>
<th>Snow Loads</th>
<th>Wind Loads</th>
</tr>
</thead>
<tbody>
<tr>
<td>□ Combined</td>
<td>□ NCpi-N</td>
</tr>
<tr>
<td>☑ Unbalanced</td>
<td>□ NCpi Negative</td>
</tr>
<tr>
<td></td>
<td>□ NCpi Positive</td>
</tr>
<tr>
<td>Other Loads</td>
<td>Components &amp; Cladding</td>
</tr>
<tr>
<td>□ Dead</td>
<td>Open Roots</td>
</tr>
<tr>
<td>□ Live</td>
<td>□ Open Arch Wind 90°</td>
</tr>
<tr>
<td>□ Minimum Roof</td>
<td>□ Open Arch Wind 60°</td>
</tr>
<tr>
<td></td>
<td>□ Zone Areas</td>
</tr>
<tr>
<td></td>
<td>□ B &amp; L Assumptions</td>
</tr>
<tr>
<td>OK</td>
<td>Cancel</td>
</tr>
</tbody>
</table>

**To display loads:**

1. Move the mouse pointer to the selection box next to the desired load.
2. Press the left mouse key.

   An 'X' will appear in the box when the load is selected for display. To deselect a load, move the mouse pointer to a box with an X in it, press the left mouse key and the X will disappear. The load has been deselected.

After selecting all desired loads for display:

3. Move the mouse pointer to the OK action box. (You may select the cancel box if you decide not to make any changes.)
4. Press the left mouse key.

The selected loads will be displayed on the structural model.

## SHOW STRUCTURE

A window is displayed which permits you to selectively display structural elements on the model. Only the items shown in bold print are available. Move the mouse pointer to the check box (or item name) and press the left mouse key to select the item you wish to display. After you select OK, the selection will be displayed on the model.

Select the Show Structure command from the Options menu.

The Show Structure Dialog Window will appear.
To display structure:

1. Move the mouse pointer to the selection box next to the desired structural element.
2. Press the left mouse key.
   An 'X' will appear in the box when the structural element is selected for display.
   To deselect a structural element, move the mouse pointer to a box with an X in it; press the left mouse key, and the X will disappear. The structural element has been deselected.

After selecting all desired structural elements for display:

3. Move the mouse pointer to the OK action box. (You may select the cancel box if you decide not to make any changes.)
4. Press the left mouse key.
   The selected structural elements will be displayed on the structural model in all views.

MODEL VIEWS

PERSPECTIVE (3D)

A three-dimensional view of the model in three-point perspective is displayed in the modeling window. The viewing angle, distance, height, and viewing center may be varied as desired with the viewpoint Tools.

Select Perspective (3D) command from the Options menu.

The model will be displayed in 3-D. Either the Wireframe Object or Solid Object display options may be selected. Only the Wireframe Object display is available on the Single-Monitor Screen.

PLAN

A plan view (roof) of the model is displayed on the screen. The Viewpoint arrow can be used to reorient the plan north, south, east, or west. The distance bar on the
Viewpoint window will permit you to zoom in and out. The plus symbol in the center of the Viewpoint circle will permit you to pan the display on the screen.

Select Plan command from the Options menu.
A roof plan of the model will be displayed in 2-D.

**ELEVATION**

Changes to an orthogonal view of an exterior elevation are displayed. The Viewpoint arrow can be used to select north, south, east, or west elevations. The distance bar on the Viewpoint window will permit you to zoom in and out. The plus symbol in the center of the Viewpoint circle will permit you to pan the display on the screen.

Select Elevation command from the Options menu.
An elevation of the model will be displayed in 2-D.

**SECTION**

Changes to an orthogonal view of a model section are displayed. The distance bar on the Viewpoint window will permit you to zoom in and out. The plus symbol in the center of the Viewpoint circle will permit you to pan the display on the screen.

Select Section command from the Options menu.
A plan view of the model is displayed at the top of the viewing window with a section cut line extending through it. A small section of the model is displayed below the plan view.

- Moving the mouse toward/away will move the section cut line through the model.
- Press the left mouse key to change the small section view.
- Double click the right mouse key to select the desired section of the model to display on the screen.

**HORIZONTAL PLANE**

A plan view of a horizontal plane from the model is displayed on the screen. The distance bar on the Viewpoint window will permit you to zoom in and out. The plus symbol in the center of the Viewpoint circle will permit you to pan the display on the screen.

You must be in the Perspective (3D) display in order to select the Horizontal Plane display.

Select Horizontal Plane command from the Options menu.
All horizontal floor and roof levels of the model are highlighted and marked by a yellow dot for selection.

- Click the left mouse key once after the cursor has been located on the yellow dot.
  A plan view of the selected level is displayed on the screen.
**INCLINED PLANE**

A plan view of an inclined plane from the model is displayed on the screen. The distance bar on the Viewpoint window will permit you to zoom in and out. The plus symbol in the center of the Viewpoint circle will permit you to pan the display on the screen.

You must be in the Perspective (3D) display in order to select the Inclined Plane display.

*Select Inclined Plane command from the Options menu.*

- All incline levels of the model are highlighted and marked by a yellow dot for selection.
- Click the left mouse key once after the cursor has been located on the yellow dot.

A plan view of the selected inclined plane is displayed on the screen.

**VERTICAL PLANE**

A vertical plane from the model is displayed on the screen. The distance bar on the Viewpoint window will permit you to zoom in and out. The plus symbol in the center of the Viewpoint circle will permit you to pan the display on the screen.

You must be in the Perspective (3D) display in order to select the Vertical Plane display.

*Select Vertical Plane command from the Options menu.*

- All Vertical planes (interior and exterior) of the model are highlighted and marked by a yellow dot for selection.
- Click the left mouse key once after the cursor has been located on the yellow dot.

An elevation of the selected vertical plane is displayed on the screen.

**PLANE NAME**

The Plane Name command permits you to select a plane by name for display. The Plane Name, Load and opening information about the selected plane can be displayed in the Display Information window.

The distance bar on the Viewpoint window will permit you to zoom in and out. The plus symbol in the center of the Viewpoint circle will permit you to pan the display on the screen.

*Select Name Plane command from the Options menu.*

- A Name Plane dialog window appears with all the listed planes.
- Click the left mouse key once after the cursor has been located on the desired plane.
A plan view of the selected plane is displayed on the screen.

**WIREFRAME OBJECT**

The Wireframe display is a 3-D display. All of the edges of each shape are defined by lines. No hidden line removal is available in the Wireframe display.

**TRANSPARENT OBJECT**

The Transparent display is a 3-D display. You may use the Transparent Object command to make the building model partially transparent (solid) or dashed lines (wireframe) in order to view other objects or items inside or on the other side of the model.

**SOLID OBJECT**

The Solid display is a 3-D display. All of the visible planes of the model are colored. The model is highlighted by two light sources to enhance the perspective. The Solid display is not available for the Single-Monitor VGA or EGA.

**HIDE OBJECT**

A shape that blocks the view of an important feature or degrades the overall view of the model may be selected and turned off (hidden from view).

You must be in the Perspective (3D) display in order to select the Hide Object display.

Select Hide Object command from the Options menu.

All visible planes on shapes are highlighted and marked by a yellow dot for selection.

- Click the left mouse key once after the cursor has been located on the yellow dot.
The selected shape will disappear. You will remain in the Hide Object mode.

- Double click the right mouse key to get out of the HIDE OBJECT command.

**SHOW OBJECT**

All objects that were hidden are turned on when you select Show Object from the Viewpoint Options menu.

**FULL SCREEN**

Returns display of the model to the initial default viewer location of 170 feet horizontally, 60 feet vertically, and southeast if in Perspective (3D) or fill the screen if in a 2-D view.

A Store View dialog window appears with four view storage selections.

- Move the mouse pointer to the number where you want to store the view. Press the left mouse key.

The view is stored.

**STORE VIEW**

Permits the storage of four selected views of the model for recall and evaluation.

*Select Store View command from the Options menu.*

A Store View dialog window appears with four view storage selections.

- Move the mouse pointer to the number where you want to store the view. Press the left mouse key. The selected view is stored for later recall.

**RECALL VIEW**

Permits selection of one of four previously stored views.

*Select Recall View command from the Options menu.*

A Recall View dialog window appears with four view storage selections.
Move the mouse pointer to the number where you want to recall the view. Press the left mouse key.

The view is displayed on the screen.
This is the first 3-D graphic release of the CASM program, Version 1.01. Following this release, there will be subsequent periods of enhancements to the program. As such, the program still has a few bugs. Since we cannot predict when and if things will go wrong, we will try to give you some good advice.

**DO** make sure you have enough RAM memory in your computer. This program was developed with an AT compatible that had 1 MB of RAM. 512KB of RAM should be enough. Windows alone takes up 320KB of RAM.

**DO NOT** run Windows with memory resident programs. This may cause memory conflicts. Check your manuals to see if your memory resident programs will work with Windows.

**DO NOT** try to run too many programs under Windows. Again, due to memory limitations you may need as much memory as you can get.

**DO** make sure that if you have an expanded/extended memory card and the Matrox graphics card that the memory address locations 0C6000 to 0C63FF are protected for Matrox use. This address location is in the 384Kb memory segment from 640Kb to 1.0Mb. If the extended/expanded memory software tries to access the same memory segment, the computer will lock up.

**DO** make sure that if you have the Matrox graphics card, you verify all switch settings before installing the card. Make sure that you are grounded before touching the card. If you have any problems with the graphics card, contact the Matrox Technical Support personnel for assistance. Use the telephone number listed in the Technical Guide.

**DO** make sure all your cables are properly connected to and from the computer.

**DO** make sure all equipment is switched on and in operable condition.

**DO** make sure the mouse port and printer port are set to the proper baud rate and protocol in the WIN.INI file. See Appendix A in the "Microsoft Windows Operating Environment" manual for details on settings in the WIN.INI file.

**DO save your work often.** We cannot stress this enough.
WHAT TO DO IF SOMETHING IS WRONG

If you get an error:

1. If it is an error message, write down the complete message.

2. First check the error messages listed in Appendix B of the "Microsoft Windows Operating Environment" manual. Follow any instructions there if the error is listed.

3. If the error message is not listed or it is some other problem, write down a complete description of the events that led to the error. Also, try to recreate the event and be as specific as possible in your description; also, save the data file on a floppy, if possible. This will help us when we try to locate the problem. Send all information to:

   Commander and Director  
   US Army Engineer Waterways Experiment Station  
   ATTN: CEWES-IM-DS  
   3909 Halls Ferry Road  
   Vicksburg, MS 39180-6199  
   Phone (601) 634-2300  

We will make every effort to correct the problem in the next release.
Appendix A: Project History

The CASM project grew out of a desire by the US Army Corps of Engineers to have a simple structural engineering modeling system that engineers could use to try out their ideas without having to wait for extensive calculations and then looking through mounds of data. This program would be a trial-and-error, flexible, easily repeated process that the engineer could change at will and get feedback from the computer directly from the screen. The task of analyzing what decision paths the structural engineer used was given to Professor David Wickersheimer of the University of Illinois and President of Wickersheimer Engineers, Inc.

With the study of the structural engineering process completed, the Army awarded Wickersheimer Engineers a contract to produce such a program. The CASM team consists of David Wickersheimer, Ken Taylor, Gene McDermott and Carl Roth. It has been a three-year, three-phase contract to produce a usable program that will be an interactive program with a 3-D graphics display of the building geometry and structure. The third phase was completed December 31, 1989.

Regular meetings at select intervals with the Building Systems Task Group of the Computer Aided Structural Engineering (CASE) Project resulted in minor scope changes and a prerelease nongraphic version (0.1) to acquaint potential users with the program. Two new phases have been awarded to allow enhancements to be implemented in the next two years.
Appendix B: Trademarks

Microsoft, MS-DOS, Windows, and EXCEL are registered trademarks of Microsoft Corporation.

IBM is a registered trademark of IBM Corporation.

Hercules is a trademark of Hercules Corporation.

AutoCAD is a registered trademark of AutoDesk, Inc.

IN'A'VISION and Designer are registered trademarks of Micrografx, Inc.
Appendix C: Disk File Contents

The following are included on the CASM release disks:

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CASM Disk 1</td>
<td></td>
</tr>
<tr>
<td>\ (Root) Directory</td>
<td>DOS program to load all the necessary CASM files on your hard disk.</td>
</tr>
<tr>
<td>LOADCASM.EXE</td>
<td>CARDFILE list of cities/installations and criteria data.</td>
</tr>
<tr>
<td>CITIES.CRD</td>
<td>NOTEPAD list of dead load and live load values.</td>
</tr>
<tr>
<td>LOADS.DAT</td>
<td>NOTEPAD list of occupancy live loads.</td>
</tr>
<tr>
<td>OCCUPAN.DAT</td>
<td>NOTEPAD file of the structural element database with span ranges and L/d ratios.</td>
</tr>
<tr>
<td>STRUCT.DAT</td>
<td>CARDFILE list of general structural guidelines.</td>
</tr>
<tr>
<td>GUIDES.CRD</td>
<td>NOTEPAD list of structural estimated self weights for BMWT.EXE.</td>
</tr>
<tr>
<td>BMWT.DAT</td>
<td>CASM default building project file.</td>
</tr>
<tr>
<td>DEFAULT.BLD</td>
<td>Structural analysis program library.</td>
</tr>
<tr>
<td>ANALYSIS.EXE</td>
<td>Stand-alone Windows estimated self weight program.</td>
</tr>
<tr>
<td><em>.XL</em></td>
<td>Excel spreadsheets and macros.</td>
</tr>
<tr>
<td>WIN87EM.EXE</td>
<td>Windows math library.</td>
</tr>
<tr>
<td>SM1281 Directory</td>
<td>Graphics library for the dual-monitor Matrox SM-1024 and SM-1281 graphics card.</td>
</tr>
<tr>
<td>XG1281.EXE</td>
<td></td>
</tr>
<tr>
<td>XG1281.EXE</td>
<td></td>
</tr>
<tr>
<td>XGVIEW.EXE</td>
<td>Program to display the single-monitor Windows graphics.</td>
</tr>
<tr>
<td>SM640 Directory</td>
<td></td>
</tr>
<tr>
<td>XG1281.EXE</td>
<td>Graphics library for the dual-monitor Matrox SM-640 graphics card.</td>
</tr>
<tr>
<td>SCRIPT Directory</td>
<td></td>
</tr>
<tr>
<td>*.SCR</td>
<td>AutoCAD script files to DXFIN the CASM DXF print screens and CASM exports. For example, 'ACAD CASM CASM1024' will run AutoCAD and DXFIN the CASM DXF print screen image, then zoom to the proper view.</td>
</tr>
<tr>
<td>PROGRAMS Directory</td>
<td></td>
</tr>
<tr>
<td>SENDXL.EXE</td>
<td>Windows program to send the CASM analysis data file to Excel. Run this program if you are unable to execute CASM and Excel at the same time. Do not execute while CASM is running.</td>
</tr>
</tbody>
</table>
Appendix C

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XGDOWNL.BAT</td>
<td>Sample Matrox LIB shell download batch program.</td>
</tr>
<tr>
<td>EMMTEST.EXE</td>
<td>DOS program to test for expanded memory; checks the page frame location for a conflict with the Matrox board. If conflicts exist, refer to the expanded memory installation guide and the CASM Installation chapter.</td>
</tr>
<tr>
<td>FRAME.EXE</td>
<td>Stand-alone Windows frame analysis program which uses the ANALYSIS.EXE library. The program uses the same input format as the program Analysis of Two-Dimensional Frame Structures (X0020).</td>
</tr>
<tr>
<td>XGLUT.EXE</td>
<td>Windows program to display the color look-up table for the graphics library.</td>
</tr>
</tbody>
</table>

Note: WIN87EM.EXE, XG1281.EXE and XGV1EW.EXE should reside in the Windows directory; all other files should be in the CASM directory.

CASM Disk 2

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CASM.EXE</td>
<td>Main CASM Windows program.</td>
</tr>
</tbody>
</table>
Appendix D: Matrox Installation

These instructions are the necessary steps to install your Matrox SM-1024 or SM-1281 graphics card. They do not include all installation options. Please refer to the Matrox Installation and Technical Manual, the README files on the diskettes or the Matrox technical phone support if a problem arises.

1. Inspect the equipment.
   a. Visually check for no damage.
   b. The SM-Series-1 board set including the SM-1281 or SM-1024 board, the PG-Series-1 board, and the GSP board should be attached.
   c. Two plastic card guides should be included.
   d. A mounting bracket should be on one end of the SM-Series-1 board set.

2. Check the dip switches.
   a. The switches should be set as follows for a dual-monitor system:

<table>
<thead>
<tr>
<th>Switch</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>Off</td>
</tr>
<tr>
<td>A2</td>
<td>Off</td>
</tr>
<tr>
<td>A3</td>
<td>Off</td>
</tr>
<tr>
<td>A4</td>
<td>Off</td>
</tr>
<tr>
<td>A5</td>
<td>Off</td>
</tr>
<tr>
<td>A6</td>
<td>On</td>
</tr>
<tr>
<td>B1</td>
<td>On</td>
</tr>
<tr>
<td>B2</td>
<td>Off</td>
</tr>
<tr>
<td>B3</td>
<td>Off</td>
</tr>
<tr>
<td>B4</td>
<td>Off</td>
</tr>
<tr>
<td>B5</td>
<td>On</td>
</tr>
<tr>
<td>B6</td>
<td>Off</td>
</tr>
</tbody>
</table>

   These are not the standard switch settings; therefore, the board set will have to be taken apart to change.

   b. Change the dip switches. A qualified person should take the board set apart in a static-free environment.
      (1) Remove the four screws.
      (2) Carefully pry the boards apart with a pair of long-nose pliers. Do not use a screwdriver.
      (3) Change the dip switches.
      (4) Realign the pins and carefully push the board back together.
      (5) Replace the four screws.

3. Install the SM-Series-1 board set. A qualified person should install the board set in a static-free environment.
Appendix D

a. Turn the computer off.
b. Remove the cover.
c. Remove the blank panel covers on two empty adjoining slots.
d. Install the card edge guides if they are missing.
e. Press the SM-Series-1 board set into the slots.
   (1) Gently slide through the two mounting fixtures and card edge guides.
   (2) Carefully slide the PC edge connectors into the motherboard.
   (3) Firmly press the board set all the way in.
f. Attach the board to the mounting fixture with a screw.
g. Connect the high-resolution monitor cable to the female connector. Do not connect anything to the male connector.
h. Replace the cover and screws.

4. Run the diagnostic test.
   For the SM-1024: DIAG1024 [path\ filename.val]
   For the SM-1281: DIAG1281 [path\ filename.val]
   Replace [path\ filename.val] with the appropriate customization file for the monitor attached to the Matrox board.

<table>
<thead>
<tr>
<th>Customization File</th>
<th>Resolution</th>
<th>XTAL (Mhz)</th>
<th>Monitor(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>lgp11.val</td>
<td>1024x768</td>
<td>64</td>
<td>Nec Multisync XL</td>
</tr>
<tr>
<td>lgp11w.val</td>
<td>1024x768</td>
<td>64</td>
<td>Special configuration</td>
</tr>
<tr>
<td>lgp22.val</td>
<td>1280x960</td>
<td>104/8</td>
<td>Olivetti monitor</td>
</tr>
<tr>
<td>lgp23.val</td>
<td>1280x960</td>
<td>104/4</td>
<td>Olivetti monitor</td>
</tr>
<tr>
<td>lh434.val</td>
<td>1280x1024</td>
<td>110</td>
<td>Hitachi 4115,4119,4619,4625</td>
</tr>
<tr>
<td>lgp34.val</td>
<td>1280x1024</td>
<td>110</td>
<td>Mitsubishi 9918,6600,6905</td>
</tr>
</tbody>
</table>

For example, to test a SM-1024 attached to a Nec Multisync XL, do the following:
A:
DIAG1024 VAL\ LGP11.VAL
Everything should be OK.

5. Install the Matrox software. Do the following steps:
C:
MKDIR \XG1281
CD \XG1281
XCOPY A:*.* C: /s/v

6. Configure the LIB shell. This needs to be done only once.
CD \XG1281\UTIL
CUSTOM \XG1281\BIN\ SMLS.OUT \ XG1281 \BIN\ VAL\ LGP11.VAL
This is to configure an SM-1024 attached to a Nec Multisync Monitor. If you have a different configuration, substitute the LGP11.VAL file with the appropriate file name from the above table.

7. Modify the AUTOEXEC.BAT file. This will set the path and download the Matrox LIB shell every time you turn the computer on. The LIB shell MUST be downloaded before executing CASM. Use a text editor to modify.
   a. Add the \XG1281\UTIL directory to the PATH.
      
      PATH= C:\WIN;C:\CASM;C:\XG1281\UTIL;
   b. Add the Matrox LIB shell download commands:
      
      SMDOWNL \XG1281\BIN\SCALER.LOD \XG1281\BIN\FEEDER.LOD
      PGDOWNL \XG1281\BIN\SMLS.OUT
      LSFLUSH
      
      Refer to the sample Matrox LIB shell download batch program XGDOWNL.BAT contained in \PROGRAMS on the CASM disk 1 as an example.
   c. Run the AUTOEXEC.BAT to update the changes.

8. Try running the Matrox demo.
   a. For the SM-1281: SMDEMO
   b. For the SM-1024: SMDEMO6
      
      There is no demo specifically for the SM-1024; therefore, use the SM-641 demo. If the demo runs, the Matrox board is installed properly.
Appendix E: Sample Graphics

The following pages contain sample graphics developed using the CASM program.
Appendix E

Snow Unbalanced (psf)

Snow Balanced (psf)

Snow Drift (psf)

Snow Sliding (psf)

Snow Combined (psf)
Snow Unbalanced (psf)
Snow Balanced (psf)
Snow Drift (psf)
Snow Sliding (psf)
Snow Combined (psf)
Appendix E

Snow Unbalanced (psf)
Snow Balanced (psf)
Snow Drift (psf)
Snow Sliding (psf)

Snow Combined (psf)
Wind Load: GCpm=0 (psf)

Wind Load: Components & Cladding (psf)
Appendix E

Wind Load: Open Roof (psf)

Wind 90 degrees

Wind Load: Open Roof (psf)

Wind 60 degrees
Appendix E

Wind Load: Open Roof (psf)

---

Wind Load: Open Roof (psf)
Appendix E

Shear (k):

Moment (kft):

Deflection:

Total Combined Load -- Envelope
INDEX

A
About CASM, 4-22
Add Beams All Grid Lines, 4-73
Add Column All Grid Intersections, 4-75
Add Column One Grid Intersection, 4-75
Add Main Grid, 4-67
Add Opening, 4-68
Add Sub Grid, 4-67
Add Wall 2-Grid Points, 4-76
Area dead loads, 4-84
Auto-start, 2-6

B
Beams All Grid Lines, 4-73
Bracing Menu, 4-78

C
Cardfile Application Program, 4-24
CASM
  Program Window, 3-5
Ceiling (DL), 4-85
Close (program window), 4-7
Col/Wall Menu (Loads), 4-110
Col/Wall Menu (Structure), 4-74
Column All Grid Intersections, 4-75
Column Dragged, 4-76
Column One Grid Intersection, 4-75
Concrete (material), 4-108
Connectivity, 4-112
Conventions, viii
Copy Structure, 4-60
Criteria Menu, 4-23

D
Define Grid, 4-65
Define Ground Plane, 4-50
Define Units, 4-51
Delete Grid Line, 4-60
Delete Loads, 4-106
Delete Object, 4-43
Delete Opening, 4-62
Delete Structure, 4-60
Design Menu, 4-111
Desktop Applications, 3-25
Disk File Contents, C-1
Display Information, 4-120
Drag Edge, 4-41
Drag Vertex, 4-40
Drag Plane, 4-42
Draw Model Tool Palette, 4-33
Draw Structure Tool Palette, 4-57
Duplicate Object, 4-46

E
Edit Menu (Draw Model), 4-38
Edit Menu (Draw Structure), 4-59
Elevation (model), 4-123
EXCEL, 4-115
Exit (program), 4-21
Export (file), 4-20

F
FDTN Menu, 4-111
File Menu, 3-22, 4-9
Final Design, 4-116
Floor (DL), 4-84
Floor/Roof Menu (Loads), 4-70
Floor/Roof Menu (Structure), 4-109
Frame Menu, 4-79
Full Screen, 4-126

G
Grid/Opening Menu, 4-64

H
Hide Object, 4-125
Horizontal Plane, 4-123

I
Import (file), 4-19
IN'A'VISION, 3-26, 4-18
Inclined Plane, 4-124
Initial Object Size, 4-52
Installing CASM, 2-4

L
Layout Menu (model), 4-49
Live Load Reductions, 4-94, 4-113
Load Combinations, 4-83
Loads and Design Tool Palette, 4-81
Loads Menu, 4-83
Lock E-W, 4-55
Lock N-S, 4-54
Lock Vertical, 4-55

M
Masonry (material), 4-108
Material Menu, 4-108
Matrox Installation, D-1
INDEX

Maximize (window), 4-6
Memory (extended/expanded), 2-4, 5-1
Min Roof (LL), 4-95
Minimize (window), 4-5
Model Views, 4-122
Modify Loads, 4-106
Modify Opening, 4-62
Modify Structure, 4-60
Moment (DL), 4-89
Moment (LL), 4-89
Move (window), 4-4
Move Grid Line, 4-61
Move Object, 4-43

N
Narrowly Spaced, 4-72
New (file), 4-10
Notepad Applications Program, 3-19

O
Occupancy (LL), 4-92
Open (file), 4-11
Options Menu, 4-120

P
Pan, 3-11, 4-118
Perspective (3D), 4-122
Plan (model), 4-122
Planes, 4-123 - 4-124
Plane Name, 4-124
Point (DL), 4-89
Point (LL), 4-89
Point Loads and Moments, 4-89
Pop-up dialog windows, 3-14
Preliminary Design, 4-111
Print Data, 3-18, 4-14
Print Screen, 3-19, 4-17
Program Window (CASM), 3-5
Project Data, 4-25
Pull-down menu, 3-9

R
Recall View, 4-126
Reference Menu, 4-56
Regional Data, 4-28
Restore (window), 4-3
Roof (DL), 4-85
Rotate Object, 4-44

S
Save (file), 4-13
Save As, 4-13
Saving work
output files, 3-18
project files, 3-16
Section (model), 4-123
Seismic Loads, 4-105
Setup CASM, 2-4 - 2-5
Shapes Menu, 4-35
Shear/Moment Diagrams, 4-114
Show Ground Plane, 4-50
Show Loads, 4-120
Show Object, 4-126
Show Structure, 4-121
Site Data, 4-30
Size (window), 4-4
Slice Object, 4-45
Snap to Units, 4-52
Snow Load, 4-98
Solid Object, 4-125
Stack on Ground, 4-53
Stack on Last Shape, 4-54
Stack on Plane, 4-54
Stack Underground, 4-54
Starting CASM
Long method, 3-1
Short method, 3-3
Steel (material), 4-108
Stopping CASM, 3-23
Store View, 4-126
Surface One-Way, 4-72
Surface Two-Way, 4-72
System Menu, 4-2

T
Tape Measure, 4-47
Tool Palettes, 3-13
Transparent Object, 4-125
Truss, 4-73

U
Undo, 4-40
Using Previously Saved Files, 3-22

V
Vertical Plane, 4-124
Viewpoint Tool, 3-10, 4-117
Viewing Distance, 3-12, 4-119
Viewing Height, 3-11, 4-119
INDEX

W
Wall (DL), 4-84
Wall Dragged, 4-77
Wall 2-Grid Points, 4-76
Widely Spaced, 4-73
Wind Loads, 4-102
Wireframe (display), 4-125
Wood (material), 4-108

Z
Zoom, 3-12, 4-119
The Computer-Aided Structural Modeling (CASM) computer program is designed to aid the structural engineer in the preliminary design and evaluation of structural building systems by the use of three-dimensional (3-D) interactive graphics. CASM allows the structural engineer to quickly evaluate various framing alternatives in order to make more informed decisions in the initial structural evaluation process. The program was developed by the Information Technology Laboratory, under the Computer Aided Structural Engineering (CASE) Project in conjunction with the Building Systems Task Group.

This first release of the CASM is designed to aid the user with design criteria, building loads, and structural framing. The various parts of the program are summarized below:

a. Basic design criteria. The user can enter information directly or retrieve information from a user-definable database. The design criteria include information about the project, regional design information, and site-specific design information.

(Continued)
10. SOURCE OF FUNDING NUMBERS (Continued).

Research, Development, Test, and Evaluation program, Work Unit No. AT40-CA-001 (CASE Building Systems)

18. SUBJECT TERMS (Continued).

Building systems Preliminary structural design
Computer Aided Structural Engineering (CASE) Structural modeling
Computer programs 3-Dimensional interactive graphics
3-Dimensional loads

19. ABSTRACT (Continued).

b. Building geometry. The user can assemble the building shape using 3-D primitives (cubes, prisms, spheres, cylinders, etc.) in an easy manner using pull-down menus, icons, and a mouse.
c. Dead and live loads. The user can select and construct dead and live loads from several user-definable menus of building materials and load conditions. These loads can then be applied to any desired area of the building volume.
d. Snow and wind loads. These loads are automatically calculated in 3-D using information from the basic design criteria database. Wind loads are also calculated for components and cladding and open roof structures.
e. Structural layout. The engineer can easily and rapidly experiment with various framing schemes inside the defined building volume. Beams, girders, joists, girts, columns, and walls are some of the structural elements that can be modeled.
f. Member analysis and preliminary sizing. The user can apply loads to the building geometry from a list of user-defined load cases. The shear, moment, and deflection of selected members may be calculated for various loading conditions (including pattern loads) and connectivity (including continuous beams). The design of a member is performed using a spreadsheet.

Data from the various investigated framing schemes can be edited and printed by CASM and used as justification in a design document.